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Preface

This manual is directed toward the person who uses Agilent Technologies’
622Vu Advisor application.  622Vu Advisor lets you analyze ATM networks and
devices systematically, using a simple Windows-based approach.

The manual assumes you’re familiar with:

•  ATM technology and the specific components comprising an ATM cell.

•  The basics of Microsoft Windows running on an Agilent Advisor.  At a
minimum, you should be able to:

⇒  Point, click, and double-click using the mouse.

⇒  Select items in a list.

⇒  Open a drop-down list.

⇒  Use scroll bars to scroll within a list or across a window.

⇒  Select a radio button.

⇒  Mark a check box.

⇒  Minimize, maximize, resize, and restore a window.

⇒  Recognize and use standard dialog boxes, such as Open and Save.

⇒  Use menu bars.

⇒  Use toolbars.

Technical Requirements

622Vu Advisor is designed to run on any "C" model of the Agilent Advisor.

Related Materials

Refer to the following manuals or online documents for more information about
622Vu Advisor:  In addition, a PDF (Portable Document Format) version of this
User’s Guide is included with the installation, and can be viewed or printed.    
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Title Description

622Vu Advisor’s Online
Help

You can display online Help information at any time, either from
the Help menu, by pressing F1, or using the Help button on a
specific window.  Refer to the Help text for all reference
information.

622Vu Advisor User’s
Guide (PDF version)

This manual, available online in PDF (Portable Document Format).
The manual can be reviewed or printed from this copy.

Windows Help If you haven’t used Microsoft Windows or Windows-based appli-
cations before, work through the Windows Tutorial before using
622Vu Advisor.  You might also want to browse through the Help
topics available from Windows.  These topics explain general
Windows concepts.
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Chapter 1

Installation and
Configuration

This chapter describes the physical appearance of the 622Vu undercradle.  In
addition, installation and configuration instructions describe the steps you need to
do prior to using the Agilent Technologies 622Vu Advisor application.  

To operate the 622Vu Advisor, the OC-12c/STM-4c application software must
be loaded in an Agilent Advisor "C or newer" model and a 622Vu undercradle
must be connected to the Advisor.

This chapter contains the following sections:

•  1.1  622Vu Undercradle Description

•  1.2 Installing 622Vu Advisor

•  1.3  Configuring 622Vu Advisor

•  1.4  Testing the Installation and Configuration

•  1.5  Troubleshooting

1:  Installation and Configuration
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1.1  622Vu Undercradle Description
The 622Vu undercradle supports testing an ATM network or device using an
OC-12c/STM-4c (SMF) interface.  You can use a single-mode or a multi-mode
physical interface module in your undercradle.        

Power
Sys
OK Fault Port 1 Port 2

OC-12c/STM-4c
622 Mb/s SM Port 1 Port 2

In  Out In  Out 

These LEDs indicate the 
mode of operation:
   top -- end-station 
   bottom -- monitor-only

These LEDs indicate an active (healthy) Port
  top -- Port 1
  bottom -- Port 2 

SM  -- Single-Mode module
MM -- Multi-Mode module

Active

Power Undercradle Power On indicator.

Sys OK 622Vu Advisor software is running when light flashes.

Fault There is a hardware or firmware problem.

Active The 622Vu Advisor application is talking to the undercradle.

Port 1 The undercradle is receiving ATM cells on Port 1.
(Dark indicates loss of cell delineation on that port.)

Port 2 The undercradle is receiving ATM cells on Port 2.
(Dark indicates loss of cell delineation on that port.)

Power DC Power connector for the power adapter.

Ethernet Connects to the NIC card in the PC Card slot on the right side of
the Agilent Advisor via the supplied crossover Ethernet cable.

Console Connects to the Serial port on the left side of the Agilent Advisor.
Use this connection if you need to troubleshoot the configuration
of the undercradle.

Right Side

Left Side

Power
Ethernet

Console

1:  Installation and Configuration
1.1  622Vu Undercradle Description
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1.2 Installing 622Vu Advisor
Two different conditions can exist for installing 622Vu Advisor.

A When you have a new 622Vu undercradle with a new Advisor mainframe.
The undercradle is already attached to the mainframe at the factory.

B When you have a new 622Vu undercradle to use with an existing Advisor
mainframe.

The following tables show the steps you should use to install Agilent 622Vu
Advisor depending on which of these conditions you have.

Each of the steps is described on the following pages.  A troubleshooting section
is provided after the installation and configuration topics.

Do These Installation Steps in This Order Page
1 Step 3. - Connect AC Power to the Mainframe 14

2 Step 6. - Install the Ethernet Card 17

3 Step 7. - Connect the 622Vu Undercradle to the
Ethernet Card

18

4 Step 8. - Apply DC Power to the 622Vu Undercradle 19

5 Step 9. - Set IP Addresses 20

6 Step 10. - Test the Installation and Configuration 22

A
If you are installing
a new 622Vu
undercradle
with a new
Agilent Advisor
mainframe.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Note:  You must install the software before you can proceed with ANY hardware
installation.

B
If you are
installing a new
622Vu undercradle
with an existing
Agilent Advisor
mainframe.

Do These Installation Steps in This Order Page
1 Step 1.- Install 622Vu Advisor Software 13

2 Step 2. - Install 622Vu Undercradle 14

3 Step 3. - Connect AC Power to the Mainframe 14

4 Step 4. - Ensure CardBus Controllers Are Enabled 15

5 Step 5. - Ensure TCP/IP Stack Is Installed 16

6 Step 6. - Install the Ethernet Card 17

7 Step 7. - Connect the 622Vu Undercradle to the
Ethernet Card

18

8 Step 8. - Apply DC Power to the 622Vu Undercradle 19

9 Step 9. - Set IP Addresses 20

10 Step 10. - Test the Installation and Configuration 22

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 1.- Install 622Vu Advisor Software

Windows 98 Installation

•  Your Agilent Advisor has software older than version 11.0.

You must have Windows 98 Second Edition (or newer) installed to run
622Vu Advisor.
You can verify this by selecting Start | Settings | Control Panel and then
clicking the System icon.  In the General tab, verify that you have System
version 4.10.2222.A or newer.
See the Agilent Advisor Software Installation Guide for instructions.   

622Vu Advisor Software Installation

The Agilent 622Vu Advisor application software is included in the 11.0 (and
newer) release of Agilent Advisor software.   

•  You have software older than release 11.0.

1. Use Section 4, in the Agilent Advisor Software Installation Guide, to add the
622Vu Advisor application software to the Agilent Advisor.  

2. If you want to install only the 622Vu Advisor application, in the Agilent
Advisor Software Installation Guide procedure:

•  Select J3763A 622 Mb/s Undercradle for the hardware

•  Select 622Vu Advisor for the software application

•  Select the LAN in Windows software application

•  Select all the System files for the software application

You need to
upgrade to
Windows 98
Second
Edition if:

You need to
upgrade to
Agilent
Advisor 11.0
software if:

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 2. - Install 622Vu Undercradle

To attach the 622Vu undercradle to your Agilent Advisor:

1. Turn the Advisor off and disconnect the
power cord.

2. Align the undercradle with the Advisor so
the connector slots match.
Tip: The network connections and
indicator lights are on the right side of the
undercradle.

3. Press the undercradle and Advisor
together until they are seated.

4. Push in the four silver tabs to lock the
undercradle to the Advisor.

Step 3. - Connect AC Power to the Mainframe

1. Connect the
Y cord power
jumper to the
Advisor.

2. Connect the
AC power
cord to the
Y cord
power.
mper

3. Connect the
AC power
cord to a
power
outlet.

You will make
the DC
connection in a
later step.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 4. - Ensure CardBus Controllers Are Enabled

The 622Vu undercradle communicates with the Advisor via an Ethernet interface
card in the PC CardBus slots.  The following procedure verifies that the card
slots are enabled.

1. Turn the Advisor power switch on (the undercradle is powered on later).

2. Select Start | Settings | Control Panel and then click the System icon.

3. Click the Device Manager tab.

4. Expand the PCMCIA socket item.  Two CardBus Controller items should be
listed.  If a red X is displayed on either icon for the controllers, do the
following steps:

a. Click on a CardBus Controller item that has a red X.

b. Click the Properties button.

c. In the General tab, locate the Device Usage group.

d. Make sure that the "Disable in this hardware profile" item does NOT have
a checkmark.

e. Click OK.

f. At the PC Card Wizard prompt, "Are you using a PC card (network card,
CD-ROM connected to a SCSI card, etc.) to install Windows?" select No
and then click Next.

g. At the PC Card Wizard prompt, "Do you want to review your system files
and select real-mode PC card drivers so Windows can disable them?"
select No and then click Next.

h. Click Finish.

i. Click the No button at the prompt to shut down Windows to finalize the
setup.
You will shut down Windows after the second CardBus Controller is
enabled.

j. Repeat these steps for the second CardBus Controller item.

k. At the prompt to shut down Windows to finalize the setup of the second
CardBus Controller, click the Yes button.

5. If you had to enable the CardBus controllers in the step above, shut down and
then restart the Advisor.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 5. - Ensure TCP/IP Stack Is Installed

If you have just installed Windows and/or the Agilent 622Vu Advisor
application, use the following steps to verify that the TCP/IP stack is enabled.

1. Select Start | Settings | Control Panel and then click the Network icon.

2. Click the Configuration tab.

3. Scroll the component list and look for a TCP/IP item.

4. If the TCP/IP protocol item is listed, click OK, wait for any open dialogs to
close, then close the Control Panel, and go to the next procedure.

5. If the TCP/IP protocol item is not listed, do the following steps:

a. Click the Add button.

b. Click the Protocol item.

c. Click the Add button.

d. In the Manufacturers column, click Microsoft.

e. In the Network Protocols column, click the TCP/IP item.

f. Click OK.

g. Scroll the list to see if the TCP/IP item is listed.

h. Click OK to close the Network dialog.

i. If a Version Conflict dialog displays a message that an old file is being
copied over a newer file, choose the option to keep the newer file.

j. At the prompt to shut down Windows to finalize the setup, click the Yes
button.

k. Shut down and then restart the Advisor.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 6. - Install the Ethernet Card

The Xircom RealPortTM CardBus Ethernet 10/100 Network Interface Card (NIC)
is supplied and supported for operation with the Agilent 622Vu Advisor.  Use the
following steps to install the card.

1. Turn the Advisor on and wait for the Windows desktop to display.

2. If this is a new Advisor, several screens prompt for information to complete
the configuration.  Answer the prompts.  At the Certificate of Authenticity
prompt, use the number located on the front cover of the Getting Started
Microsoft Windows 98 book shipped with your Agilent Advisor.

3. Insert the Xircom CardBus card in the PC Card slot of the Advisor.

4. If the drivers are not already installed, you should see several drivers being
installed.

Note: If a Version Conflict dialog displays a message that different versions
of files are being copied, read the message carefully and click the option to
keep the newer file.

5. Wait for the New Hardware Found dialog to close.

6. In the DHCP Client dialog, click No.

7. Select Start | Settings | Control Panel and then double click the PC Card
(PCMCIA) icon.

8. Click the Socket Status tab.

“Xircom CardBus Ethernet 10/100 Adapter – Socket 1” should be listed.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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If this item is not listed, see The CardBus NIC Card Is Not Detected During
Installation on page 28 in the troubleshooting section.

9. Click OK to close the Socket Status window.

10. Close the Control Panel window.

Step 7. - Connect the 622Vu Undercradle to the
Ethernet Card

1. Connect one end of
the provided Ethernet
crossover cable to the
Ethernet connector on
the left side of the
undercradle.

2. Connect the other
end of the provided
Ethernet crossover
cable to the Ethernet
network interface
card (NIC) on the
right side of the
mainframe.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor
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Step 8. - Apply DC Power to the 622Vu
Undercradle

1. Connect the
Y cord power
jumper to the
power supply
module.

2. Connect the
power supply
module output to
the Power
connector on the
undercradle.

1:  Installation and Configuration
1.2 Installing 622Vu Advisor

19



1.3  Configuring 622Vu Advisor

Step 9. - Set IP Addresses

The first time you install the Xircom CardBus Ethernet card, you must set its IP
address and Subnet Mask. The 622Vu undercradle and the Advisor default
addresses are:

Default IP Address Default Subnet Mask

Agilent Advisor 15.21.191.200 255.0.0.0

622Vu Undercradle 15.21.191.201 255.0.0.0

Use the Registry Configuration application to set the IP Addresses for the
Advisor.

1. Start the Registry Configuration application.

Note: The address values for the Xircom CardBus card configuration are stored
in the registry and are listed in the “Advisor Config Defaults” column.

2. Click the Restore Defaults button to assign the default values and click Done.

1:  Installation and Configuration
1.3  Configuring 622Vu Advisor
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The following figure provides explanations about the screen’s contents and
controls.

Agilent Advisor IP address
and Subnet Mask address
currently in the Registry.

Enter an IP address
and Subnet Mask
value to be set
in the Registry.

Assign default
config values
to the Internet
Advisor’s
registry.

Default Internet
Advisor IP Address
and Subnet Mask
values.

IP Address of
undercradle with
which 622Vu
Advisor is
configured to
communicate.

Generates a file OC12_CMD.TXT
that contains the proper Console
commands to configure the
undercradle to work with this Internet
Advisor

3. Click OK to accept the new settings.

4. Select Start | Shut Down; restart the Agilent Advisor.

1:  Installation and Configuration
1.3  Configuring 622Vu Advisor
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1.4  Testing the Installation and
Configuration

Use this section to verify that the 622Vu Advisor application and undercradle are
correctly installed and configured.

Step 10. - Test the Installation and Configuration

1. Use the Start menu to start the application; a toolbar is displayed.

2. Click the Manage Devices  toolbar button to display the Device Manager
window.

3. Click the 622Vu#1 item in the left pane of the window.
This item will not display if the undercradle is not installed properly.  See
Undercradle Not Detected by the 622Vu Application on page 25.

4. Verify that the Serial No., MAC Address, and ATM Address fields are not
blank in the Device and Network groups.

5. Verify that the undercradle has been recognized as “OC-12c / STM-4c MMF
(or SMF) in the Hardware Specifications group.

6. If the undercradle was found and the field contents are correct, you are
finished with the installation and configuration.

See chapters 2 and 3 for introductory and getting started information.

7. If no 622Vu undercradle is found, a message displays "Sorry - no CellCards
have been detected.  Please check your configuration and try again.", go to
the following Troubleshooting section.

1:  Installation and Configuration
1.4  Testing the Installation and Configuration
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1.5  Troubleshooting
Configure Standard Modem

This section describes configuring a standard modem so that you can use the
Console application to troubleshoot the 622Vu Advisor application.  

Troubleshooting Problems

This section covers several potential problems you may see during installation
and operation of the 622Vu Advisor.  These problems include:  

•  Undercradle Not Detected by the 622Vu Application

•  The NIC Is Not Detected During Installation

•  Problems With Console

Useful Troubleshooting Tools

Several tools are provided with the 622Vu Advisor application to help you test
and configure the 622Vu Advisor.  These tools include:

•  Ping

•  Configure Registry

•  Console

1:  Installation and Configuration
1.5  Troubleshooting
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Configure Standard Modem

In the 622Vu Advisor’s start menu, the Console selection runs the Hyper-
Terminal application so you can view and configure the 622Vu undercradle’s
parameters.

Even though the connection from the Advisor to the 622Vu undercradle is a
direct serial connection, the Hyper-Terminal application requires a default
modem to be configured.  To enable the Console selection to run without error,
you need to add a modem.

To add a modem:

1. Select Start | Settings | Control Panel, double click the Add New Hardware
icon, and then click Next.

2. At the prompt to search for new hardware, select No and then click Next.

3. In the Hardware Types list, click Modem and then click Next.

4. Put a checkmark in the box labeled "Don’t detect my modem: I will select it
from a list."

5. Click Next.

6. Click Standard Modem Types in the Manufacturers box.

7. Click any choice in the Models box and then click Next.

8. Click any choice for the port to use with the modem and then click Next.

9. If the Location Information dialog displays, enter your dialing information
and click Next.

10. Click Finish and then close the Control Panel window.

When you want to use the Console application, select:
        Start | Agilent Advisor | ATM Analysis | 622Vu Advisor | Console

1:  Installation and Configuration
1.5  Troubleshooting

24



Troubleshooting Problems

Undercradle Not Detected by the 622Vu Application

When you try to start the 622Vu Advisor’s Device Manager and a message
displays, "Sorry - no cell cards have been detected.  Please check your
configuration and try again." displays, try the following steps:

1. Click the Refresh  toolbar button to refresh the 622Vu Advisor’s Device
Manager window contents.

Wait a few seconds to see if the Device Manager detects the undercradle.
Refreshing may work if the undercradle had not finished booting when the
Device Manager first began its search for the undercradle.

2. Check if the DC power adapter is connected to the 622Vu undercradle.
The Power LED on right side panel should indicate the undercradle has
power.
The Sys OK LED should be flashing to indicate normal operation of the
undercradle.

3. Check the cable connections between the Ethernet connector on the left side
panel and the Ethernet NIC card inserted in the PC Card slot.
You must use the supplied crossover cable for this connection.

4. Check if the Ethernet NIC card is operating properly.

a. In the Windows desktop, select Start | Settings | Control Panel and then
double click the System icon.

b. Click the Device Manager tab.

c. Expand the Network Adapters line.

d. Select the Xircom Ethernet Adapters 10/100 item.

e. Click the Properties button.  The Device Status group should indicate
"This device is working properly."

5. Use the Console application to view the power-up sequence.
Note:  The Console application is described in more detail in the following
Useful Troubleshooting Tools section of this chapter.

a. Use the provided cable to connect the Console connector on the 622Vu
undercradle to the Serial connector on the Advisor.

1:  Installation and Configuration
1.5  Troubleshooting
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b. Start the Console application.
Note:  The Console application requires that a default modem is
configured.  See Configure Standard Modem on page 24.

c. Close the 622Vu Advisor application and disconnect power from the
622Vu undercradle.

d. Connect power to the 622Vu undercradle and observe Console messages.

Are power-up messages displayed?

Did the "auto-sensing" of the Ethernet connection work?  For example,
did you see a "100 MB Link Established" message?

e. If no messages display, or pressing Enter does not display the ">>"
prompt, check the cabling between the undercradle Console connection
and the Serial connector.

Are you using the provided (null-modem) cable?

Are the connectors firmly attached?

Is the power on and is the Power LED on?

6. Gather information about the Agilent Advisor and the 622Vu undercradle.

Agilent
Advisor

In the Start menu, select
Agilent Advisor | ATM Analysis | 622Vu Advisor | Config Tool.

Verify if the registry information is correct.  The default information
shows:           Agilent         Undercradle Address
                Advisor         in Config file

IP Address      15.21.191.200       15.21.191.201

Subnet Mask     255.0.0.0

622Vu
Undercradle

Connect the provided cable between the Console connector on the
undercradle and the Serial port on the Advisor.
In the Start menu, select
Agilent Advisor | ATM Analysis | 622Vu Advisor | Console.
Verify if the IP Address, Subnet Mask, and Gateway addresses are
correct.  Do this by typing commands on the console.

  COMMAND          DEFAULT RESULTS

show ipaddr        15.21.191.201

show mask          255.0.0.0

show gateway         gateway: 15.21.191.200

                     host/network: 15.21.191.200

1:  Installation and Configuration
1.5  Troubleshooting
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7. If the undercradle’s settings on the previous step are not correct, use the
Console application to edit the IP Address or Subnet Mask.  Then power
down and power up the undercradle and repeat step 6 to test the undercradle.

8. If the Advisor’s settings in step 6 are not correct, use the Config Tool to
modify the IP Address or Subnet Mask.  Then restart the Advisor and repeat
step 6 to retest the Advisor.

9. If the address of the undercradle in the Config Tool application does not
match the undercradle, start the 622Vu Advisor application.

a. Click the Manage Devices  toolbar button.

b. Select Tools | Configure Server List.

c. Highlight the IP Address and click the Edit button.

d. In the Remote Server Information dialog, edit the IP Address and click
OK.

e. Close the Remote Server List dialog.

f. Restart the Advisor and repeat step 6 to retest the Advisor.

10. The section Useful Troubleshooting Tools on page 31 describes how to use
Ping to see if the Advisor can find the undercradle.

If you still have problems, call 1-800-698-0061 for support or contact your local
Agilent Technologies Sales and Service Office.
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The CardBus NIC Card Is Not Detected During
Installation

The 622Vu undercradle communicates with the Agilent Advisor via an Ethernet
NIC card in the PC CardBus slot.  If you have trouble installing the provided NIC
card, you may be having a conflict between the Xircom CardBus NIC card
drivers and other installed NIC card drivers.

Try the following steps to isolate the problem.    

1. Shut down the Advisor and turn the power off.

2. If an Agilent J2901 Gigabit undercradle is attached to the Advisor, remove
the undercradle.

3. Turn the Advisor on and as soon as the memory count is complete, press the
F8 key a couple of times.

4. Select item 3 “Safe Mode” from the Microsoft Windows Startup Menu.

5. Answer OK to the safe mode warning.
Note:  In Safe Mode, the serial mouse may not be functional.  Therefore, the
following instructions are for the keyboard.  If you have a functioning serial
mouse, you can use it instead of the keyboard.

6. Use the Microsoft Window key to bring up the Start Menu.

7. Use the arrow keys to launch the Control Panel.

8. Use the arrow keys to launch the System icon.

9. Use CTRL + TAB to select the Device Manager tab.

10. Use the arrow keys to select “Other devices”.

11. Use the right arrow to open the “Other devices” list.

12. Examine the devices in the “Other devices” list and with the exception of the
devices listed in Note below, delete every device in the “Other devices” list
by using the following steps:

Note: Do NOT delete the following devices.

•  Agilent J2524 FDDI Interface for Advisor LAN
•  Agilent Advisor Plug & Play Driver
•  PCMCIA Card Services

a.  Use the arrow keys to highlight an entry to delete.

b.  Press the delete key (Del).

c. Press Enter (OK) to confirm the device removal.
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d. Repeat steps 9 thru 11 until all devices have been removed from the
“Other devices” list.
Remember, the devices listed in the Note above should not be deleted.

13. Use the Tab key to highlight the Close button and press Enter.

14. Use Alt+F4 to close the Control Panel window.

15. Use the Microsoft Window key to display the Start Menu.

16. Use the arrow keys to Shut Down the system.

17. Turn the Advisor power off.

18. Turn the Advisor power on.

19. Use Windows Explorer to go to directory C:\Windows\Inf and delete the
following files\directories:

•  fx1k.inf

•  xi_cfg.inf

•  xi_desc.inf

•  xi_mem.inf

•  xi_stat.inf

•  drvdata.bin

•  drvdx.bin

•  Other (directory)

20. Shut down the Advisor and turn the power off.

21. Turn the Advisor power on.

22. Insert your CardBus NIC card.
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Problems With Console

The Console application provides a remote terminal to view and edit parameters
in the 622Vu undercradle.  If the Console application is not communicating with
the undercradle, try the following steps.  

1. Use the provided cable to connect between the Console connector on the
undercradle and the Serial port on the left side of the Advisor.

2. A modem must be configured.  If you get the message:
"Could not read session file: %S", you have not configured a standard
modem,

a.  Use the procedure, Configure Standard Modem on page 24, to configure a
modem.

3. If you have a Serial Mouse connected to the Serial port:
Remove the Serial Mouse from the Serial port.
Power down, then power up and use the keyboard mouse.
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Useful Troubleshooting Tools

Several tools are available to troubleshoot the 622Vu Advisor operation with the
622Vu undercradle.  Each of these tools is described below.

Ping

You can use the Ping function to test if the Advisor can reach the 622Vu
undercradle.

1. At the MS DOS prompt, type:
ping 15.21.191.201 and press Enter.
This is the default IP address of the 622Vu undercradle.

You should see a timing information about the Ping test if it is successful.

2. If you get messages that the Ping test failed, try the following steps:

Request
timed out

If the request times out, you can conclude that the NIC card is installed
properly.  You can now question the operation of the undercradle and the
supplied crossover cable.  To verify the cable’s operation:

Power On LED should be on.
Sys OK LED should be flashing.
Use the Console application as described in the "Undercradle Not Detected"

procedure in the "Troubleshooting Problems" section of this chapter.

Destination
Host
Unreachable

This message makes you question the installation and configuration of the NIC
card.  The message tells you that the Advisor did not "know" which NIC card
to use to reach the Ping destination.

The Registry Configuration tool can show you the currently set IP Address and
Subnet Mask of the installed NIC card.

                                Undercradle address

            Agilent Advisor     in Config file

IP Address   15.21.191.200       15.21.191.201

Subnet Mask  255.0.0.0

If these values look proper:
Uninstall all PCMCIA/PC CardBus card drivers.
Reinstall the provided Xircom CardBus Ethernet NIC card.
Use the procedures in the earlier installation and configuration topics to

verify the TCP/IP stack is installed and verify IP addresses of the
undercradle and the Advisor.

Repeat the Ping test.
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3. If you make any changes that allow Ping to operate successfully, try the
622Vu Advisor application again to see if it now can retrieve undercradle
information.

Registry Generation and Command File Generation
Tool

The Config Tool application lets you view and edit the registry for addresses
currently being used by the Advisor.  You can also view the address the Advisor
is currently using to communicate with the 622Vu undercradle.  

1. Start the Config Tool application.

Agilent Advisor IP address
and Subnet Mask address
currently in the Registry.

Enter an IP address
and Subnet Mask
value to be set
in the Registry.

Assign default
config values
to the Internet
Advisor’s
registry.

Default Internet
Advisor IP Address
and Subnet Mask
values.

IP Address of
undercradle with
which 622Vu
Advisor is
configured to
communicate.

Generates a file OC12_CMD.TXT
that contains the proper Console
commands to configure the
undercradle to work with this Internet
Advisor
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2. You can use the Console application in conjunction with the generated
OC12_CMD.TXT file to configure the 622Vu undercradle’s IP, Subnet Mask,
and gateway addresses.

See the topic "Use of Generated File" later in this troubleshooting section.

Note: In the 622Vu Advisor’s Device Manager view, use the Tools | Configure
Server List item to edit what 622Vu undercradle IP address is used as the
destination undercradle address.

Console

The Console connection is not needed for normal operation of the 622Vu
Advisor.  It is used mainly to let you view and edit the IP, Subnet Mask, and
gateway addresses stored in the 622Vu undercradle’s flash ROM.   

Note:  The Console application requires that a default modem be configured.
See Configure Standard Modem on page 24

To start the Console application:

1. Use the provided cable to connect the Console connection on the 622Vu
undercradle to the Serial connection on the Advisor.

2. Start the Console application:

3. Press the Enter key to display the ">>" prompt.

4. Type   help  and press Enter to display console commands for
controlling the 622Vu undercradle parameters.

Console
Commands
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5. For example, the "show" and "set" commands are useful to view existing
parameters and to edit the parameters to new values.

Command Action / Default

set ipaddr n.n.n.n Set the IP address of the 622Vu undercradle to n.n.n.n
Default = 15.21.191.201.

set mask n.n.n.n Set the subnet mask to n.n.n.n.
Default = 255.0.0.0

set gateway n.n.n.n
   destination n.n.n.n

Set the gateway and destination IP Address to that of the
controlling Agilent Advisor that communicates with the
undercradle.
Default = 15.21.191.200   15.21.191.200

show setting Show the value of the specified setting, which can be: name,
ipaddr, mask, gateway, or macaddr.

banner Display version information.

reset Restart the system.

6. Press Enter in the terminal window to start the command line interface.
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7. Use the set ipaddr command to set the 622Vu undercradle’s address.  For
example:

set ipaddr 15.21.191.201

8. Use the set mask command to set the 622Vu undercradle subnet mask.  For
example:

set mask 255.0.0.0

9. Use the set gateway command to set the IP addresses of both the gateway
and the Agilent Advisor.  For example:

set gateway 15.21.191.200 destination 15.21.191.200

10. Enter reset to restart the system with your new settings.

Remove the Console cable.

11. Close the Console application.
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Use of Generated File

In addition to the previous procedure to manually set the controlling Agilent
Advisor’s IP Address, Subnet Mask, and Gateway/destination IP address, you can
do the same configuration via a generated file of commands.  This file is
generated when you press the "Generate File" button in the Config Tools
application.

The Generate File button takes the information contained in the Advisor’s
registry and the 622Vu Advisor application’s configuration file and generates a
text file of console commands.  The generated file is OC12_CMD.TXT.

When you have created the OC12_CMD.TXT file, use the Console application and
select Transfer | Send text File to send the commands in the text file to the
undercradle just as though they were typed in.
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Chapter 2

Introduction

622Vu Advisor is a full bandwidth, Asynchronous Transfer Mode analysis and
management system.  It’s designed for use by network managers, technicians,
and development engineers involved with all aspects of ATM technology.  622Vu
Advisor lets you monitor, analyze, and manage the physical interface to each
ATM device, as well as the traffic passing through each port.

This manual uses the terms port and channel interchangeably when channel
refers to the actual physical connector on the Agilent Advisor system.

CAUTION:  622Vu Advisor is very powerful!  It allows extensive analysis of
any problem that might occur during ATM transmissions.  Because of this,
622Vu Advisor lets you transmit anything;  it assumes that any bad or broken data
introduced into cells or packets is being introduced intentionally.  (From the
analysis standpoint, a corrupted cell may be what you want.)  It’s important, then,
that you fully understand all the implications of 622Vu Advisor’s operation.
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2.1  Overview of Processing

Monitor Mode vs. End Station

You can operate 622Vu in monitor mode or as an end station:

•  When operating in monitor mode, the 622Vu Advisor passively observes the
traffic flow coming through it, optionally capturing some or all traffic for
further analysis.

•  In end-station mode, the 622Vu Advisor is a known, visible end station on
the network, capable of transmitting ATM cells, ping messages, and
QoSMeter tests, as well as monitoring and capturing traffic as it’s received.

Capturing Traffic

In either mode, 622Vu lets you capture traffic as it moves through the analysis
device, and analyzes the functional characteristics of the ATM DUT (device
under test) as reflected by that traffic.

You can filter the incoming traffic if you wish, to restrict the capture to certain
types of cells or specific paths, or simply to restrict the amount of memory used
to store captured cells.  622Vu offers a variety of filtering capabilities, including
real-time filtering by IP address, VCC, and/or protocol.

After a capture finishes, you can search the capture file for specific values, create
(and save) virtually any subset(s) of the captured cells or PDUs, and optionally
turn the capture (or subset) into a script that you can then send over the network
for further analysis.  If you save a capture file, you can then export it in any of
several formats:  full textual decode, the standard 622Vu format, or Network
Associates Sniffer format

Real-time Statistics

Any time you’re not capturing traffic actively, 622Vu lets you monitor real-time
statistics for the link attached to an analysis device.  At your request, it displays
the active network connections on the link, providing statistics in a tabular
fashion so you can track bandwidth use easily.  It also offers a graphing
capability, so you can lay out the statistics in graphical form.

Each time 622Vu detects a new connection, it displays the corresponding VP/VC
identifiers and begins tracking statistics for that connection.  If you notice a
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problem while monitoring the statistics, you can begin capturing any particular
VCC(s).

Scripts

While in end-station mode, you can send out transmission scripts over the
network.  Each script comprises a predefined, specific pattern of standard ATM
transmissions (i.e., transmit sequences and timed pauses).  You can monitor a
link as the script traffic passes through it, and optionally capture that traffic on
another analysis device.

Ping Tests

Also while in end-station mode, you can transmit standard ping messages
through an ATM network, targeting a specific destination address.  You can
monitor the results as responses come back for these messages, tracking packet
counts and latency information.

QoSMeter Test Sessions

While in end-station mode, too, you can send QoSMeter sessions over a
particular virtual circuit.  Each QoSMeter test session comprises a series of
identical tests, with the test itself defined as some amount of traffic that’s
transmitted using a certain percent of available bandwidth.  The traffic is
analyzed by a receiving device, and the results can be monitored from your PC.
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2.2  Specific Capabilities
622Vu lets you:

•  Configure analysis devices.

•  Monitor physical ATM ports while they send/receive traffic, allowing you to
observe the characteristics of the physical interface to ATM devices.

•  Capture and examine traffic as it enters the analysis device.  You can capture
all traffic or only selected traffic, as controlled by 622Vu’s optional filtering
capability.  This filtering capability allows you to restrict the capture to only
certain types of cells or specific paths, and/or to restrict the amount of
memory used to store captured cells.  622Vu offers a variety of filtering
capabilities, including real-time filtering by IP address, VCC, and/or
protocol.

•  Manipulate files of captured cells:  to create subsets of the cells and/or PDUs,
to locate specific information within the captured traffic, to generate scripts
(groups of cells) to send out over the network for further analysis, and so
forth.

•  Save captured traffic (or a subset of a particular capture).  If you save a
capture file, you can then export it in any of several formats:  full textual
decode, the standard 622Vu format, or Network Associates Sniffer format.

•  Send out scripts (available only in end-station mode), where each script
comprises a predefined, specific pattern of ATM traffic (transmit sequences
and timed pauses).

•  Generate ping messages to verify connectivity to remote end stations through
an ATM network.

•  Send data over a particular virtual circuit (available only in end-station
mode), to test the quality of service over that VCC.  This is known as
QoSMeter testing, and emphasizes analysis of variations in cell delay and
latency of data transmission.

•  Monitor real-time statistics for the link attached to an analysis device
(available any time, unless you’re actively capturing traffic).  At your
request, 622Vu displays the active network connections on the link,
providing statistics in a tabular fashion so you can track bandwidth use (and
error counts) easily.  It also offers a graphing capability, so you can lay out
the statistics in graphical form.  If you notice a problem while monitoring the
statistics, you can begin capturing any particular VCC(s).   
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2.3  How Does It Work?
622Vu Advisor lets you analyze ATM networks and systems systematically,
using a simple Windows-based approach.  To do this, it passes requests to the
622Vu Advisor hardware through the CellCommand server interface:    

Figure 1.  622Vu Advisor’s Component Architecture

The cell library, shown to the left of CellCommand in Figure 1, serves as a
repository for various 622Vu Advisor information:  sequence definitions (groups
of cells), script definitions (groups of sequences and timed pauses), filterset
definitions, QoSMeter test sessions, etc.  622Vu Advisor can manage any number
of cell libraries, but only one library is open (active) at any given time.       

2.4  Where To Go From Here
Other chapters in this manual describe how to use 622Vu Advisor to perform
specific tasks, and how to use the ping-message generation tool:

For Instructions to…
See

Chapter… Page

Install and configure the 622Vu Advisor software and the 622Vu
undercradle.

1 9

622Vu

CellCommand 

Analysis Device

Windows in-process 
OLE Automation server

Windows 

Cell
Libraries

(622 Undercradle)

Power Sys OK Fault Active ATM 1 OK ATM 2 OK
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For Instructions to…
See

Chapter… Page

Get started with 622Vu Advisor, including use of its menus, toolbars,
user profiles, and general processing information.

3 43

Instructions to configure analysis device(s).  Includes specifics related
to the physical interface (OC-12c/STM-4c).    

4 55

Monitor the characteristics of the physical interface to each ATM port
as traffic flows through that port.   

5 67

Capture traffic as it moves through the network;  specifically, as it
enters the incoming channel on an analysis device.  Includes
instructions to manipulate the captured cells upon completion of the
capture (to create subsets of the capture, search for specific data,
generate scripts from the data, etc.).

6 77

Monitor real-time statistics for the link attached to an analysis device. 7 117

Use 622Vu Advisor’s filtering capability to restrict the cells that are
saved in a capture, and/or to control the use of available capture
memory.     

8 131

Define sequences (groups of cells) that you can send out over the
network to analyze ATM networks.

9 153

Define and run scripts, where each script comprises a predefined series
of sequences and timed pauses that can be sent over the network in a
controlled manner.

10 171

Generate ping messages to verify connectivity to remote end stations
through an ATM network.

11 181

Define and run QoSMeter test sessions to analyze the quality of
service over a particular VCC.

12 185

The appendixes present information as follows:

Appendix Description

A: Glossary Definition of terms.   

B: config.ini File Listing of the initialization file installed with 622Vu Advisor.  

C:  Summary of Libraries Description of the cell libraries distributed with the system.

D:  Cell Library Structure Description of the internal structure of 622Vu Advisor’s libraries.

E:  Regulatory Information Regulatory information and Declaration of Conformity.
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Chapter 3

Getting Started

To start 622Vu Advisor, either double-click its shortcut icon (shown to the left),
or choose it from the Agilent Advisor Windows Start menu.

622Vu Advisor opens its main toolbar:

Main menu.  These pulldown
menus give you access  to
622Vu’s full range of features.

System toolbar

Profile toolbar

Current (in-use) cell library

Current user
profile

Current
time

Use the pulldown menus to direct your processing, as described starting on page
45.  As an alternative, use the toolbars to choose the processing you want through
a simple point-and-click method:

•  The system toolbar lets you choose the most commonly used commands
easily.  It also displays the name of the current (in-use) cell library, and the
time.

The first and last command groups on the system toolbar deal with
housekeeping functions, and are covered in this chapter.  The commands in
the center of the toolbar let you direct 622Vu Advisor’s capabilities, and are
detailed in subsequent chapters.

•  The profile toolbar lets you establish user profiles that tailor the 622Vu
Advisor application for individual users or types of analysis.  Each user
profile comprises a combination of settings that become active when that

622Vu
startup icon

3:  Getting Started

43



profile is used, including a set of scripts that can be run directly from the
toolbar.  You can define as many user profiles as you wish (see page 50),
then display a toolbar that’s specific to the profile you want.  The profile
name displays to the right on the toolbar;  standard.prf in this example.  

In addition to the toolbars themselves, 622Vu Advisor provides bubble Help that
describes each toolbar button.

You can toggle use of the toolbars and toolbar Help via the
View menu.  Use the first two commands in that menu to toggle
display of the system and profile toolbars, respectively.  The last
option, Enable Toolbar Help, toggles the system toolbar’s
Help feature on and off.  With this feature enabled, 622Vu Advisor’s bubble
Help describes each toolbar button as you point to it:

All 622Vu Advisor processing requires that you have an active cell library.  Any
changes you make during processing are saved in the active cell library
immediately.  Before proceeding, make sure the cell library you want to update is
open.  Refer to Section 3.3  Managing Cell Libraries (page 47) for related
instructions.

While 622Vu Advisor runs, you’ll see this icon in your taskbar: .

This icon represents the CellCommand32 OLE Automation Server application
being used by 622Vu Advisor.  Do not shut this application down explicitly;
622Vu Advisor will close it when it’s no longer needed.

If you need Help with any of 622Vu Advisor’s windows, either press <F1>, click
the Help button on the window you’re processing, or use the Help menu to
choose any of several Help-related commands.

When you’re through running 622Vu Advisor, click the Exit Application button
(or choose Exit from the File menu).

 

Displaying Toolbars
& Toolbar Help

The Active
Cell Library

Taskbar Icons

Obtaining Help

Exiting 622Vu
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3.1  Summary of Menu Commands

Menu Command
Toolbar

Equivalent Used to…

File
New Library Create a new cell library.    

Open Library Open a cell library.

Edit User Profile

profile toolbar

Edit a user profile to change one or more
specifications, then either save the changes for the
same profile, or save the changes under a new
name.   

Load User Profile

profile toolbar

Load a user profile, configuring 622Vu Advisor
according to that profile’s settings.   

Exit Exit 622Vu Advisor.

View
System Toolbar — Toggle display of the system toolbar.

Profile Toolbar — Toggle display of the profile toolbar.

Enable Toolbar Help — Toggle use of bubble Help for the system toolbar
buttons.

Activities
Manage Devices Launch the Device Manager, which is used to

configure analysis devices and to monitor the
physical interface between a device and an ATM
device (e.g., after executing a script, or simply to
get a general sense of the traffic and physical
medium).  Also used to generate errors in the
physical transmission layer.

Real-Time Statistics Launch the Real-Time Statistics application,
which lets you monitor active network
connections on the link attached to a device, and
provides related statistics in both tabular and
graphic format.

Capture Launch the Capture utility, which is used to
initiate and monitor cell captures, and/or to
review and manipulate captures that were run
previously.

Capture Filters Specify filtering criteria for use when capturing
cells.

Transmit Scripts Browse and execute (then optionally monitor)
scripts.

Edit Transmit Sequences Define or edit a transmit sequence, including
individual cells in that sequence.
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Menu Command
Toolbar

Equivalent Used to…

QoSMeter Launch the QoSMeter utility, which is used to
test the quality of service over a particular VCC.

Ping Generation Launch the Ping Generation tool, which sends
standard ping messages through an ATM
network, targeting a specific destination address.

Tools
Cell Sequence AAL Wizards
(AAL5)

— Define AAL5 PDUs easily, adding them to an
existing or new sequence.  The system prompts
for all the information necessary to generate the
PDU, and computes the end-of-datagram
automatically.   

Window
Minimize All Windows — Minimize all 622Vu Advisor windows.

Restore All Windows — Restore any 622Vu Advisor windows that were
minimized previously.

title of each open window — Make the window you choose active.

Help
Contents — Display the Help Contents.

How to Use Help — Display the standard Windows Help window,
including tabs for Contents, Index, and Find.

Obtaining Technical Support — Display instructions to contact technical support,
information about the software versions you’re
running, and the specifics of your installed
devices.

About 622Vu Advisor Display general information about 622Vu
Advisor, including version, licensing information,
available system resources, etc.    
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3.2  Connecting to the ATM Network
When you are ready to connect your 622Vu undercradle  to your ATM network
use the following steps:   

1. Insert the 622Vu undercradle between two ATM devices by attaching ATM
cables (not supplied) from the two devices to Ports 1 and 2 on the 622Vu
undercradle’s right-side connector panel.

Local
ATM Device

Tx

Rx

In

InOut

Out622Vu 
Undercradle Tx

Rx Remote
ATM Device

Long single-mode
fiber-optic cable

Short single-mode
fiber-optic cable

Attenuators attach at both the Tx and Rx 
ports for a particular channel on the shortest 
end of the single-mode fiber-optic connection.

Right Side Connector Panel

OC-12c/STM-4c
622 Mb/s SM Port 1 Port 2

In  Out In  Out 

To ATM
device 1

To ATM
device 2

Port 1 Port 2

2. If you are using a single-mode fiber-optic interface and connecting the
622Vu undercradle on a relatively short run of the cable (one mile or less),
you must use 10-db inline attenuators to protect both the ATM device and the
622Vu undercradle from the power of the laser.  For the channel that is
running out over the shortest length cable in this case, attach an attenuator to
both the Transmitting (Out) and Receiving (In) ports on the 622Vu
undercradle.
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3.3  Managing Cell Libraries
Remember from Chapter 2 that 622Vu Advisor stores its information in a central
repository known as a cell library.  You can have any number of cell libraries,
but each library is a complete entity, containing all the sequence definitions,
script definitions, filterset definitions, QoSMeter test sessions, etc., that are used
together during processing.    

622Vu Advisor provides commands to open and create cell libraries, as detailed
below.

Note: For processing efficiency, 622Vu Advisor only stores two types of information outside of
the cell library:  configuration information and cell-capture files.  The configuration
information includes a standard initialization file, config.ini, and user profiles that are stored
using a standard Windows format.  The capture files are stored as binary files, to allow for
quick access, transport on floppy disk, and transmission over a network.  

Opening a Cell Library

You can only have one cell library open at a time, and all actions apply for that
library until you close it.  When you start 622Vu Advisor for the first time, it
opens with a standard library called standard.lib.  You can use this library or any
of the other libraries shipped with 622Vu Advisor (detailed in Appendix C);  or
you can define one or more different libraries for use at your site.   

To open a library, click the
toolbar’s Open Library button
(or choose Open Library from
the File menu).  This opens a
standard file-open dialog box
that you’ll use to navigate to
the library you want (shown to
the right).

As necessary, refer to your
Windows documentation for instructions to use this dialog box.

Note: When you open a cell library, 622Vu Advisor automatically closes the old library for you.

If you always work with a particular library, make sure to specify that library in
your user profile (see Editing a User Profile on page 50).  

Open Library
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Creating a New Cell Library

Each cell library is fully self-contained, and many users store all their definitions
in a single library;  however, the system lets you maintain multiple discrete
libraries, as necessary.  Click the toolbar’s New Library button to define a new
cell library (or choose New Library from the File menu).

622Vu Advisor opens a dialog box that prompts for the name of the new library
(similar to the one shown above for open-library processing).  Specify the
filename you want, using the format name.lib.  If you omit the suffix, 622Vu
Advisor assigns it correctly.  Cell libraries can be stored anywhere, but typically
reside in 622Vu Advisor’s \library directory.

Saving Library Changes

Any changes you make during a 622Vu Advisor session apply for the active (i.e.,
open) cell library, and are saved immediately when you click the Apply or OK
button from a processing window.    

3.4  Setting Up User Profiles
622Vu Advisor lets you set up one or more user profiles, each comprising:

•  A combination of settings that become effective when that profile is loaded:
a particular cell library, use of toolbars and toolbar Help, and so forth.

•  Up to 16 scripts that are run regularly by the profile user(s).  The scripts
associated with a particular profile are available to all users throughout the
system, and are simply associated with the profile to facilitate their
execution.  Each script has a corresponding run button on the profile’s
toolbar, allowing you to run it with a click of the mouse.  Any one script can
be associated with several profile toolbars.  

•  Preferences (and other information) that’s stored session to session, so you
can restart with the same settings.

Profiles provide an easy way to establish a particular configuration quickly, but
don’t restrict you to the profile-specific settings;  you can change any settings
you want, regardless of the profile in use.

622Vu Advisor is distributed with one standard profile, called standard.prf.  This
profile is active when you first start 622Vu Advisor;  thereafter, the application
starts with the last profile used.   

New Library
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Loading a User Profile

You can change the active user profile at any time, as necessary to adjust the
default settings or to bring up a different set of commonly executed scripts.

To do this, click the profile toolbar’s Load User Profile button (or choose the
corresponding command from the File menu).  This brings up a standard file-
open dialog box:

Use this dialog box to navigate to the profile you want, then click OK.  Profile
files use the suffix .prf.  They can be stored anywhere, but typically reside in the
622Vu Advisor’s \profile directory.

After you select a profile and click OK, 622Vu Advisor loads the requested
profile and configures itself to be consistent with that profile (to show toolbars or
not, for example).     

Editing a User Profile

You can edit a user profile to change it, or to define a new profile that you’ll save
under a different name.  To initiate the edit, first make sure the profile you want
to change is active.  (If it’s not, load it as described above.)  Then click the Edit
User Profile button on the profile toolbar (or choose the corresponding
command from the File menu).

622Vu Advisor opens a window you can use to modify the profile.  Tab to each
category of setting, in turn, making changes as necessary.  When you’re through:

•  Click OK to save the new definition.  622Vu
Advisor asks if you want to reload the revised
profile (right).  Click Yes to reload;  No to
continue with the previous settings.  In either
case, 622Vu Advisor saves the profile.

Load
User Profile

Edit
User Profile
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•  Click Save As to save the changes under a new name then load the new
profile.  Use the standard Save dialog box to assign a name to the profile,
using the format name.prf.  If you omit the suffix, 622Vu Advisor assigns it
correctly.  Profiles can be stored anywhere, but typically reside in 622Vu
Advisor’s \profile directory.

Note: In addition to the settings described here, you can establish user-profile settings for use
during capture processing.  These are edited differently, as described with the capture
facility (Chapter 6).

General Settings

Use the General tab to identify the default cell library for the profile, and the
default format in which to view (and enter) cell-header information:

Name of the active
profile (Display-only).

Cell library opened
when the profile loads.

Default format used to specify
and display cell-header
values.

•  Specify the Default Library as the name of the library to open when the
profile is loaded.

•  Specify the Header Format as either Hexadecimal or Decimal, indicating
the default format to use when displaying or entering the cell header
(VPI/VCI, PTI, etc.).  As necessary, you can override this setting on each
window used to specify cell-header information.

Toolbar Settings

Use the Toolbars tab to enable or disable the display of the two toolbars, as well
as the associated bubble Help.  If you enable the profile toolbar, you can identify
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up to 16 scripts that will run directly from that toolbar, using the Toolbar Scripts
panel (bottom of window):

Use these buttons to shift
scripts back and forth
between the unselected
(right) and selected (left)
sides.

Other scripts you can add
to the toolbar.

Click to toggle display of the
toolbars and bubble Help
(same as changing these
settings via the View menu).

Scripts available on the
profile toolbar.
622Vu places one
button on the toolbar for
each script in this list.

Click on a script, then use
these buttons to move it
up or down in the list.

•  Mark Display System Toolbar to display the system toolbar.

•  Mark Display Profile Toolbar to display the profile toolbar.

•  Mark Enable Toolbar Help to display the system toolbar’s bubble Help.

•  Use the Toolbar Scripts area to identify those scripts you want to execute
directly from the profile toolbar.  The righthand side of the Toolbar Scripts
area lists each script defined in the Default Library associated with this
profile (via the General tab), but not yet assigned to the toolbar.  To associate
a script with the profile (and add it to the profile toolbar), select it in this
righthand box, then use the Add button to shift it to the left (i.e., selected)
box.  If a script is selected (highlighted) in the lefthand list when you do this,
622Vu Advisor places the new script just after the highlighted one;
otherwise, it places the new script at the end of the list.  As necessary, use the
Remove button to shift a script back to the unselected area.

When a user profile loads, 622Vu Advisor assigns buttons across the toolbar in
the same order as the scripts are listed in the lefthand box:  the first script is the
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left-most button on the profile toolbar, the second script is the next button, and so
forth.  The bubble Help identifies the script associated with each button:

If the order of the scripts is important to you, use the Up and Down buttons to
position the script names correctly in the selected list.  (Select a script then click
the appropriate button to move it.)

A word of caution:  If you change the profile’s cell library after assigning scripts, then load the
profile, the script buttons on the profile toolbar correspond to scripts in the new library, and
not in the library from which you originally assigned them.  If the new library doesn’t have
a script to match a particular name, the profile ignores that script entry.
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Chapter 4

Configuring Analysis
Devices

622Vu Advisor’s Device Manager lets you configure analysis devices, and/or
monitor the physical interface between an analysis device and the ATM device
under test.  This chapter describes how to configure analysis devices.  Refer to
Chapter 5 for instructions to monitor the physical interface.

Starting the Device Manager

Click the Manage Devices button to initiate the Device Manager.  622Vu
Advisor builds a device list, then displays the Device Manager window:

Manage Devices
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Lefthand Side of the Initial Display

The lefthand side of this window has one line for the analysis device that you can
access.

You’ll only see the devices that are available for use currently.  If the specific
device is already performing RAM-intensive activity (such as a capture), it won’t
appear in the list.  If you expect to see a device that isn’t here, click the Refresh
button to reevaluate its status.

Righthand Side of the Initial Display

The righthand side of the window shows information that corresponds to the
device selected (left side).  This information is retrieved from the hardware and
cannot be changed.  It includes device, network, hardware, and resource
information, as described below:

Panel Field Description

Device Name System name to identify each device, followed by a
number (always 1).

Style Type of device (always 622Vu Advisor).

Serial No Analysis device’s identifying serial number.

Network IP Address Internet Protocol address to identify the analysis
device.

MAC Address Media/Medium Access Control address to identify the
analysis device.

ATM Address ATM address to identify the analysis device.

Hardware
Specifications

Physical
Interface

Type of connection supported between the analysis
device and ATM device, followed by the type of media
used to connect to the ATM device:

OC-12c/STM-4c (SMF)

Hardware
Revision

Hardware revision.

Microcode
Revision

Revision of the device’s microcode.

Resources Memory Bank 1 If the analysis device is configured as an end station,
this is the amount of RAM available for capturing
traffic.

If the analysis device is configured as a monitor-only
station, this is the amount of RAM available for
monitoring/retransmitting traffic over Channel 1.

Memory Bank 2 If the analysis device is configured as an end station,
this is the amount of RAM available for cell
transmission (i.e., executing a script).

Refresh
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Panel Field Description

If the analysis device is configured as a monitor-only
station, this is the amount of RAM available for
monitoring/retransmitting traffic over Channel 2.

Menu and Toolbar Commands

Use the Device Manager menu and toolbar commands as described in Table 1
(page 57).

Upgrading Firmware

Note:  This operation is
only necessary if the
undercradle has lost its
programming.  It should
not be necessary to do
this operation regularly.

To upgrade the firmware
on a 622Vu Advisor, choose Update Firmware from the Tools menu.

Using the dialog returned, enter your user name and password (initially admin
and adminpass, respectively), then navigate to the upgrade file you want to use.
Click Browse and then locate c:\advisor\622Vu\firmware6.fls.  Click
Upgrade when you are through.

622Vu Advisor displays a progress bar during the upgrade, then asks you to
reboot the device (necessary after an upgrade, before you can access the device):

Table 1.  Device Manager Menu Commands and Toolbar Buttons

Menu Command
Toolbar

Equivalent Used to…

File
Exit Close the Device Manager.
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Menu Command
Toolbar

Equivalent Used to…

View
Toolbar — Toggle display of the toolbar.

Status Bar — Toggle display of the status bar (bottom of window).

Refresh Reevaluate the status of each device and rebuild the list of
available devices.

Tools
Configure Device Configure the selected device.  The specifics of this

window vary depending on the physical interface
supported (OC-12c/STM-4c), and the current
configuration of the analysis device.  Details follow in this
chapter.

Monitor Physical
Interface

Monitor the ATM network via the selected device.  Refer
to Chapter 5 for information about this feature.

Update Firmware — Upgrade the device to a new version of firmware.  Refer to
page 57 for information about this feature.

Configure Server
List

— Define which analysis devices are available to your
system.  Refer to page 59 for details about this feature.

Reboot Device — Reboot the selected device.  622Vu Advisor verifies your
request before rebooting the hardware.

Window
Close All — Close all Device Manager windows.

Windows... — Make a window active or close a window.

Help
Help Topics — Display standard Windows Help for the Device Manager.

About Device
Manager...

— Display general information about the Device Manager.
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Configuring the Server List

The Device Manager lets you configure the list of analysis devices available to
you, without having to go into the config.ini file directly.  (The device list is
maintained in config.ini.)  To do this, choose Configure Server List from the
Tools menu.  622Vu Advisor opens a list of devices currently configured for
your use:

•  Click Add to add a device to the list, making
it available for use by your system.  622Vu
Advisor opens a dialog box (right) that lets
you specify the server name and IP address of
the device:

Specify the Server Name as the system name associated with the analysis
device.

Specify the IP Address as the Internet address assigned to the analysis
device, using dotted notation.

Click OK when you’re
through.  622Vu Advisor
updates the config.ini file to
add the device (shown right).
Use the Refresh button to
reflect the new device in the
display.
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•  To change a device name or IP address, first select the device from the list,
then click Edit.  622Vu Advisor prompts for the changes using a window
similar to the one described above for an add.

•  As necessary, select an address then click Remove to delete it from the
device and server lists.

Selecting a Device to Configure

To view or define the configuration information for an analysis device, first
select the analysis device you want in the lefthand side of the window.  Then
either click the Configure Device button (shown left) or choose the
corresponding command from the Tools menu.

622Vu Advisor opens a window used to
configure the selected analysis device.

Grayed options, if shown, are not config-
urable with the version of the hardware
you’re using.

Proceed as follows from the configuration
window:

1. Use the Operation Mode tab to
identify the mode of operation under
which the device should function, and
related settings.

2. Use the Options tab to establish settings that are specific to the physical
interface installed, and common to both channels.  If there is no Options tab,
there are no settings that apply across channels.

3. Use the Channel 1 and Channel 2 tabs to set channel-specific options.  If
there are no Channel tabs, there are no settings that are specific by channel.

Click Apply as necessary, to save the settings on the active property sheet (i.e.,
tab).  Click OK to save the settings on all the configuration tabs.

The next section describes the Operation Mode configuration for the OC-
12C/STM-4C interface.

When you’re through configuring the device(s), choose the Exit command from
the File menu.

Configure Device

4:  Configuring Analysis Devices

60



4.1  Configuring the Operation Mode
At any point in time, each analysis device can run as either an end station or a
monitor-only station:

•  An end station is known across the network, and can send and receive data.
In this mode, 622Vu Advisor lets you monitor traffic coming in on either of
the analysis device’s two channels;  you select the channel you want.

•  A monitor-only station examines network traffic passively, without being
recognized across the network.  In this mode, 622Vu Advisor automatically
monitors the traffic coming in both channels, and retransmits traffic over the
opposite channel from where it’s received.  (Incoming on Channel 1 goes out
over Channel 2;  incoming on Channel 2 goes out over Channel 1.)

Note: There’s no loss of signal strength if you elect to monitor traffic;  the analysis device
recovers the data stream, removes any jitter, then retransmits the signal.

The right-most LEDs on the 622Vu undercradle indicate the current operation
mode:

Figure 2.  LEDs Indicating Current Operation Mode

Use the Operation Mode tab to establish the settings you want.

Setting Up an End Station

With an end station analysis device, you can monitor traffic coming in on either
(one) of the analysis device’s two channels.  All outgoing traffic is transmitted
over that same (receive) channel.  When setting up an analysis device to run as an
end station, the configuration window includes a Channel selection and (as
appropriate to the interface type in use) a Clock Source area:

Power
Sys
OK Fault Active Port 1 Port 2

OC-12c/STM-4c
622 Mb/s SM Port 1 Port 2

In  Out In  Out 

Device is operating in end-station mode when
the top indicator is lit, and in monitor-only mode
when the bottom indicator is lit.
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Channel used
to monitor and
transmit
traffic.

Source of the device’s
transmission timing.

•  The Channel area identifies the channel over which you want to monitor
network traffic, and from which you want to transmit traffic from the device.
Each analysis device has two channels, and you can use either one (1 or 2).  

•  The Clock Source indicates where the analysis device should obtain its
transmission timing (pulse frequency), which is used to synchronize outgoing
transmissions.  Select the source you want:

Clock Source Use if the device…

Recovered RD Channel  Recovers the clocking signal from the receive-data (RD)
channel, thereby synchronizing transmissions with incoming
traffic.

Onboard Clock Uses the clock on the analysis device.

Possible End-Station Configurations

You can establish either of two configurations when running as an end station, as
detailed in Table 2.  In that table, the Configuration # (5 or 6) indicates the
number used internally by 622Vu Advisor to identify the particular configuration
setting.  This number shows up on the window used to monitor the ATM network
(described in Chapter 5).

Use this key to interpret the symbols used in the Traffic Flow diagrams:
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Table 2.  Possible Configurations for an End Station

Definition Traffic Flow Description

Configuration # 5: Incoming traffic on Channel 1 goes into the
framer chip on the analysis device and is
monitored by 622Vu Advisor (and
optionally captured).  The analysis device
transmits traffic over Channel 1.

Incoming traffic on Channel 2 loops out
over Channel 2 without being monitored.

Configuration # 6: Incoming traffic on Channel 1 loops out
over Channel 1 without being monitored.

Incoming traffic on Channel 2 goes into the
framer chip on the analysis device and is
monitored by 622Vu Advisor (and option-
ally captured).  The analysis device
transmits traffic over Channel 2.

Setting up a Monitor-Only Station

With a monitor-only mode analysis
device, 622Vu Advisor automatically
monitors the traffic coming in both
channels, and retransmits all traffic over
the opposite channel from where it’s
received.  When configuring a monitor-
only device, then, you need only specify
the Operation Mode (shown to the right
and described on page 61).    
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The traffic flow is always the same, and allows
you to connect with two physical ATM links:

•  Incoming traffic on Channel 1 is monitored by
622Vu Advisor (and optionally captured),
then goes out over Channel 2.

•  Incoming traffic on Channel 2 is monitored by
622Vu Advisor (and optionally captured),
then goes out over Channel 1.

Use the following key to interpret the symbols
used in the illustration:

The internal Configuration # is always 10 for monitor-mode devices, and is used
by 622Vu Advisor to identify this particular configuration.  The configuration
number shows up on the window used to monitor the ATM network (Chapter 5).
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4.2  Configuring an OC-12c/STM-4c
Device

Configuration of an OC-12c/STM-4c device involves setting options specific to
the physical interface.  The Options tab looks like this:

Indicate the type of framing the
card should recognize on input,
and use when sending traffic.

Mark the physical line
options you want.

Specify the options as follows:

Option Description

Framing Method used to synchronize cell transmissions:  SONET or its
European equivalent, SDH (Synchronous Digital Hierarchy).  Both
transmit at 622 Mb/s.  The SONET C2 overhead octet is hex 13 on
transmit, and the SDH C2 overhead octet is hex 13.  On the receive
side, the analysis device checks for hex 13.

For capture processing, make sure to use a setting that’s compatible
with the sending device (or the result will be no data).    

Enable Cell Scrambler Indication of whether to scramble the payload data at transmission, and
unscramble payload data when received.  Mark the check box to enable
this scramble/unscramble feature.

For capture processing, make sure to use a setting that’s compatible
with the sending device.  Most network devices enable scrambling.

Generate HEC Coset Indication of whether to enable the x6+x4+x2+1 polynomial to be
XORed with the calculated HEC.  Mark the check box to enable this
feature.

For capture processing, make sure to use a setting that’s compatible
with the sending device.

As necessary, refer to page 60 for instructions related to the Operations Mode
tab.
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Chapter 5

Monitoring the ATM
Network

622Vu Advisor’s Device Manager lets you monitor the physical interface
between any analysis device and the ATM device being tested, as analysis
proceeds.  This is useful after executing a script (see page 171), to track the
transmission online.  It’s also useful to get a general sense of how clean the
traffic and physical medium are.

This chapter describes how to monitor the physical interface.  The Device
Manager is also used to configure analysis devices, as described in Chapter 4.

Starting the Device Manager

Click the Manage Devices button on the toolbar to initiate the Device Manager.
622Vu Advisor builds a device list, then displays the Device Manager window.
Refer to page 55 for a description of this window and the information shown, and
for a description of each menu command available during processing.

Selecting An Analysis Device

To begin monitoring the physical interface between a particular analysis device
and the ATM device being tested, first select the analysis device you want in the
lefthand side of the window.  Then either click the Monitor Physical Interface
button (shown left) or choose the corresponding command from the Tools menu.

Overview of the Display

622Vu Advisor opens a window that’s specific to the physical interface
supported by the device.  The top of the window and overall format is illustrated
below :

Manage Devices

Monitor Physical
Interface
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The Physical and ATM tabs let
you monitor both channels at once.

Current configuration
for the analysis device.

Heartbeat
light.

Active channel
lights (correspond
to the channel
lights on the
device hardware).

Refresh rate (seconds). Click to reset statistics to zero (0).

•  The Physical tab (above) displays physical characteristics of data trans-
missions for both channels at once.  This is the same information as is shown
on the Channel tabs, but combines the two channels in one display.

•  The two Channel tabs let you monitor one channel at a time:
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Click on the tab for the channel you want to monitor (1 or 2).  The left side of
the display shows alarms and errors relating to the physical characteristics of
the data transmission (as observed by the device).  The right side shows
ATM statistics:  counts of various receiver/transmitter conditions, as well as
instances of a bad HEC.  These (ATM) statistics are the same across
interface types.

The ATM tab (shown on page 72) displays the ATM statistics for both
channels at once.  This is the same information as is shown on the Channel
tab, but combines the two channels in one display.  The ATM tab also graphs
the percent of available bandwidth used to transmit data (vs. idle cells),
separately by channel.  The bandwidth-usage statistics are sampled (and
reported) every five seconds.    

Regardless of the tab you’re viewing, the information at the top of the window
and bottom is the same, as described starting on page 69.

You can move freely among the tabs to monitor the physical interface.  The Set
Baseline button (bottom) resets the statistics and counters across all tabs, so your
information stays in sync.

Note:  Set Baseline applies only to your Device Manager’s view of the statistics, and does not reset
counters on the hardware device.  This means that if another user is accessing the same
board, that user’s statistics are unaffected.

When you’re through, click the Close button.  Then, from the Device Manager
window, choose Exit from the File menu.     

General Indicators:  Top

The LEDs tell you which channels are active and the device’s overall
configuration, and provides a heartbeat light:

•  Active channels are indicated by the LEDs in the top left.  The indicator
corresponding to each channel lights, as appropriate, to reflect:  1) a good
physical connection;  and 2) that the channel is being reported by the ATM
622Vu Advisor.

The indicators here correspond to the LEDs between the channel connectors
on the 622Vu undercradle hardware:
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Figure 3.  Channel Indicators for a 622Vu Advisor
One or both of the channels are highlighted, indicating the channel(s) configured
to receive (and capture) network traffic (see Chapter 4, Configuring Analysis
Devices):

⇒  For devices configured as an end station, only one channel is highlighted,
corresponding to the channel you selected when configuring the analysis
device.

⇒  For devices configured as monitor-only stations, both channels are
always highlighted.

•  The device’s configuration takes this form:

[config_id]  op_mode  (receive/xmit_channels)  capture capture_channel

It reflects the configuration established through the software (see Chapter 4),
and contains specific information as follows:

Item Description

config_id Always 10 for a monitor-only device;  5–8 for an end-station
device, indicating which of the possible configurations is set (see
Table 2 on page 63).

op_mode Operating mode set for the analysis device:

Mode Description

Full duplex on n End station listening on Channel n.

Pass-thru Passive (monitor-only).  All traffic comes in
one channel and goes out the other.  

receive/xmit_channels Traffic flow through the analysis device, formatted as two sets of
receive -> transmit specifications separated by a comma.  For
example:  R2->T2, R1->T1

Each side of the specification is described as either:

R (receive) or T (transmit), followed by the channel number (1
or 2).  This applies for traffic flowing through Channels 1
or 2.

Power
Sys
OK Fault Active Port 1 Port 2

OC-12c/STM-4c
622 Mb/s SM Port 1 Port 2

In  Out In  Out 

Channel 1 is active when the top indicator is lit.
Channel 2 is active when the bottom indicator is lit.

Channel 1 connector Channel 2 connector
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Item Description

RFrmr (receive framer) or TFrmr (transmit framer).  This applies
to traffic flowing through the on-device framer chip.

If the flow goes out over two channels, the right side of the
specification has two values: TFrmr->T2+T1.

capture_channel Channel on which 622Vu Advisor is listening to the device’s
traffic, specified using the same notation as above (e.g., “capture
R1”).  Always “R1 and R2” for dual-capture, monitor-only
devices.

In this example: [5]Full duplex on 1(R1->RFrmr, TFrmr->T1), capture R1,
we’re looking at a device that’s running as an end station listening on
Channel 1.  Traffic coming in on Channel 1 is going to the receive framer,
and traffic from the framer chip is going out through Channel 1.  622Vu
Advisor is capturing traffic off Channel 1.  Internally, this is known as
Configuration #5.

•  The heartbeat light (far right) flashes to indicate communication between the
analysis device and ATM device under test.

General Indicators:  Bottom

The bottom line lets you control the frequency with which information is updated
(Update Delay field), and has buttons used to:

•  Close the window.

•  Set Baseline counters to zero.  A reset initializes error counters as well as
ATM counters and graphs.

•  Request Help text describing the information shown.

The Update Delay controls how often 622Vu Advisor refreshes the information
displayed.  Specify this field as a number of seconds (in the range 1–3600), or
use the spin-control arrows to increase or decrease the value shown.  622Vu
Advisor will begin refreshing the information at the requested frequency.

Where to Go From Here

The next section describes the ATM tab, which is identical across all the physical
interfaces supported by the analysis devices.  Subsequent sections describe the
errors and counters shown for each specific physical interfaces and, as
appropriate, the BIP error-generation features available for that interface.    
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5.1  The ATM Tab
The ATM tab shows the following information for OC-12c/STM-4c physical-
interface type.

The indicators to the left count various receiver/transmitter conditions, as well as
instances of a bad HEC:

•  Receiver counters indicate how many times non-idle ATM cells occur.

•  Transmitter counter increments by 1 for each cell that’s actively sent out by
the device (applicable in end-station mode when the device is actively
transmitting cells over the channel it’s monitoring).

•  HEC Errors counters track these conditions related to HEC errors in
incoming traffic:   
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Counter Increments by 1 when:

Corrected A HEC error is corrected by the framer chip (which automatically
corrects single-bit errors).

Not Corrected A HEC error can’t be corrected by the framer.

Total Both of the above.

The graph to the right shows the percent of available bandwidth used to transmit
data (vs. idle cells), separately by channel.  The bandwidth-usage statistics are
sampled (and reported) in accordance with the frequency specified via the
Update Delay field (see page 71).
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5.2  Monitoring an OC-12c/STM-4c
Interface

This section describes the physical indicators for an analysis device configured to
support OC-12c/STM-4c.  You can obtain a different view of this same
information through the Channel tab, described on page 68.  The ATM tab is
described on page 72.

Physical Tab

The Physical tab looks like this for an OC-12c/STM-4c interface:   

Card number and interface type.

The sections below describe the alarms and errors specific to OC-12c/STM-4c.
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Alarms

The first two alarms indicate major problems, and should remain clear when
running with a good connection.  The other alarms may light during processing,
and indicate various physical events:

Alarm Lights when this event occurs:

Loss of Signal Total loss of signal;  most likely a cabling problem (lost connection,
damaged cable, etc.).

Signal Label
Mismatch

The analysis device can’t figure out the incoming signal;  specifically, the
received value in the C2 octet doesn’t equal hex 13 for seven consecutive
frames.  The most likely problem is a device that’s connected to an ATM
device through the wrong type of physical connection (e.g., an OC-
12c/STM-4c device cabled to an OC-3 device).

Loss Of Pointer Loss of Pointer error;  i.e., there’s no valid H1/H2 pointer in the
STS-12c/STM-4c frame.

Out Of Frame Out of Frame error;  i.e., the analysis device observes four consecutive in-
error A1/A2 framing patterns.  The pattern observed consists of the third
A1 octet and the first A2 octet.

Loss Of Frame Loss of Frame error;  i.e., the STS-OOF is active for 24 consecutive
STS-12c/STM-4c frames.

Loss Of Cell
Delineation

Loss of Cell Delineation error (indicating a loss of cell synchronization).
Lights when seven consecutive HEC errors occur at the current cell-
delineation position.

Summary BIP Error Bit-Interleaved Parity check error;  i.e., an error in the B1, B2, or B3 BIP-8
or BIP-24 codes at the receiver.

Line AIS Alarm Indication Signal on the line (signal is sent downstream to report an
error detected upstream).  Lights after the three least significant bits of the
K2 octet are ‘111’ for five consecutive frames.
(MS-AIS = equivalent SDH term)

Line RDI RDI (Remote Defect Indicator) error on the line (signal is sent upstream to
report a receive or transmission error downstream — generally a frame-
sync error or a loss of incoming signal).  Lights when the three least
significant bits of the K2 octet are ‘110’ for five consecutive frames.
(MS-RDI = equivalent SDH term)

Path AIS Alarm Indication Signal on the path;  i.e., the H1 and H2 octets are all ones
for three consecutive frames.
(AIS = equivalent SDH term)

Path RDI RDI (Remote Defect Indicator) error on the path, indicating a loss of cell
delineation.  Lights when the analysis device detects a value of 9 in the
most significant nibble of the G1 octet of the STS-12c/STM-4c overhead.
(RDI = equivalent SDH term)

Path FEBE Far End Block Error on the path, indicating that the block (frame) has a
checksum error.  Lights when there’s a non-zero FEBE value (1–8) in the
most significant nibble of the G1 octet of the STS-12c/STM-4c overhead.
(SDH REI = equivalent SDH term)
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Alarm Lights when this event occurs:

Line FEBE Far End Block Error on the line, indicating a valid non-zero FEBE value
(1–24) in the Z2 octet of the STS-12c/STM-4c overhead.
(MS-REI = equivalent SDH term)

Errors

The Errors counters indicate the number of occurrences of various events,
including alarms and other errors.  Each counter has a corresponding alarm LED
that lights when the event occurs (B1–B3 all show up in the Alarms panel as
Summary BIP errors).  

Counter Increments by 1 when this event occurs:

Line FEBE Far End Block Error on the line.  Increments if any valid non-zero FEBE
value (1–24) is detected in the Z2 octet of the STS-12c/STM-4c overhead.

Path FEBE Far End Block Error on the path (described above with the alarms).

BIP B1 Bit-Interleaved Parity check error on the Section component of the
STS-12c/STM-4c overhead.

BIP B2 Bit-Interleaved Parity check error on the Line component of the STS-12c/
STM-4c overhead.

BIP B3 Bit-Interleaved Parity check error on the Path component of the STS-12c/
STM-4c overhead.
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Chapter 6

Capturing Incoming Traffic

622Vu Advisor lets you capture and monitor the traffic coming in over one or
both channels of an analysis device.  You can save the captured cells, either to
review them later or to use them as a script (or as the basis for a script).   

This chapter describes the capture facility, including the use of filters during
capture processing.

Starting the Capture Facility

Click the toolbar’s Capture button to initiate capture processing (or choose
Capture from the Activities menu).  Then click the appropriate button to either
start a new capture, or to review the traffic from a previous capture:

•  Click the New  button to start a new capture.

•  Click the Open  button to open a file that contains ATM cells captured
previously.

The rest of this chapter contains information as follows:

•  Section 6.1  Starting a New Capture details the options available when you
start a new capture, and describes the initial display.

•  Section 6.2  Opening a Capture File (page 89) describes how to open an
existing capture file.

•  Section 6.3  Viewing Captured Traffic (page 90) tells how to view and
process captured traffic.  This discussion covers active (i.e., live) captures as
well as captures that have been stopped and/or saved previously.

Capture
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6.1  Starting a New Capture
After you request New Capture
processing, 622Vu Advisor displays
the 622Vu undercradle (right).  The
622Vu undercradle is identified by a
descriptive icon ( ), followed by
the name of the device and a number
(always 1).

 Select the device you want from the
list, then click Next.  

You’ll only see those devices that
are available for use currently.  If the device is already performing RAM-
intensive activity (such as a capture), it won’t appear in the list.  If you expect to
see a device that isn’t here, click the Refresh button to reevaluate its status.

After making your device selection,
622Vu Advisor prompts for any
filtering you want to use.  By
default, 622Vu Advisor captures all
non-idle cells coming in over both
channels.  The resulting capture files
can become very large, so 622Vu
Advisor lets you filter captures, to
limit their size.  The form shown to
the right lets you post-filter the
capture.  Note that this filter
operates on an existing capture, it
does not affect how cells are
captured.

You can filter captures based on VCC, IP address, decode, or incoming channel.
You can also use filters to control the way in which the traffic is captured (using
a single buffer that wraps, using multiple buffers that don’t wrap, etc.).  Refer to
Chapter 8 if you’re not familiar with filtering.

As the first step to filtering a capture, you must define (i.e., establish) the filtering
criteria to use.  There are three ways to do this:  through 622Vu Advisor’s
standard filterset processor (detailed in Chapter 8), while monitoring real-time
statistics (detailed in Chapter 7), or using the capture facility’s filterset wizard
(described in this chapter).  In the latter two cases (real-time stats and filterset
wizard), you have the option of saving the filter definition, or discarding it after a

New Capture

Selecting Filtering
Options
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single use.  The approaches offer slightly different filtering capabilities, as
follows:

Table 3.  Summary of Filtering Capabilities

Can be defined in:

Filtering Capability
Standard
FilterSets

Real-Time
Stats Filters

FilterSet
Wizard

Limit the size of the buffer used (and therefore the traffic
captured).

� — —

Wrap buffers, allowing you to reuse each buffer
continually until the capture is stopped (vs. filling each
buffer once).

� � —

Specify whether to include cells having a bad HEC. � — —

Specify whether to include idle cells, and define the
exact content of an idle cell.   

� — —

Specify whether to include idle cells (but not define the
content).   

— � —

Request only those PDUs or cells having a particular
VCC.

� � �

Request only those PDUs or cells having specific IP
addresses (source and/or destination).

— — �

Request only those PDUs or cells that use a certain type
of decode.

— — �

Request only those cells captured on a particular
channel.   

— — �

There are three filtering choices for a new capture, as described below.  622Vu
Advisor always remembers the last filterset used, and prefills the window
accordingly.

•  Mark Capture All to capture all non-idle cells to a single buffer.

•  Mark Capture Using Existing Filter to filter the capture using criteria that
are set up already.  If you choose this option, select the filterset that defines
the traffic you want to capture.  You can specify any filterset, regardless of
where it was first defined.  (Refer to Table 3 for a list of differences between
the three approaches to defining filtering criteria.)

•  Mark the last button (Use the FilterSet Wizard to Define a New Filter) if
you want to define a new filterset on the fly, for immediate use with the
current active capture.  As noted in Table 3, these filtersets are based on
some combination of VCC, IP address, decode, and/or channel.  They can be
saved or not, as appropriate to your needs.

Note: The Real-Time Statistics processor also lets you define a new filterset on the fly,
although the purpose (and therefore the definition) are somewhat different.
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Click Next when you’re through, to display a summary of capture specifications:

If you agree with the description shown, click Finish to run the capture;
otherwise, click Cancel to go back and change the capture specifications.

Proceed to the discussion appropriate to the filtering selection you made:

If you selected: Refer to:

Capture All Using the Capture All Option on page 80.

Capture Using Existing Filter Capturing Using an Existing Filter on page 82.

Use the FilterSet Wizard to
Define a New Filter

Using the FilterSet Wizard to Define a New Filter on page 84.

Note: Don’t change the active cell library while the capture is running.  If you change the active
library with the capture window open, make sure to close and restart capture processing to
ensure that it reads the current library correctly.

Using the Capture All Option

 After you start a new Capture
All capture, 622Vu Advisor
displays the captured traffic in a
Browser window.  As described
on page 113 (see Switching
Between a PDU and Cell-Level
Display), the display shows
either PDU- or cell-level traffic (cell-level illustrated below):

Verifying Your
Specifications
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List of captured
PDUs or cells
(cells shown here).

Amount of time the capture has been running.

Number of PDUs/cells captured so far.

Percent of captured cells

uploaded to the Advisor
already.

Click to stop
the capture.

Analysis device where
you’re capturing traffic.

Filtering option in effect (CaptureAll in this case).

Temporary name
assigned to the capture.

The Auto Update Display button controls which of two options 622Vu Advisor
uses for the display:

•  With Auto Update Display OFF, 622Vu Advisor stops updating the
window after displaying the initial screen load of cells/PDUs (but continues
with its capture).  Use the scroll bar to see the latest traffic captured in this
case;  622Vu Advisor updates the display automatically as you scroll
forward.

•  With Auto Update Display ON, 622Vu Advisor refreshes the display
continually, always showing the latest cells.  The scroll bar is disabled when
you use this feature.

Click the Auto Update Display button to toggle your selection.  622Vu Advisor
remembers the last auto-update setting when it opens a user profile, and
continues with that setting unless you specify otherwise.

In the status bar (bottom of window), the Elapsed field indicates the amount of
time the capture has been running.  The Captured field indicates the number of
PDUs/cells captured by the analysis device.  While these PDUs/cells are on the
device, they are not necessarily loaded yet to your Advisor;  the analysis device
typically captures traffic much faster than the traffic can be passed to the
Advisor.  The Uploaded field (and corresponding blue bar) indicates the
percentage of captured cells/PDUs that have been forwarded to the Advisor
already.  

Auto Update
Display
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Stopping the Capture

The toolbar’s Stop Capture button is activated during a new capture, allowing
you to terminate the capture at any time.  After you stop the capture:

1. The Elapsed field (in the status bar) changes to show the Start and Stop
date/time.

2. The status bar also displays the total number of cells or PDUs in the capture.

3. The Start button becomes active (turns green), allowing you to begin a new
capture using the same specifications (same device and filter).

As appropriate (i.e., if you save a large capture
then try to start a new capture or exit), the system
displays a message telling you how many captured
cells remain to be uploaded from the analysis
device to the Advisor (right), and asks whether
you want to finish uploading those cells.  If you
proceed with the upload, it can take several minutes to complete.  This is because
the analysis device captures traffic significantly faster (at full bandwidth) than
the Advisor can load the cells from the device to its memory.    

Note: After stopping a capture, you can’t continue it to append additional cells.  Instead, you can
click Start to begin a new capture using the same settings.

Capturing Using an Existing Filter

 When you request a new capture
that uses an existing filter, you
specify the filterset you want to
use (shown right).

 The capture display looks much
the same as for the Capture-All
option (see page 80), but includes
an additional area showing VCC
statistics:

Start (left) and Stop
Capture (right)
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List of PDUs or
cells captured
(cells shown here).

Filterset in use.

VCC statistics
(shown separately
by channel).

If the Buffers Wrap…

If you’re using a capture filter that wraps its buffers (described on page 140),
622Vu Advisor won’t display any cells until the capture is stopped, at which time
it displays the first traffic captured.

In this case, you’ll see the message wrapped instead of a PDU/cell count in the
Captured field.  Use the VCC-statistics area in this case to see the number of hits
in each VCC.

VCC Statistics

The VCC Statistics window provides statistics relating to the active filterset, and
applies only if you identified a filterset for use by the capture.  Each line corre-
sponds to a different combination of VCC and channel.  You can display the
VCC stats via the VCC Statistics command (View menu).  (See Chapter 8 for a
description of filtersets if you’re unfamiliar with the concept of buffers.)   

Table 4.  VCC Statistics

Column Description of Content

Name VCC over which cells have been captured, as defined within the filterset being used.

Ch Channel over which cells have been captured.

Cells Number of cells captured over this VCC and channel.
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Using the FilterSet Wizard to Define a New Filter

When you use the filterset wizard
to define a new filter, 622Vu
Advisor opens a Create Filter
window.  This window has five
tabs, each corresponding to a
specific component of the filter
definition.

Note: You can open this same (Create
Filter) window directly from the
Tools menu, by choosing the
Create Filter command.
Processing is the same as when
you open it from the new-capture
wizard, except that there’s no
verification of the capture
specifications.  When you close the Create Filter window in this case, simply choose the
Start command (Capture menu) to begin a new capture with the filterset you just defined.

Click each tab in turn, filling in the specifications you want:    

•  Use the VCC tab to limit the capture to a specific set of VCCs.

•  Use the IP tab to limit the capture to a specific set of IP addresses.

•  Use the Decode tab to limit the capture to specific types of decode.

•  Use the Other tab to restrict the capture to traffic coming in over Channel 1
or 2.

•  Use the Save tab to indicate whether to save the filter for future use.  If you
don’t save the filter, it will not be available after you stop the capture.

When you’re through, click OK.  622Vu Advisor stores the filterset under the
name you assign via the Save tab (see page 88).  Then it verifies your capture
specifications and continues with the capture.

If you save the filterset, it will be available whenever you start a new capture,
from the new-capture wizard.  (You can’t view or edit the detailed specifications
of the filterset, once defined;  however, there’s no limit to the number of different
new-capture filters you can define.)

The new filter has one buffer, called Traffic, that contains all the filtering
specifications.  Criteria are ANDed between tabs, but ORed within any particular
tab.  Thus, when 622Vu Advisor uses the new filter, it captures all traffic having
any of the VCC(s) specified, and any of the IP address(es) specified, and any of
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the decodes specified, limited to the traffic coming in over the channel(s)
specified.

When you’re through defining the filterset, 622Vu Advisor displays the new-
capture specifications for verification (including what filterset you’re using, as
described on page 80):

Then the new-capture session proceeds as described above under Capturing
Using an Existing Filter (page 82).

Using the VCC Tab During
FilterSet Definition

 Use the VCC tab (right) to limit the
capture to only those cells/PDUs having
a specific VCC(s).  By default (i.e., if
this tab is blank), the filterset logic
captures traffic for all VCCs.

•  Click Add to add a VCC to the list.
622Vu Advisor opens a dialog box
that lets you specify the components
of the VCC individually:
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You must specify the full VCC explicitly;  you cannot ignore any field
positions.  You can choose to use decimal or hexadecimal notation.  Mark the
box at the bottom for decimal;  leave it blank for hexadecimal.

 Click OK when you’re through, to add the VCC to the list.

•  To change a VCC, select the VCC in the list and click Edit.  622Vu Advisor
prompts for the changes using a dialog similar to the one described above for
an add.

•  As necessary, select a VCC and click Remove to delete it from the list.

When you’re through with the VCC tab, click OK to save your settings.

Using the IP Tab During
FilterSet Definition

 Use the IP tab to limit the capture
to only those cells/PDUs having a
specific IP address(es).  You can
specify source and/or destination
addresses, or combinations of
source/destination addresses.  By
default, the filterset logic captures
any (i.e., all) IP addresses.

•  Click Add to add an IP address
(or pair of IP addresses) to the
list.  622Vu Advisor opens a
dialog box that lets you specify
a source and/or destination
address, as well the direction of
traffic flow (bi-directional or
source-to-destination):

You must specify each address explicitly, but you can select "any" or "****"
from either list, to request a match to any IP address for that field (e.g., to
match a specific source address to any destination address, or any source
address to a specific destination address).  Click OK when you’re through to

Arrows indicate the direction of
flow: either bi-directional (shown
top) or source-to-destination
(bottom).
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add the address(es) to the IP list.  The arrows under the Flow column indicate
the selected direction of flow.

•  To change an address (or pair of addresses), first select the address(es) from
the list, then click Edit.  622Vu Advisor prompts for the changes using a
window similar to the one described above for an add.

•  As necessary, select an address (or pair of addresses), then click Remove to
delete it from the IP list.

When you’re through with the IP tab, click OK to save your settings.

Using the Decode Tab
During FilterSet Definition

 Use the Decode tab to limit the capture
to only those cells/PDUs that use a
certain type of decode.  By default,
622Vu Advisor captures all decodes.

1. Click Add to add a specific type of
decode to the list.  622Vu Advisor
opens a dialog box that lets you
enter a decode directly, or select one
from the drop-down list:

Click OK when you’re through, to add the decode to the list.

 If you specify a type of decode that isn’t in the drop-down list, 622Vu
Advisor accepts (and uses) it as entered.  622Vu Advisor does not try to
verify user-specified values.

2. Click All to add all the decodes available in the drop-down list.

3. As necessary, select a type of decode and click Remove to delete it from the
list.

When you’re through with the Decode tab, click OK to save your settings.
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Using the Other Tab

Use the Other tab to limit the capture to
only those cells/PDUs coming into the
analysis device on a particular channel.
Select Channel (Ch) 1 and/or Channel
(Ch) 2, then click OK to save the
settings.

Using the Save Tab

 Use the Save tab to specify whether or
not to save the filterset.  Mark Save File
to Library if you want to save the
filterset in the cell library;  leave it
blank to use the filterset for the active
capture (after which it’s deleted).

If you save the filterset, assign it a name
and enter any comments you want to
associate with it.

Note:  The filtering criteria specified here are different from those available through 622Vu
Advisor’s standard filterset editor (described in Chapter 8);  therefore, you can’t access a
new-capture filter through the editor.  It’s important, then, that you provide a clear
description of the filterset, as necessary to help you recall its purpose.
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6.2  Opening a Capture File
When you open an existing capture file, 622Vu Advisor uses the standard file-
open dialog box to prompt for the name of the (.cap) file you want to see.
Captures can be stored anywhere, but by default reside in 622Vu Advisor’s
\capture directory.  Open the file you want.

622Vu Advisor displays the captured traffic:

Date and time (hh:mm:ss) the
capture started and ended.

Number of PDUs or
cells in the capture.

Name of the capture file you’re looking at.

This is a
cell-level
display.

The capture display shows traffic at either the PDU or cell level, with one row for
each PDU or cell.  You can switch back and forth between a PDU- and cell-level
display, as necessary to best analyze the data captured.  (See page 113 for related
instructions.)

The Start and Stop times (displayed in the status bar at the bottom of the
window) indicate the date and time the capture was started and completed.  The
Count field (bottom right) displays the total number of cells or PDUs in the
capture.  A blue bar moves across the Count... field as the file loads, to indicate
the progress.

From this display, you can request a decode of the PDU information, and
manipulate the file as necessary to analyze it (for example, to locate specific cells
or PDUs).  You can also create subsets of cells based on specific criteria, save
subsets (typically under a different name), and/or generate scripts from the data
in the file.  The next section describes these features in more detail.        

Open
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6.3  Viewing Captured Traffic
This section describes the tools available for analyzing the captured data, first
presenting a description of the basic display and all menu commands:

•  Description of the Basic Display (page 90) describes the basic data displayed
in the Capture File Browser window.

•  Capture-Facility Menu Commands and Toolbar Buttons (page 92)
describes the menu options and toolbar buttons.

The remaining sections cover the menu commands that haven’t been described
yet, using a left-to-right, top-to-bottom approach:

•  Saving the Capture (page 97) describes how to save a capture (or subset of a
capture).

•  Displaying the PDU (page 97) describes how to decode the PDU-level
information for a specific PDU(s)/cell(s).

•  Exporting a Capture File (page 101) describes how to export the capture file
in any of three formats (decode, CSV, or NG Sniffer).

•  Using the Goto Feature (page 103) tells how to position the display at a
specific PDU/cell.

•  Finding Specific Cells or PDUs (page 103) tells how to locate a specific
PDU/cell using the Find facility.

•  Creating Subsets of PDUs/Cells (page 107) tells how to create a subset of
captured cells.  

•  Requesting More Detail For a PDU or Cell (page 112) tells how to toggle
display of more details about each PDU or cell displayed.

•  Switching Between a PDU and Cell-Level Display (page 113) tells how to
switch back and forth between a PDU- and cell-level display.

•  Creating a Script From a Capture File (page 113) tells how to create a
script from the capture file.

Some of these tools are available during an active capture, while others are only
available after the capture is stopped, or from a previously saved capture, noted
in Table 5 (page 93).

Description of the Basic Display

In the main Capture File Browser window, each row is numbered sequentially
starting with 1.  This lets you determine your position in the file.
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Depending on whether you’re in PDU Summary Mode (see page 113), each row
displays either cell- or PDU-level information (and the title of the window is Cell
Browser or PDU Browser, respectively).  The traffic displays in order according
to the time that it was captured, with the following information for each PDU or
cell:   

Column

Cell Display PDU Display Description

No. No. Sequential number assigned to each row (i.e., to each cell
or PDU).  The icon to the left of this number indicates the
type of data shown:
Icon Indicates the Row Contains...

PDU-level information.

Individual cells.

Traffic that has bad HEC data.

Ch Ch Channel where the traffic was (or is being) captured.

Arrival Time Arrival Time Arrival Time:  Time associated with the cell or PDU.
Initially traffic displays in order according to the time that
it was captured, and this field is labeled as the Arrival
Time (hh:mm:ss.nnnnnnnnn, shown to a resolution of 33
ns).  You can change this to display a delta time between
cells/PDUs, or to establish a particular cell/PDU as a
baseline from which all other (relative) times are
measured.  Refer to Table 5 (page 93) for the specifics of
these options.

Header VCC Cell header data (for a cell-level display), or PDU-level
VCC information (for a PDU-level display).  Shown in
decimal or hexadecimal format to correspond to the default
header format specified in the user profile (General tab).

Payload PDU Summary Payload data, in hexadecimal format (for a cell-level
display), or PDU summary-level information (for a PDU-
level display).  For a PDU-level display, this area provides
a high-level overview of the protocol layering in the PDU.
As appropriate, you’ll see protocol-specific information in
the PDU summary line, such as the LAN protocol (IP,
IPX, etc.) source and destination addresses.
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Controlling the Color Used

622Vu Advisor uses color to highlight the
captured traffic.  You can control the colors
used through your profile definition.
Choose the User Profile command from the
Options menu to change the color(s) in the
display.  622Vu Advisor opens the dialog
shown to the right.   

Click to the Color tab, then select the color
you want for each category of display:

Display Color used for...

[Ch 1] Cell Default Basic display for cells captured on Channel 1.

[Ch 2] Cell Default Basic display for cells captured on Channel 2.

Bad HEC Cells that have a bad HEC.

PDU All the cells in a particular PDU.

To select a color, first click the double-right arrow, then use the standard
Windows Color dialog box to choose the color you want.

Capture-Facility Menu Commands and Toolbar
Buttons

Table 5 describes each command and toolbar button available for use during
capture processing.  Some of these tools are available during an active capture,
while others are only available after you stop a capture, or when you open a
(previously saved) capture file.
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Table 5.  Capture-Facility Menu Commands and Toolbar Buttons     

Available from:

Menu Command
Toolbar

Equivalent
Active

Capture
Stopped
Capture

Saved
Capture Used to…

See
Page

File
New � � � Initiate new-capture processing. 78

Open � � � Open an existing capture file. 89

Close — � � � Close the active capture file (available when a
capture file is open).

—

Save � � � Save the capture file you’re viewing,
modifying it to include only the currently
displayed cells, as appropriate (generally a
subset of the initial display).

97

Save As — � � � Save the capture (or currently displayed
subset) under a new name.

97

Export — — � � Export the contents of the entire capture (or
subset if you've created one).  There are three
choices of format:  decoded text, CSV, or
Network General Sniffer.

Note:  You can create decoded text for a single
PDU by double-clicking it in the basic
display.

101

Print — � � Print the current window on your default
printer:  either the entire capture file or the
current PDU.  (The PDU prints if PDU decode
is displayed and has focus.)

—

Print Preview — — � � Display a preview of what would print via the
Print command.  Applicable when the Print
command would print the entire capture (i.e.,
when the PDU is not displayed and/or does not
have focus).  622Vu Advisor opens a window
that lets you scroll through the document,
zoom in and out, and print, as necessary:

—

6:  Capturing Incoming Traffic
6.3  Viewing Captured Traffic

93



Available from:

Menu Command
Toolbar

Equivalent
Active

Capture
Stopped
Capture

Saved
Capture Used to…

See
Page

Print Setup — � � � Open your standard print-setup dialog box. —

Exit � � � Close the Capture utility. —

Edit
GoTo — � � � Position the display at a specific cell or PDU

in the capture, identified by number.
103

Find — � � Locate a particular cell or PDU based on a
search string value, and/or specific VCC
settings.  

103

Find Prev(ious) — — � � Position the cursor at the cell or payload
located by the previous Find.

103

Find Next — — � � Repeat the last Find. 103

Create Subset — — — � Create a subset of captured cells or PDUs,
based on a search string value and/or specific
VCC settings.

107

Undo Last Subset — — — � Reverse the last Create Subset operation to
display the previous subset (or the initial
display, if this is the first subset).

108

Set Baseline — � � � Display Arrival Time relative to the time when
the currently selected cell was captured:

Negative values
indicate cells captured
before the baseline cell.

Baseline (selected) cell.

—

Clear Baseline — � � � Clear the baseline established last via Set
Baseline.

—
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Available from:

Menu Command
Toolbar

Equivalent
Active

Capture
Stopped
Capture

Saved
Capture Used to…

See
Page

View
Detail Display � � � Toggle display of a more detailed view of the

cell or PDU data.
112

PDU Summary
Mode

� � � Toggle an option that summarizes all the cells
for a PDU on one line.  The line comprises a
terse description of the protocol layering for
the PDU.

97

Auto Update
Mode

� � — Toggle an option that applies during an active
capture, and that refreshes the display once per
second, to always show the latest cells.  With
this toggled ON there’s no scroll bar, but the
most recently captured cells always display.
With this option OFF, you can use the scroll
bar to see the latest captured data.

81

Alternate Time
Format

— � � � Toggle display of the Arrival Time to delineate
decimal positions within the seconds field with
spaces, or to reverse this delineation:

—

Use this command to
separate milliseconds,
microseconds, and
nanoseconds (or to
remove the separation).

Cell Delta Time — � � � Toggle display of the Arrival Time to show the
time elapsed since the previous cell was
captured (option is ON), or a time relative to
when the capture was started (option is OFF):

Choose this
command to
show the time
elapsed
between each
cell.

—

VCC Statistics — � — — Display VCC statistics during an active
capture (applies only when using a filterset for
the active capture).  If the VCC statistics are
already opened, this command changes the
focus to the statistics window.

83

Toolbar — � � � Toggle display of the toolbar. —

Status Bar — � � � Toggle display of the status bar (bottom of
window).

—

PDU Raw Data — � � � Toggle display of the PDU’s payload, in both
hex and ASCII format (applicable only when
PDU decode is displayed and has focus).

98
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Available from:

Menu Command
Toolbar

Equivalent
Active

Capture
Stopped
Capture

Saved
Capture Used to…

See
Page

PDU Cell List — � � � Toggle display of a list of cells in the PDU
displayed (applicable only when PDU decode
is displayed and has focus).

99

Options
Font — � � � Open a dialog box through which you can

control the font used to display the active view
window:  either the standard Capture File
Browser window or a decoded PDU window.

—

Default Font — � � � Redisplay the currently active view window
using the default font.

—

User Profile — � � � Specify preferences to use when decoding
captured cells, and the colors to use when
displaying the capture.

92 &
100

Capture
Start — � — Begin a new capture using the same

specifications as the capture you’re viewing;
applicable after stopping an active capture.
(You can’t continue a stopped capture to
append additional cells.  Instead, click Start to
begin a new capture using the same settings.)

82

Stop � — — Terminate an active capture (applicable when
a capture is running).  After you stop the
capture, the Start button becomes active (turns
green), allowing you to begin a new capture
using the same specifications (same device and
filter).

82

Tools
Create Script — — � Create a script from a capture file that’s been

saved previously.  You can use and maintain
the script like any other script, using 622Vu
Advisor’s scripting facility.

113

Create Filter — — � — Define a filterset on the fly, for immediate use
during new-capture processing.  The filterset is
based on VCC, IP address, decode, and/or
channel, and its definition is the same as
described for new-capture processing.

84

Describe Capture
Device

� � — Display information about the analysis device
used for the active capture (or the most recent
capture, if no capture is running currently):
device identification, network information,
hardware specifications, and available
memory.

—

Window
Cascade — � � � Cascade all open windows. —

Tile Horizontally — � � � Arrange all open windows horizontally, so you
can see them together.

—
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Available from:

Menu Command
Toolbar

Equivalent
Active

Capture
Stopped
Capture

Saved
Capture Used to…

See
Page

Tile Vertically — � � � Arrange all open windows vertically, so you
can see them together.

—

Arrange Icons — � � � Align icons for all minimized windows across
the bottom of your monitor display.

—

Help — � � � Display online Help and/or general
information about the Capture utility.

—

Saving the Capture

At any time, you can save the capture as it’s displayed currently, using the Save
or Save As commands from the File menu:  Save to resave the current file under
the same name;  Save As to save the file under a different name.  In the latter
case, 622Vu Advisor opens a standard dialog box that you’ll use to assign a name
to the capture file (name.cap format).  If you omit the suffix, 622Vu Advisor
assigns it correctly.  Captures can be stored anywhere, but typically reside in
622Vu Advisor’s \capture directory.

If you click Exit or New (capture) before saving
the previous capture, 622Vu Advisor asks
whether you want to save the capture before
proceeding (illustrated to the right for an Exit
before saving).  

Displaying the PDU

After you stop an active capture, or when you open a capture file that was saved
previously, 622Vu Advisor lets you decode the captured traffic at the PDU level.
(You can’t decode PDU-level information during a live capture.)  Double-click a
cell or PDU to decode that PDU.  622Vu Advisor opens a Decode window that
displays Protocol Data Unit (PDU) information for the currently selected
PDU/cell.  The title bar identifies the PDU you’re looking at:    
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Decoded Protocol
Data Unit (scroll to
see the entire
PDU).

The current PDU
(or all cells in the
current PDU) are
highlighted.

•  If you’re looking at a PDU-level display, 622Vu Advisor highlights the
currently selected PDU.

•  If you’re looking at a cell-level display, 622Vu Advisor highlights all cells in
the same packet as the cell that’s currently selected.

Scroll through the decode window to see the full PDU display.  622Vu Advisor
decodes as much of the PDU as it can, and displays this information in a logical
form.  The specifics of this vary depending on the type of data encapsulated in
the PDU (shown above for an AAL5 PDU).

You can identify preferences for use in decoding captured ATM traffic through
your profile definition;  specifically, you can specify any VCCs that should
always be interpreted using a particular decode.  See Specifying Decode
Preferences starting on page 100 for more information.  

Two View menu commands let you toggle display of additional PDU detail:

•  Choose PDU Raw Data to toggle display of a hex and ASCII translation of
the payload:
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Binary translation of
the payload (hex left
and ASCII right).

•  Choose PDU Cell List to toggle display of a list of cells in the PDU:

Cell list toggled on
(in addition to the
binary data (right)).

You can open any number of decode windows.  As you click different lines in the
main display, the PDU window shows information corresponding to that line —
even as you jump to different PDUs in the main display.  The most recently
opened window is reserved for tracking purposes, however;  622Vu Advisor
always displays the decode for the currently selected cell/PDU using this
window.

If you want to compare decodes, open two or more decode windows.  Any
windows except the most recent are static, and track only the specific PDU for
which they were initiated.  The Window menu lists each separate decode
window, so you can move easily from one to another.  You can also use the tiling
feature, to arrange multiple decodes so you can compare them.
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It’s sometimes easier to decode the entire file at once, rather than one PDU at a
time.  Use the Export (to decode) command from the File menu to do this (page
101).      

Specifying Decode Preferences

622Vu Advisor lets you specify preferences
for use in decoding captured ATM cells.
Choose the User Profile command from the
Options menu to do this.  622Vu Advisor
opens the window shown to the right.   

Click the Decode tab, then proceed as
follows:

•  Use the Decode Overrides area to
identify any VCCs that should always
be decoded a particular way (for
example, as using AAL1 ATM
Adaptation layering, or PNNI or UNI
signaling).  This feature forces all cells having a particular VCC to be
decoded using the specified protocol.  Click Add, Edit, or Delete, as
appropriate to the processing you want (respectively, to add a new VCC, edit
an existing specification, or delete the selected VCC).

For add/edit processing, 622Vu Advisor opens this dialog box:

Specify the VCC you want using the top three boxes, then use the drop-down
list to select the type of decode you want to associate with that VCC.  (When
you specify the VCC, use either hexadecimal or decimal format to
correspond to the Header Format specified in the profile definition’s General
tab, described on page 51.)  Click OK when you’re through to save the
change.

As installed, the system supplies a set of standard VCCs that are commonly
decoded a particular way.  If you want to restore these default VCCs, click
the Default button.
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•  Use the UNI Version field to specify which UNI decode to use (defaults to
3.1).

•  Use the MIB File field to identify a MIB (Management Information Base)
for use when decoding SNMP or ILMI PDUs.  (See page 97 for information
about decoding PDUs.)  If you identify a valid MIB filename here, 622Vu
Advisor uses the values in that file to convert MIB Object Identifiers (OIDs)
to their textual representation;  otherwise (without a MIB) 622Vu Advisor
only shows OIDs in their numerical form.   

You can specify any valid MIB text (.txt) file here.  As necessary, use the
Browse button to scan your file system for the MIB you want.  If you inad-
vertently identify a non-MIB text file (or a MIB file that isn’t recognizable to
622Vu Advisor’s parser), the system returns a file parsing error during PDU
processing, then continues processing without the file.

Exporting a Capture File

The Export command from the File menu lets you export the entire capture file
in any of three formats:

•  Decoded Text — Decodes all PDUs at once, writing the results of the decode
to a flat text file.  The resulting text file can be quite large.  If the capture file
is 1MB, expect a decoded text file in the range 8–12 MB.

•  CSV Format — Exports the entire capture file in CSV format (readable by
Excel).

•  Network General Sniffer Format — Exports the entire capture file in NG
Sniffer format (.enc).

When you choose this command, 622Vu Advisor opens a standard Save As
dialog box.  Identify the new file to which you want to export the capture (format
varies by type), then click OK to proceed.  

622Vu Advisor displays its progress as it creates the file, then issues a message
telling you that it’s through.  (You can hide the progress dialog box by clicking
the Hide button, or stop the process altogether by clicking Abort.)

Saving a File for Expert Analysis

The ATM 622 application can save a data file for import into the Agilent Advisor
LAN. This gives you expert analysis capability for your LAN traffic being
carried over an ATM 622 link. You will be able to analyze your ATM 622 traffic
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and then when the ATM is proven to be reliable evaluate the same traffic with
the Advisor LAN to find existing LAN problems.    

To use the Advisor LAN on your ATM 622 traffic you will need to do the
following steps:

1. Connect the ATM 622 undercradle to the network under test and capture
desired LAN traffic using any VCC filters desired.  Filters can be used to
limit the amount of traffic to only the desired traffic, if no filters are used
then all LAN traffic running over AAL-5 is analyzed.

2. Save the captured traffic to a data file on the hard drive.  This file can later be
opened by the ATM 622 application and additional post process filters
applied to reduce the amount of traffic if desired.

3. Start the Advisor LAN found under the Start menu.  Use the Start | Agilent
Advisor | ATM Analysis | Off-Line LAN-ATM Expert  path. This will open
the program with a default set of parameters.  You can now import the ATM
622 file into this application.  Select [File] then [Open (Load Data)].  You
will now see a list of all of the *.dat files that have been saved by the Advisor
LAN.  As a part of the open window you should see an input box labeled
“Files of type”.  You will need to click on the pull-down arrow and select the
file type identified as “*.cap”.  This will now apply a file filter to only show
you the ATM 622 files and most likely the file list window will be blank.
You will need to use the directory navigator icon in the open box to move up
until the “Look in” box has the “Advisor” directory listed. Now select
“622Vu” then “Capture” and now you should see the ATM 622 files that
have been stored.
Note: If you change the default directory for the file save you will need to
change to that directory to do the import.

4. Once you have a list of the ATM 622 files you can select one file to open.
Click one time and wait for the import function to validate the file be verify
that you can open this file.  You will see a “Created by:” box that lists the
application used to create the file if it can be imported along with a yellow
indicator.  This yellow indicator lets you know that you have selected a file
that will need to be converted to the Advisor LAN format.  Click on the
“Open” button to start the import function. NOTE: if the ATM file does not
have LAN traffic carried over AAL-5 the import will fail and you will see a
missing file notification.

5. Once you have imported the file you will be able to use the Advisor LAN
decode engine to decode the LAN traffic in detail.  You can also let the
“Expert Analyzer” look through the traffic by switching to the Expert screen.
From the “Run” pull-down select “Run From Buffer” to start the expert and
select the range of frames to evaluate.  You will then be able to watch the
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screen update as the traffic is analyzed and reported on the screen.  When the
run has completed you will be able to view the results and Commentator
notes that resulted.  For more details on the Advisor LAN capabilities please
review the Advisor LAN documentation the was shipped with and on your
Advisor.

6. You can review the ATM 622 traffic and quickly identify network problems.
If you need to you can change back to the ATM 622 application and refine
your capture and save to a new data file or capture new traffic to review as
required until your network problems are solved.

Using the Goto Feature

The Goto command from the Edit menu lets you locate a
particular PDU or cell (as appropriate to the level of
information currently displayed), and make that PDU/cell
active.  Identify the cell/PDU by number (shown here for a
cell), then click OK.

Finding Specific Cells or PDUs

The Find button (or command from the Edit menu) lets you locate a cell or PDU
based on: a specific (ASCII or hex) value in the payload, the channel where the
cell was captured, specific settings in the VCC, source or destination IP
addresses, and/or the type of decode used.  

When you request a Find, 622Vu Advisor opens a window through which you
can qualify the PDU/cell you want.  This window has three tabs:

•  Use the General Find Criteria tab for general specifications.

•  Use the IP tab to locate specific source or destination IP addresses.

•  Use the Decode tab to locate a specific type of decode.

When you’re through, click OK to confirm your settings and find the first
PDU/cell matching your specifications.

Multiple criteria are ANDed between tabs:  622Vu Advisor finds the first PDU or
cell that matches all the General Find Criteria and that has one of the IP
address(es) specified, and that has any of the decodes specified.

After you execute a Find, you can use the Find Prev(ious) (<Shift-F3>) or Find
Next (<F3>) commands, respectively, to position the cursor at the previously
found cell/PDU, or to repeat the Find moving forward through the capture.

Find

Repeating a Find
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Using the General Find Criteria Tab

The General Find Criteria tab lets you describe the basic search criteria:

Search string (value to
locate in the payload).

Mark to enter/display header
values using decimal (vs.
hexadecimal) format.

Type of value represented by the
search string (ASCII or hex).

Indicate whether you’re searching for
a PDU or cell, and whether to restrict
the search to those PDUs having a
good or bad CRC (if Target = PDUs),
or those cells having a good or bad
HEC (if Target = Cells).

Use to search for a specific
value in the header.

Use to restrict the search to traffic
captured on a particular channel.

 Follow these steps to fill in these criteria:

1. If you want to search for a value in the payload area:

Specify the search string in the Find What box.

Use the As drop-down list to indicate whether you’re looking for ASCII text
or a hex value.

2. If you want to search for a value in the cell header, use the VCC area to
specify the value you want.  Header values can be entered/displayed in
decimal or hexadecimal format.  Mark the Decimal Notation box if you
prefer decimal;  otherwise leave it blank.

 If you specify both the Find What and VCC areas, the system looks for the
search string within the payload of only those cells where the header fields
match your VCC values.

3. Use the Search drop-down list to indicate whether to search all PDUs or
cells; or to limit your search to only those PDUs having a good or bad CRC,
or only those cells having a good or bad HEC.  Any of the PDU/CRC values
request a search by PDU.  The cell/HEC values request a cell-by-cell search
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of the capture file.  622Vu Advisor only displays those options that are
appropriate to the level of detail shown in the main display (PDU or cell).   

4. In the Source area, indicate whether to search traffic captured on Channel 1,
Channel 2, or both.

5. Mark Search Backwards to begin searching for the specified value at the
end of the capture file;  otherwise (with this box unmarked) the system starts
at the beginning of the file.

6. If you’re searching for an ASCII value, indicate whether to Match Case or
not.  Leave this box blank for a non-case-sensitive search.

7. If you want to treat the Find What and/or VCC values as a bit-match pattern,
mark the Use Search String as Bit-AND Mask box.  With this box marked,
622Vu Advisor interprets the Find What and/or VCC values as a bit-match
pattern, returning the first cells/PDU that match any of the ON bits in the
mask.  For example, if you specify a hex 03 (binary 0000 0011) in the search
string, fixed at offset 15, the Find looks for the first cell whose payload has
either of the low-order two bits set.

8. Optionally, mark the Select Cells/PDUs NOT Matching Search Criteria
box to toggle between selecting values that match or don’t match the other
specifications.  With this box marked, the select/reject decision that’s made
by taking all the other criteria into account is reversed at the very end of the
decision-making process;  any cells or PDUs that would normally be rejected
are accepted, and any cells/PDUs that would normally be accepted are
rejected.

9. The Search at Fixed Offset field applies if you’re searching for a string in
the payload.  It allows you to specify an offset from the beginning of the
payload where you want to begin the search.  Valid offsets are in the range
1–48 for a cell-by-cell search;  1–65,535 for a PDU search.  If you leave this
field blank, 622Vu Advisor searches the entire payload.

10. The Search Index Range field lets you limit the search to a particular range
of cells or PDUs, identified by the number displayed to the left of each
cell/PDU in the capture-file display.  Specify a starting (i.e., low) and/or an
ending (i.e., high) number to identify the range you want to search.  These
default, respectively, to the first and last cells in the capture file.

11. The Search Time Range field lets you limit the search to cells/PDUs
captured during a specific time period.  Specify the from (left) and to (right)
times using an hour:minute:second format, with an optional 9 decimal
positions to the right of the seconds field:  hh:mm:ss.nnnnnnnnn
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 Use the Clear and Reset buttons at the bottom of the form to set all values to
their default settings, or to redisplay the last saved set of values, respectively.
(The OK button saves values.)

Using the IP Tab During Find Processing

 Use the IP tab (illustrated on page 86) to limit the search to only those
PDUs/cells having specific IP addresses.  You can specify source and/or
destination addresses, or combinations of source/destination addresses.  By
default, 622Vu Advisor searches any (i.e., all) IP addresses.

•  Click Add to add an IP address (or
pair of IP addresses) to the list.
622Vu Advisor opens a dialog box
(right) that lets you specify a source
and/or destination address, as well
the direction of traffic flow (bi-
directional or source-to-destination).

You must specify each address explicitly, but you can select "any" or "****"
from either list, to request a match to any IP address for that field (e.g., to
match a specific source address to any destination address, or any source
address to a specific destination address).  Click OK when you’re through to
add the address(es) to the IP list.  The arrows under the Flow column indicate
the selected direction of flow.

•  To change an address (or pair of addresses), first select the address(es) from
the list, then click Edit.  622Vu Advisor prompts for the changes using a
window similar to the one described above for an add.

•  As necessary, select an address (or pair of addresses), then click Remove to
delete it from the IP list.

When you’re through with the IP tab, click OK to save your settings.

Using the Decode Tab During Find Processing

 Use the Decode tab (illustrated on page 87) to limit the search to those
PDUs/cells that use a certain type of decode.  By default, 622Vu Advisor
searches all decodes.

1. Click Add to add a specific type of
decode to the list, then use the dialog
box (right) to enter a decode directly, or
to select one from the drop-down list.
Click OK when you’re through, to add
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the decode to the list.

 If you specify a type of decode that isn’t in the drop-down list, 622Vu
Advisor accepts (and uses) it as entered.  622Vu Advisor does not try to
verify user-specified values.

2. Click All to add all the decodes available in the drop-down list.

3. As necessary, select a type of decode and click Remove to delete it from the
list.

When you’re through with the Decode tab, click OK to save your settings.

Creating Subsets of PDUs/Cells

622Vu Advisor lets you create any combination of subsets — including nested
subsets — from a capture file (assuming the capture is finished).  Subset
processing is similar to Find processing (page 103), except here we’re locating
all cells or PDUs that match certain specifications, then creating a subset from
them.     

When you request a subset (Create Subset from the Edit menu), 622Vu Advisor
opens a window through which you can qualify the subset you want.  This
window has three tabs:

•  Use the General Subset Criteria tab to define general subset specifications.

•  Use the IP tab to identify specific IP addresses to include in the subset.

•  Use the Decode tab to identify specific types of decodes you want to include.

When you’re through, click OK to execute the subsetting logic based on your
specifications.  Multiple criteria are ANDed between tabs:  the subset will
include each PDU/cell that matches all the General Subset Criteria and that has
one of the IP address(es) specified, and that has any of the decodes specified.

 After you create the subset, the title above the main PDU/cell list changes
accordingly, and indicates the current subset level:  1 the first time you create a
subset, 2 when you created the first nested subset, and so forth.  You can save the
subset, as necessary, assigning it a new capture filename (Save As command).
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The PDU/cell Count field changes
to reflect only the traffic in the
subset.

Note: If you create a subset of cells (vs. PDUs), 622Vu
Advisor can’t guarantee the integrity of the
containing PDUs, because one or more cells may
be missing.  The system warns that you won’t be
able to decode the PDU-level information (right).
Click OK to proceed.

You can nest subsets by creating increasingly restrictive criteria, basing each
subset on the results of the prior subset.  622Vu Advisor keeps track of the entire
hierarchy of subsets, and lets you undo subsetting to any level.  Choose Undo
Last Subset from the Edit menu (or press <Ctrl-Z>) to revert to the next-higher-
level subset.  From a level-2 subset you can revert to a level-1 subset, for
example, and from there to the original capture.

Nesting Subsets
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Using the General Subset Criteria Tab

The General Subset Criteria tab lets you describe the basic subset criteria:

Search string (use to create a subset of
PDUs/cells having this payload value).

Mark to enter/display header values
using decimal (vs. hexadecimal)
format.

Type of value represented by the
search string (ASCII or hex).

Use to create a subset that contains either
isolated cells or the full PDU, for each cell that
matches your specifications.

Use to create a subset of
PDUs/cells having a specific
value in the header.

Use to restrict the subset to traffic
captured on a particular channel.

Also to restrict the subset to those PDUs having a
good or bad CRC (if Target = PDUs), or those
cells having a good or bad HEC (if Target = Cells).

 Follow these steps to fill in the General Subset Criteria tab:

1. If you want to create a subset based on a value in the payload area:

Specify the value you want in the Find What box.

Use the As drop-down list to indicate whether you’re looking for ASCII text
or a hex value.

2. If you want to create a subset based on a value in the cell header, use the
VCC area to specify the value you want.  Header values can be
entered/displayed in decimal or hexadecimal format.  Mark the Decimal
Notation box if you prefer decimal;  otherwise leave it blank.

If you specify both the Find What and VCC areas, the system creates a subset
of cells/PDUs that have the search string within the payload of only those
cells where the header fields match your VCC values.

3. Use the Search drop-down list to indicate whether to create a subset of all
PDUs or cells; or to consider only those PDUs having a good or bad CRC, or
only those cells having a good or bad HEC.  Any of the PDU/CRC values
request a search by PDU.  The cell/HEC values request a cell-by-cell search
of the capture file.  622Vu Advisor only displays those options that are
appropriate to the level of detail shown in the main display (PDU or cell).     
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4. In the Source area, indicate whether to consider traffic captured on Channel
1, Channel 2, or both.

5. Mark Search Backwards to begin searching for cells/PDUs to include in the
subset at the end of the capture file;  otherwise (with this box unmarked) the
system starts at the beginning of the file.

6. If you’re searching for an ASCII value, indicate whether to Match Case or
not.  Leave this box blank for a non-case-sensitive search.

7. If you want to treat the Find What and/or VCC values as a bit-match pattern,
mark the Use Search String as Bit-AND Mask box.  With this box marked,
622Vu Advisor interprets the Find What and/or VCC values as a bit-match
pattern, returning all cells/PDUs that match any of the ON bits in the mask.
For example, if you specify a hex 03 (binary 0000 0011) in the search string,
fixed at offset 15, 622Vu Advisor looks for traffic whose payload has either
of the low-order two bits set.

8. Optionally, mark the Select Cells/PDUs NOT Matching Search Criteria
box to toggle between selecting values that match or don’t match the other
specifications.  With this box marked, the select/reject decision that’s made
by taking all the other criteria into account is reversed at the very end of the
decision-making process;  any cells or PDUs that would normally be rejected
from the subset are accepted, and any cells/PDUs that would normally be
accepted are rejected.

9. The Search at Fixed Offset field applies if you’re searching for a string in
the payload.  It allows you to specify an offset from the beginning of the
payload where you want to begin the search.  Valid offsets are in the range
1–48 for a cell-by-cell search;  1–65,535 for a PDU search.  If you leave this
field blank, 622Vu Advisor searches the entire payload.

10. The Search Index Range field lets you limit the search to a particular range
of cells or PDUs, identified by the number displayed to the left of each
cell/PDU in the capture-file display.  Specify a starting (i.e., low) and/or an
ending (i.e., high) number to identify the range you want to search.  These
default, respectively, to the first and last cells in the capture file.

11. The Search Time Range field lets you limit the search to cells/PDUs
captured during a specific time period.  Specify the from (left) and to (right)
times using an hour:minute:second format, with an optional 9 decimal
positions to the right of the seconds field:  hh:mm:ss.nnnnnnnnn

Use the Clear and Reset buttons at the bottom of the form to set all values to
their default settings, or to redisplay the last saved set of values, respectively.
(The OK button saves values.)
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Using the IP Tab During Subset Processing

 Use the IP tab (illustrated on page 86) tab to include only those cells/PDUs
having specific IP addresses.  You can specify source and/or destination
addresses, or combinations of source/destination addresses.  By default, the
subset includes any (i.e., all) IP addresses.

1. Click Add to add an IP address (or pair of IP addresses) to the list.  622Vu
Advisor opens a dialog box that lets you specify a source and/or destination
address, as well as the direction of traffic flow (bi-directional or source-to-
destination).

You must specify each address explicitly, but you can select "any" or "****"
from either list, to request a match to any IP address for that field (e.g., to
match a specific source address to any destination address, or any source
address to a specific destination address).  Click OK when you’re through to
add the address(es) to the IP list.  The arrows under the Flow column indicate
the selected direction of flow.

2. To change an address (or pair of addresses), first select the address(es) from
the list, then click Edit.  622Vu Advisor prompts for the changes using a
window similar to the one described above for an add.

3. As necessary, select an address (or pair of addresses), then click Remove to
delete it from the IP list.

When you’re through with the IP tab, click OK to save your settings.

Using the Decode Tab During Subset Processing

 Use the Decode tab (illustrated on page 87) to include only those cells/PDUs that
use a certain type of decode.  By default, the subset includes all decodes.

1. Click Add to add a specific type of decode to the list.  622Vu Advisor opens
a dialog box that lets you enter a decode directly, or select one from the drop-
down list.  Click OK when you’re through, to add the decode to the list.

 If you specify a type of decode that isn’t in the drop-down list, 622Vu
Advisor accepts (and uses) it as entered.  622Vu Advisor does not try to
verify user-specified values.

2. Click All to add all the decodes available in the drop-down list.

3. As necessary, select a type of decode and click Remove to delete it from the
list.

When you’re through with the Decode tab, click OK to save your settings.
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Requesting More Detail For a PDU or Cell

You can toggle display of a more detailed view using the Detail Display button.
When you toggle the detail on, a panel opens above the cell/PDU list that
contains detailed information about the cell or PDU that’s selected currently:

•  For a PDU-level display, the detailed information includes a brief PDU
summary (left) and full PDU summary (right):

Detail for the selected
PDU:  brief PDU
summary (left) and full
summary (right).

•  For a cell-level display, the detailed information includes a decode of the
cell’s header (left) and the ASCII translation of the cell's payload (right).
The payload translation includes 16 bytes/line, with hex values to the left and
an ASCII translation to the far right (off the display in this example).

Detail for the selected
cell:  header
information (left) and
payload data (right).

Detail Display
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Switching Between a PDU and Cell-Level Display

The PDU Summary Mode button lets you toggle between a display of
individual cells, and one that condenses each PDU to a single line.  Click the
PDU Summary Mode button as many times as you want, to toggle between a
display of PDU-level information and individual cells.

The title of the browser window changes to reflect the current setting (PDU
Browser vs. Cell Browser).  The window on page 89 shows a cell-level display.
A PDU-level display looks like this:

This is a
PDU-level
display.

As appropriate with the PDU-level display, you’ll see protocol-specific
information in the PDU summary line, such as the LAN protocol (IP, IPX, etc.)
source and destination address.  You can specify preferences for use in decoding
PDUs, through your user profile definition;  specifically, you can indicate
particular VCCs that should be decoded in a certain way.  See Specifying Decode
Preferences starting on page 100 for more information.     

When you exit from 622Vu Advisor, the system remembers the current PDU
summary-mode setting.  It stores the setting in the user profile, then initiates the
next capture display using the same setting.    

Creating a Script From a Capture File

You can create a script from any previously stored capture file, or from a subset
of any previously stored capture file.  In either case, 622Vu Advisor combines a
series of sequences to form the script, preserving the timing and delays from the
original cell transmission.   

Note: If you want to edit any of the cells or the script itself, use 622Vu Advisor’s script editor to
view the script (including a list of sequences defined within the script), then use the
sequence editor to make any cell- or sequence-level modifications.  Refer to page 177 for

PDU Summary
Mode
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information about browsing and editing a script, and to Chapter 9 for details about sequence
processing.

Click the Create Script button to build a script from a capture file.  622Vu
Advisor opens a dialog box used to define the details of the script:

Range of PDUs/cells to
include in the script.

Mark to retain the VCC of each
cell included in the script;  leave
blank to mark the VCC properties
as undefined (so cells inherit
these properties from the
containing script).

Click to convert the requested
cells to a new script.

Indicate whether to
include cells captured
on Channel 1 or 2.

Specify values that must
match in order for cells to
be selected for inclusion
in the script (defaults to
any values).

1-20 character name
for the new script.

Create Script
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Follow these steps to create the script:

1. Fill in the script name (1–20 characters).

2. Specify the range of PDUs or cells to include in the script.  The Start and
End values you specify correspond to the numbers in the left-most column of
the main display (labeled No.).

3. Mark the Preserve Cell Headers check box to retain the VPI/VCI for all
captured cells.  Leave it blank to mark the VPI/VCI properties as undefined,
causing the cells to inherit these properties from the containing script (see
Chapter 10).  

4. Optionally, use the Header area to limit the cells included in the script to
those that match particular values in the GFC/VPI, VPI, and/or VCI header
fields.  (You might have performed this reduction in cells already, by
creating a subset of the cells/PDUs you want.)  622Vu Advisor uses the
values you enter as a filter, and only includes those cells that match the hex
bits specified.  An X instructs 622Vu Advisor to include cells having any
value in the corresponding bit positions.  By default, 622Vu Advisor ignores
these fields (as indicated by Xs in the initial display), so accepts any value.  

Mark the Decimal Notation box to display and specify header values in
decimal format.  Leave it blank if you’re using hexadecimal instead.

The settings to the right request only those cells having a
VCI value of ending in hex ‘10’.

5. Use the Channel area to indicate whether to include cells
captured on Channel 1 or 2.

6. Click OK when you're through, to save the
indicated range of cells as a script.  622Vu
Advisor displays a progress bar at the
bottom on the window as it creates the
script, then issues a message telling you that
the script is completed.  (You can Hide the
progress dialog box by clicking the Hide
button, or stop the process altogether by clicking Abort.)
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Chapter 7

Monitoring Real-Time
Statistics

Any time you’re not actively capturing traffic, 622Vu Advisor lets you monitor
the traffic over the link attached to a particular analysis device.  It displays
statistics related to the traffic (in order as the traffic is received by the device),
breaking down the information by VCC.

622Vu Advisor tracks all traffic on the attached link on a real-time basis.  At
your request, 622Vu Advisor displays the active network connections on the link,
providing statistics in a tabular fashion so you can track bandwidth use (and error
counts) easily.  It also offers a graphing capability, so you can lay out the
statistics in graphical form.

 Click the toolbar’s Real-Time Statistics button to initiate real-time statistics
processing (or choose Real-Time Statistics from the Activities menu).

 622Vu Advisor displays the 622Vu
undercradle.  Select that device.

You’ll only see the 622Vu undercradle
that is currently available for use.  If a
specific device is already performing
RAM-intensive activity (such as a
capture), it won’t appear in the list.  If
you expect to see a device that isn’t here,
click the Refresh button to reevaluate its
status.

If you want to write a copy of the statistics to an external (.csv-format) file, mark
the Log Data To File box.  This opens a standard file-open dialog box that you’ll
use to navigate to the log file you want.

Click OK when you’re through.

622Vu Advisor opens a display of statistics for traffic on the link attached to the
selected analysis device:

In the real-time statistics display, each line corresponds to a different VCC, with
a total by channel.  In the status bar (bottom of window), the Start and Elapsed

Real-Time Statistics

Overview of the
Display
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times indicate the date and time the statistics were started, and the amount of
time the statistics have been accumulating.  The VCC field indicates the number
of different VCCs for which statistics are displayed.

Statistics display,
with one row per
VCC.

Device where you’re monitoring real-time stats.

initially.  (Use View > IP Connectivity to display.)

The IP connectivity
applies for TCP/IP
traffic, and may or
may not display

The statistics run until you click Stop  , at which point all statistics
 stop incrementing and any graphing functions cease.  After you stop the statistics,
the Start button becomes active (turns green), allowing you to restart a new set
of statistics for the same analysis device.  (You can’t append to the previous set
of statistics with a restart.)

 You can control the statistics displayed (including whether you see Mbps or
Cells/sec data), through use of the Columns command.  If you notice a problem
with a particular VCC, you can begin capturing traffic over that VCC, first
defining a filter that’s specific to the data you want.

As desired, you can graph the Mbps (or Cells/sec) statistic for one or more
VCCs.

If you’re tracking a channel that’s carrying TCP/IP traffic, you can monitor the
source and destination addresses for that traffic.  Use the IP Connectivity
command from the View menu to do this.  (The real-time statistics display may
start up with the IP Connectivity window opened already, in which case this isn’t
necessary.)
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The rest of this chapter describes these features further, and is broken down as
follows:

•  Section 7.1  Real-Time Statistics For Each VCC (page 120) describes each
available statistic, and the use of the Columns feature to control the
information displayed.

•  Section 7.2  Menu Commands & Toolbar Buttons (page 121) describes the
menu options and toolbar buttons.

•  Section 7.3  Graphing Real-Time Statistics (page 124) tells how to graph
statistics for one or more VCCs,

•  Section 7.4  Creating A FilterSet That Captures Specific VCCs (page 127)
tells how to create a filterset based on specific VCCs that show up in the
display, and optionally how to initiate a capture using that filterset.
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7.1  Real-Time Statistics For Each VCC
The following real-time statistics are available.  You can display any or all of
these statistics, as necessary.  See Requesting Statistics via the Columns (page
84) for related instructions.

Table 6.  Available Real-Time Statistics

Column Description of Content

VCC Number to identify a particular VCC.  Each time 622Vu Advisor detects a new
connection on a channel (1 or 2), it displays the corresponding VP/VC
identifiers and begins tracking statistics for that connection.

Ch Channel on which the VCC was detected.

Cells Number of cells encountered that match the VCC.

Cells/sec Number of cells that are currently being transported per second over the VCC.
You can select either this field or the Mbps field using the Columns command,
but not both.

You can graph this statistic, using the Real-Time Graph facility described on
page 124.

Mbps Number of Megabits per second used currently to transport cells over the
VCC.  You can graph this statistic using the Real-Time Graph facility (page
124).

Current Percent of the total bandwidth used currently to transport cells for this VCC.

Average Same as Current, but specifies the average (vs. current) line utilization for the
duration of the session.

Peak Same as Current, but specifies the maximum line utilization at any point during
the session so far (to transport cells for this VCC).

Encapsulation Type of IP encapsulation available on the connection (blank if the analysis
device has not been able to identify the type of encapsulation):

IP over AAL5, according to RFC 1577

LC encapsulation according to RFC 1483

LANE encapsulation

If you click on a row that shows encapsulation, 622Vu Advisor opens a
window showing the source and destination address(es) for the connection.
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Controlling Which Statistics (i.e., Columns) Display

You can control which real-time statistics display,
by choosing the Columns command from the
Options menu.  Mark each statistic you want to
see, then click OK.  Use the top-most area (Units)
to indicate whether you want to view the Mbps or
Cells/sec data.  (You can only view one or the
other at any point in time.)

If you want to save the currently selected set of statistics as the default, mark the
Save as Default box.  622Vu Advisor will display the same information in all
subsequent real-time statistics displays until you change it, and will reset the
same set of statistics when you click the Default button (below).

The Default button sets all statistics to the last default settings (defaults to all
statistics ON including Mbps at installation).

Note: Instead of using the Columns command to open this dialog box, you can click the right
mouse button from the main statistics display.

7.2  Menu Commands & Toolbar Buttons
Table 7 describes each command and toolbar button available for use during real-
time statistics processing.

Table 7.  Real-Time Statistics Menu Commands and Toolbar Buttons

Menu
Command

Toolbar
Equivalent Used to…

See
Page

File
New Initiate the collection of real-time statistics on a

particular device.
—

Print Print the current window on your default printer. —

Print Preview — Display a preview of what would print via the Print
command.  622Vu Advisor opens a window that lets
you scroll through the document, zoom in and out, and
print, as necessary.

Print Setup — Open your standard print-setup dialog box. —

7:  Monitoring Real-Time Statistics
7.2  Menu Commands & Toolbar Buttons

121



Menu
Command

Toolbar
Equivalent Used to…

See
Page

Exit Close the Real-Time Statistics application. —

View
IP
Connectivity

— Display the IP Connectivity window, used when there is
TCP/IP traffic on a particular VCC to track the source
and destination addresses for that traffic.

118

Real-Time
Graph

Initiate graphing of either the Mbps or Cells/sec statistic
on one or more VCCs.  Specifically, this command
opens a dialog box through which you can define the
properties of the graph you want.

124

Toolbar — Toggle display of the toolbar. —

Status Bar — Toggle display of the status bar (bottom of window). —

Options
Font

—
Not used. —

Default Font — Not used. —

Columns — Open a dialog box used to control the statistics
displayed.  This command is an alternative to clicking
the right mouse button from the main statistics display.

121

Graph Settings — Change the properties of a graph.  This command is an
alternative to clicking the right mouse button from a
graph window.

125

Logging — Open a log file, then begin writing the statistics to that
(.csv-format) file.  Same as clicking Log Data To File
in the initial window (page 117).

—

Statistics
Start Reinitialize all real-time statistics and restart the

monitoring process using the current set of
specifications;  applicable after stopping the statistics.
(You can’t continue a stopped set of statistics to append
additional information.)  This command does not restart
any graphs that were running previously;  you must
redefine and restart those graphs individually.  To
restart the graphs, choose Graph Settings (from the
Options menu) from each graph window.

118

Stop Terminate the actively running statistics and any active
graphs.  After you press Stop, the Start button becomes
active (turns green), allowing you to restart the
statistics.

118

Tools
Create Filter — Define a capture filterset on the fly, and optionally

initiate a capture using the filter.  The filterset is based
on VCC values.  This feature is useful if you see one or
more "problem" VCCs while monitoring real-time
statistics, and want to capture the traffic on those VCCs.

127
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Menu
Command

Toolbar
Equivalent Used to…

See
Page

Describe
Device

Display information about the analysis device where
you’re collecting real-time statistics (applicable only
when statistics are running):  device identification,
network information, hardware specifications, and
available memory.

—

Window
Cascade — Cascade all open windows. —

Tile
Horizontally

— Arrange all open windows horizontally, so you can see
them together.

—

Tile Vertically — Arrange all open windows vertically, so you can see
them together.

—

Arrange Icons — Align icons for all minimized windows across the
bottom of your monitor display.

—

Help — Display online Help and/or general information about
the ATM Capture utility, which includes real-time
statistics.

—
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7.3  Graphing Real-Time Statistics
622Vu Advisor lets you graph the Mbps and/or Cells/sec field while monitoring
real-time statistics.  You can open any number of graphs.  For each graph, you
can choose one statistic or the other, and you can select the format you want (line
or bar graph).

 Click the Real-Time Graph button to start a new graph.  622Vu Advisor uses
these two panels to prompt for the new graph properties:

From this display:

•  Use the VCCs tab to specify which VCC(s) you want to graph.  You can
select one or more VCCs;  622Vu Advisor graphs each one separately.  Hold
down the <CTRL> key to select multiple VCCs.  Do not click OK until you’ve
also assigned the Options you want.

•  Use the Options tab to indicate what Graph Type you want, choosing either
a histogram (line) or bar graph format.  Next identify the Units you want to
chart:  either Mbps or Cells/second.  Finally, indicate the Refresh Rate:  the
rate at which 622Vu Advisor updates the graph.  Select the rate you want
from the drop-down list.

Note: Do not click OK until you’ve also assigned the VCCs you want.

 Press OK when you’re through to open the new graph:

Real-Time Graph
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 In this window:

•  The X-axis tracks the time elapsed, marked at five-minute intervals.  When
you reach the limit of the time displayed, 622Vu Advisor shifts the graph to
allow for additional data to the right.  (Be careful if you stop real-time
statistics then start them again, and restart a graph whose X-axis has shifted.
You won’t actually see the new data until the statistics have run for the
earliest elapsed-time indicated along that axis.  To show the data from the
beginning, close the graph window before restarting the graph.)

•  The Y-axis tracks the data (either Mbps or Cells/second) by VCC, and shows
values consistent with the physical interface supported by the analysis device
(OC-12c/STM-4c).  Each VCC uses a different symbol, so you can
distinguish between them easily.  (Refer to the bottom of the graph for a key
of symbols used to identify each VCC.)

 As necessary, you can click the right mouse button to change the properties of
the graph, or choose Graph Settings from the Options menu.  This opens the
same window described above, allowing you to change the VCC(s) and graphing
options.  Each time you change the specifics, 622Vu Advisor restarts the graph.
Here’s the same information shown in bar-graph format:
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 622Vu Advisor continues to update the graph until you Stop the session (or close
the graphing window). If you restart the real-time statistics, make sure to start the
graph again if desired.
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7.4  Creating A FilterSet That Captures
Specific VCCs

While you’re monitoring real-time statistics, you may notice one or more VCCs
that require closer analysis.  In this case, you can define a filterset from the real-
time statistics window that includes only those VCCs, then initiate a new capture
using the filterset.  (Alternatively, you can save the filterset for later use.)

Choose Create Filter from the Tools menu to
define the new filter.  Then:

•  Specify a name for the filterset in the Name
field.

•  Mark Capture Idle Cells to capture idle cells
(in addition to those for the VCC(s)
specified).  This is useful, for example to
determine how much of the bandwidth is used
for idle-cell traffic.  If you mark this box,
622Vu Advisor defines a buffer in the filterset
that’s dedicated to storing idle cells.

By default, a cell is considered idle if it has
zeros in every bit position of the first five
header fields.  If you want to capture idle cells but change the definition of an
idle cell, first save the filterset by clicking OK, then edit it using 622Vu
Advisor’s standard filterset editor, detailed in Chapter 8.

•  Mark Wrap All Buffers if you want to wrap each buffer when it’s full,
reusing each buffer continually until the capture is stopped.  See page 140 for
more information about wrapping buffers.

•  In the VCC area, select each VCC you want to capture when you use the
new filterset.

Click OK when you’re through.  622Vu Advisor
asks if you want to launch the new capture
immediately (which will automatically stop any
active real-time statistics processing).  Click Yes to
start a new capture using the filterset you just
defined;  No to not start the capture and to save the filterset for future use.
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Saving the Filter

622Vu Advisor automatically saves each filter you define, assigning it the name
you specified above.  It defines a buffer for cells having a bad HEC, a buffer for
idle cells (as appropriate to your specifications), and a buffer (called Traffic) to
store the selected VCCs.  It allocates the available buffer space automatically as
follows:  10% for the BadHec buffer (if specified), and the rest split evenly
between the idle-cell and traffic buffers.

You can examine the filterset using 622Vu Advisor’s standard filterset editor
(detailed in Chapter 8), and you can use the filterset editor to change the standard
features of the definition.  For example, to control the capture of idle cells, or
cells having a bad HEC;  or to override the automatic buffer sizing available
here.  If you view the sample filterset shown above through the normal filter
processing window, this is how it would look:

The circled components correspond to the specifications entered explicitly during
the original filter definition.  Cells having a bad HEC are always captured, by
default (as indicated by the first check box in the Options panel).
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Using the Saved Filter

The filtersets you create from the
Real-Time Statistics window are
available whenever you start a
new capture (or real-time stats
session), from this window of the
wizard (right):
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Chapter 8

Filtering Captures

When you capture incoming traffic, the capture files get large very quickly if you
keep every cell.  Because of this, 622Vu Advisor lets you set up filters that
identify the characteristics of the cells you want to keep.  When you initiate a
capture (see page 77), 622Vu Advisor lets you specify a filter to use to control
the content of the capture file.  The filter you specify operates in real time during
the capture, at full bandwidth and at the hardware level.1

You can define filtersets from three places:  using 622Vu Advisor’s standard
filterset processing (described in this chapter), during capture processing
(described in Chapter 6), or while monitoring real-time statistics (described in
Chapter 7).

8.1  Understanding Filters
Filters are defined in terms of filtersets.  Each capture
can use, at most, one and only one filterset.  The image
to the right shows six filtersets.  At the highest level,
each filterset is defined as either capturing everything
(i.e., all traffic), or as using filter entries.  The specifics of the filterset definition
vary depending on the type of filterset (everything or use filter entries).  

Each filterset divides the memory available for capturing cells into receive areas
(called filter buffers), and specifies what type(s) of cells should go into each
area:  

•  For filtersets that are defined as capturing everything, there’s only one buffer,
called CaptureAll.

                                                     

1 This contrasts with the subset facility described in Chapter 6, which lets you reduce the cells
in a capture after the full capture has taken place.  The filtering capability provides a more
efficient way to limit the content of the capture, for those situations where you’ll never need
the cells being eliminated.
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•  For filtersets defined as using filter entries, there’s always a buffer called
BadHec, which stores cells detected as having a bad HEC;  and there can be
up to three additional buffers.   

In our example, the filterset All Cells has one buffer, and
Catch VCI 12 and Cells with CLP clear have two buffers
each:

•  The CaptureAll buffer stores all cells for the first
filterset (All Cells).

•  The BadHec buffers store cells having a bad HEC
for each of the other two filtersets.

•  The other two buffers store cells defined as having specific values
(respectively, in the VCI and CLP fields).

For any buffers you define, there is one or
more filter entry within that buffer.  Filter
entries tell 622Vu Advisor exactly what types
of cells you’re looking for.  There’s one filter
entry for each different type of cell you want to
capture in the buffer.  In the example to the
right, the two buffers designed to store cells
having a specific value have one filter entry
each.

The standard BadHec and CaptureAll buffers don't allow filter entries, although
you can change their buffer-level settings (to restrict the size of the buffer, for
example, or to control whether the buffer wraps when it's full).

During capture processing, 622Vu Advisor checks each incoming cell against the
filter entries, looking at those entries in order as they’re defined within the
filterset.  It keeps each cell that matches the criteria specified by any filter entry,
storing that cell in the buffer corresponding to the first filter entry it matches.
622Vu Advisor discards cells that don’t match the criteria for any of the buffers.
This is illustrated here for a filterset having three buffers:  
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Buffer 1 Buffer 2 Buffer 3
No Match

ATM traffic feeding 
into the 622Vu undercradle

FilterSet Used for the Capture

622Vu's Capture Mechanism

ATM cells coming 
through the connection

If a cell matches the criteria for a particular filter entry but the corresponding
buffer is full (and doesn’t wrap), then that cell is dropped;  it won’t fall through
to another buffer, even if it matches a filter entry in that buffer.

Note: The assignment of buffers through filtering has no effect on the capture display.  All the
cells stored in the various buffers are combined and sorted (by arrival time) before being
displayed.
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8.2  Looking at Filter Definitions
Click the Capture Filters button on the toolbar to display a list of filtersets
defined in the active cell library (or choose Capture Filters from the Activities
menu).  Initially, the lefthand side of this window only shows the filtersets (no
buffers or filter entries).  Click on any filterset to display its definition:    

Definition of the currently selected
entity (filterset in this example).

Percent of the total capture-
buffer capacity assigned already
for use by the filterset’s buffers.

Current (selected) filterset.

Click once to display
the corresponding
definition to the right.
Double-click to
explode one level of
detail.

You can explode any filterset to see its buffer definitions, then any buffer to see
its filter entries.  Double-click on a line to explode its detail.

Use the window above to define and modify your filtersets, using the pulldown
menus to direct your processing (see Table 8 on page 136).  As an alternative,
use the toolbars to choose the processing you want.  The toolbars include buttons
for the most commonly used commands.   

The menu options available to you vary as you click on the different levels of
definitions down the lefthand side of the window, as do the available toolbar
buttons across the top.  In Table 8, the Level Used At column indicates which
options are available for filtersets (FS), filter buffers (Buf), and filter entries
(Ent).

Follow the instructions in the rest of this chapter to define and modify filtersets.
Use the right side of the window to enter and change specific information.  The
information displayed to the right varies, depending on whether you are

Capture Filters
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positioned on a filterset, filter buffer, or filter entry in the left-hand panel.  Use
the pulldown menus or toolbars to direct your processing.  When you’re through,
choose the Exit command from the File menu.

The rest of this chapter is broken down as follows:

•  Section 8.3  Defining FilterSets describes how to add, define, and delete
filtersets at the highest level.

•  Section 8.4  Defining Filter Buffers (page 143) describes how to add,
define, and delete filter buffers, and how to adjust the sequence in which the
buffers are examined during capture processing.

•  Section 8.5  Defining Filter Entries (page 147) describes how to add, define,
and remove specific capture criteria (i.e., filter entries) for a buffer.

•  Section 8.6  Advanced Filtering Mode (page 149) describes the advanced
filtering feature, which lets you define a filterset-level mask that’s combined
with all other selection criteria when choosing the cells to include.  This lets
you specify a particular characteristic that you want across all captured cells,
for example, or header fields you want to ignore completely.    
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Table 8.  FilterSet Pulldown Menus — Summary of Functions Available

Menu
Command

Toolbar
Equivalent

Level Used At:
 FS    Buf    Ent Used to…

See
Page

File
New FilterSet � � � Define a new filterset. 137

Remove FilterSet � � � Delete the selected filterset,
including all its component
buffers and filter entries.

138

Clone FilterSet — � � � Copy the currently selected
filterset under a new name.

138

Save FilterSet — Not currently available. —

New Buffer � � � Define a new buffer in the
filterset.

144

Remove Buffer � � Delete the selected buffer. 144

Clone Buffer — � � Copy the selected buffer under a
new name.

144

Move Buffer Up � Move the selected buffer up one
position (within the same
filterset).

146

Move Buffer Down � Move the selected buffer down
one position (within the same
filterset).

146

New Filter Entry � � Define a new filter entry in the
selected buffer.

147

Remove Filter Entry � Delete the selected filter entry. 147

Clone Filter Entry — � Copy the selected filter entry
under a new name.

147

Exit — � � � Exit from filter processing. 135

Options
Show Header Values
in Decimal Format

— � � � Request decimal (vs.
hexadecimal) format for all
header values.  With this option
selected, you'll enter and view
header fields in decimal format.
With this option unselected,
you'll enter and view header data
in hex format.

141,
143, &

148

Help — Obtain Windows Help on
filtering.

—

* FS = option available for filtersets.
Buf = option available for buffers.
Ent = option available for filter entries.
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8.3  Defining FilterSets
Use the FilterSet commands from the File menu to add a new filterset (either
from scratch or by cloning a filterset that exists already then changing it), to
remove a filterset, or to modify a filterset’s definition.   

Adding a New FilterSet

To add a new filterset, click the toolbar’s Add FilterSet button (or choose New
FilterSet from the File menu).  The system prompts for the name of the new
filterset, and asks whether the filterset should be configured to capture all traffic
coming into the analysis device or only selected traffic (based on filter entry
definitions):

Click to capture all traffic
coming in on the analysis device.

Click to capture only
those cells indicated by
specific filter entries.

Fill in the name and select the appropriate radio button:

•  If you select Everything, the filterset comprises only one buffer, by
definition called CaptureAll.  You can control the size and wrapping of this
buffer, and whether it captures idle cells or not.

This is the recommended way to capture all incoming traffic, if you’re using
a single wrapped buffer.

•  If you select Use Filters, the system sets up one buffer (BadHec) to store any
cells having a bad HEC.  You can establish up to three other buffers, each
with its own definition of content.  You can define how much memory to use
for each buffer, and whether to wrap buffer space.  You can also indicate
whether or not to capture idle cells.

When you’re through, click OK.  This adds a new (blank) definition.  Proceed to
Modifying a FilterSet Definition (page 139) for instructions to define the filterset,
then to Section 8.4  Defining Filter Buffers (page 143) for instructions to set up
the buffers for the filterset.

Add
FilterSet
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Cloning a FilterSet

Instead of adding a new filterset from scratch, you can copy an existing filterset
then modify it.  To do this, first select anywhere in the filterset you want to copy,
then choose Clone FilterSet from the File menu.  The system prompts for a
filterset name for the copy, using a window similar to the one shown above for
Add processing.  Fill in the name you want, then click OK.  622Vu Advisor
makes a complete copy of the filterset, including all buffers and filter entries
(with their original names and definitions).  Then it stores the copy under the new
filterset name, placing it directly under the copied filterset.

You can change the definition as necessary, referring to the appropriate sections
of this chapter.

Removing a FilterSet

If you find you no longer need a particular filterset, you can remove it from the
cell library.  To do this, first select any component of the filterset definition, then
click the Remove FilterSet button (or choose Remove FilterSet from the File
menu).

The system verifies that you really want to remove the entire filterset, then
deletes it from the library — including all component buffers and filter entries.

Note: Regardless of the level of definition selected when you request the delete, 622Vu Advisor
removes the entire filterset, not just the selected component (e.g., buffer or filter entry).

Remove
FilterSet
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Modifying a FilterSet Definition

The filterset definition window looks like this:

These values are
predefined based on
the initial add-filterset
settings.

100%

The filterset name and type were defined when you first added the definition, and
can’t be changed.  Follow the directions below to specify the description, the
options you want to use, and the idle-cell definition.

FilterSet Description

Specify the description as any text you want;  typically something that explains
the overall purpose of the filterset.  The descriptive text is only used in this
window.

FilterSet Options

Click the Options panel to make it active.  Use the two check boxes at the top
lefthand side, as appropriate, to indicate whether you want to capture cells having
a bad HEC and/or idle cells.

•  Cells having a bad HEC always go in the BadHec buffer, unless the filterset
is set up to capture everything.  (For everything-type filtersets they go into
the standard CaptureAll buffer, along with all other traffic.)

•  Idle cells go into a buffer that you set up explicitly, through filter entry
definitions, to store idle cells.  They’re dropped if there’s no such buffer.
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Again, an exception occurs if the filterset is set up to capture everything, in
which case idle cells go into the standard CaptureAll buffer.

Click to specify a filterset mask;  filtering
specifications that are combined with each
filter entry to form composite criteria.

Click to wrap the memory
allocated to each individual buffer
when it’s full, thereby overwriting
previously captured cells.

Click to capture bad HEC cells
(always selected for filtersets
that capture everything).

Click to capture
idle cells.

Mark the Advanced Filtering Mode box if you want to extend the basic filtering
capabilities of the system.  (This feature isn’t applicable for everything-type
filtersets;  i.e., CaptureAll buffers.)  By default (without using advanced
filtering), 622Vu Advisor lets you select cells based on bit settings in the first
three header fields (GFC, VPI, and VCI).  Collectively, these fields comprise the
cell’s address (path).  With advanced filtering in effect, you can also select based
on the remaining header fields (PTI, CLP, and HEC) as well as the first byte of
the cell’s payload.     

If you mark this box, refer to Section 8.6  Advanced Filtering Mode (page 149)
for the specifics of using a filtering mask.

Note: The advanced filtering feature is very powerful, and can lead to unexpected results unless
you’re careful.  For most users the standard filter-entry criteria provide all the power
necessary.  

The Wrap Buffers When Full option applies for all buffers defined for the
filterset, and indicates whether to:

•  Reuse each buffer continually until the capture is stopped, essentially
creating a circular buffer (box is marked).

•  Fill up each buffer once, then stop collecting the corresponding cells (box not
marked).  Cells that would otherwise be stored in the buffer are discarded;
they don’t fall through to any other buffers that match their content.  When
all buffers are full, the capture stops automatically.

If you wrap buffers, 622Vu Advisor writes over cells that have already been
stored on the analysis device after the buffer is full.  This is useful, for example,
if you’re tracking a particular problem(s) and aren’t interested in saving the
traffic until the problem occurs.  In this situation, you can stop the capture
immediately after the problem presents itself on the ATM device being tested,
and the traffic passing through the analysis device at the time of the problem will
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be in the active buffer (assuming the buffer is sufficiently large to accommodate
any delay in human response time in stopping the capture).

Idle Cell Definition

Use the Idle Cell panel to define which cells should be considered idle, based on
values in the first four bytes of the header.  (Idle cells are either captured or
skipped, depending on the Capture Idle Cells setting on the Options panel.)   

You can use 622Vu Advisor’s default
definition of an idle cell, as shown to
the right (all zeros in the header);  or
you can identify the characteristics of
an idle cell explicitly.  In the latter
case, 622Vu Advisor lets you specify
any combination of specific bit values
you want.  The combination of these values will be recognized by the filtering
mechanism (during capture processing) as an idle cell:

Notice the two parts of the idle-cell definition:  the mask and the match settings.
Both can be specified as either hexadecimal or decimal values that translate into
specific bit-level settings for the first four bytes of the cell header.  (Use either
hexadecimal or decimal format to correspond to the current Options menu
setting for Show Header Values in Decimal Format.)

•  The Idle Cell Mask indicates those bits you want to look at when searching
for idle cells.  By default, 622Vu Advisor looks at all the header bits, so each
masking field contains a hexadecimal F (i.e., all 1s).  The hexadecimal fields
above translate to a bit string that looks like this:

Mask

Match

VCI PTIGFC VPI CLP

Bit: 

Byte 1 Byte 2 Byte 3 Byte 4

 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1

1  1  1  1  1  1  1  1 1  1  1  1  1  1  1  1 1  1  1  1  1  1  1  1 1  1  1  1  1  1  1  1

0  0  0  0  0  0  0  00  0  0  0  0  0  0  00  0  0  0  0  0  0  00  0  0  0  0  0  0  0
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You can specify any bit position as follows.  Use either hexadecimal or
decimal values for the non-X settings, as appropriate to the current Options
menu setting for Show Header Values in Decimal Format:

Bit (s)
Setting Tells 622Vu Advisor to…

0 (zero) Ignore this bit position when trying to identify idle cells.

1 Examine this bit position when trying to identify idle cells.  Consider the cell
idle if all positions corresponding to 1s in the mask contain the values (0 or 1)
specified in the same bit positions in the match specification.

X Ignore all the bits in this field; they’re not relevant to whether the cell is idle.  If
you use Xs in a field, the entire field must specify Xs.

Change the mask as necessary, to indicate those bit positions you want to
match when determining whether the cell is idle (use 0 or 1 for each bit), and
those that you want to ignore (use X).

In the example shown to the
right (and the bit mask below),
we’re asking 622Vu Advisor to
explicitly ignore the GFC, VPI,
and CLP when examining each
cell to see if it’s idle, as well as
the first 11 positions of the VCI and last two bits of the PTI:

XX  X  X  X  X  X  X  X 

VCI PTIGFC VPI CLP

Byte 1 Byte 2 Byte 3 Byte 4

 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1

Mask

Bit: 

X  X  X  X 1 

Evaluate the input stream for idle 
cells based only on these six bits.

1  1  1  10  0  0  1 0  0  0  0  0  0  0  0  0  0

•  The Idle Cell Match indicates the specific bit values that define a cell as
idle.  By default, a cell is considered idle if it has zeros in every bit position
of the first five header fields.  If you’re using a mask, 622Vu Advisor only
looks at the bit positions you’ve enabled (set to 1) via the mask, regardless of
the match characters you specify.  In our example, it would only make sense
to specify the last five bits of the VCI, and the three bits in the PTI.  Because
the mask tells 622Vu Advisor to ignore the other positions, there’s no point
in specifying them here.
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For purposes of illustration, as-
sume we want to specify idle
cells as those having zeros in
the last five bits of the VCI, and
a 1 in the first bit of the PTI.
Our match settings look like
this. (  indicates bits that are
not examined):

Match

VCI PTIGFC VPI CLP

Bit: 

Byte 1 Byte 2 Byte 3 Byte 4

 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1

XX  X  X  X  X  X  X  X Mask X  X  X  X 0  0  0  1  1  1  1  1

1 X  X  X  X  X  X  X  X X  X  X  X 0  0  

1 0  0  0  0  0  0  0  0  0  0

0 0  0  0  0  0  0  0  0 0  0  0  0  0  0  0  0

Use either hexadecimal or decimal values to indicate the settings you want,
to correspond to the current Options menu setting for Show Header Values
in Decimal Format.

8.4  Defining Filter Buffers
As described previously, the filtering process uses 1–4 predefined buffers to store
cell captures while you’re monitoring incoming traffic (described in Chapter 6).
Each buffer is allocated a certain percentage of the total memory available (32
MB) on the analysis device for captures.

During capture processing, incoming cells are stored in the first buffer where a
match is found between the cell and specific filtering criteria (established via the
buffer’s filter entries).  A filterset option controls the action taken when a
buffer’s memory is exhausted (either wrap traffic back to the beginning or stop
capturing, as described on page 140).    

This section describes how to add a new filter buffer (either from scratch or by
cloning a buffer that’s defined already), to remove a buffer, to shift a buffer up or
down within the filter definition, and to modify a buffer’s definition.  The
definition specifies the amount of memory available for each buffer.

Two types of buffers, CaptureAll and BadHec, are reserved for use by the system
(see page 131).  You can modify the definitions of these buffers, but you can’t
delete them.
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Adding a New Buffer

To add a new filter buffer, click the
toolbar’s Add Buffer button (or
choose New Buffer from the File
menu).  The system prompts for the
name of the new buffer using the
window shown to the right.  Fill in
the name and click OK to add a new
(blank) definition.  Proceed to Modifying a Buffer Definition (page 145) for
instructions to define the buffer, then to Section 8.5  Defining Filter Entries (page
147) for instructions to establish the buffer’s filter entries.   

Cloning a Buffer

Instead of adding a new buffer from scratch, you can copy an existing buffer then
modify it.  To do this, first select anywhere in the buffer you want to copy, then
choose Clone Buffer from the File menu.  The system prompts for a buffer name
to assign to the new copy, using a window similar to the one shown above for
Add processing.  Fill in the name you want and click OK.  622Vu Advisor
makes a complete copy of the buffer, including all filter entries (with their
original names and definitions).  Then it stores the copy under the new buffer
name, placing it directly under the copied buffer.

You can change the definition as necessary, referring to the appropriate sections
of this chapter.

Removing a Buffer

If you find you no longer need a particular buffer, you can remove it from the
cell library.  To do this, first select any component of the buffer definition, then
click the Remove Buffer button (or choose Remove Buffer from the File menu).
The system verifies that you really want to remove the entire buffer, then deletes
it from the library — including all component filter entries.    

Add Buffer

Remove Buffer
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Modifying a Buffer Definition

The buffer definition window looks like this:

Buffer name
and description.

Allocation of
hardware memory
for this buffer.

Follow the directions below to specify the buffer’s name and description, and the
percentage of total-buffer space allocated to the buffer.

Buffer Name and Description

The buffer name displays as specified previously;  change this name as
necessary.  Enter the description as any text you want:  typically something that
explains the overall purpose of the buffer.  The description is only used in this
window.

Buffer Allocation

Use the Allocation area to specify how much of the analysis device’s available
memory should be allocated for this buffer:

•  Automatic instructs 622Vu Advisor to take all the buffers for which no
explicit size is specified (i.e., all the Automatic buffers), then to divide the
available (unspecified) space equally among these buffers.  This is the initial
setting for all new buffers.  In the window shown above, BadHec is already
defined as using 10.1% of the available buffer space, so this second buffer
automatically receives the remaining 89.9%.  The bottom right corner of the
window indicates that 100% of the available buffer space is allocated.  
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•  User-Defined Size specifies an exact percentage of the total buffer space to
allocate to this buffer.  You can either enter a value here, or use the spin
control arrows to change the percent shown:

Percent of the total
available capture
RAM allocated to
this buffer.

Total capture RAM
available on the device.

Number of ATM cells that will fit in
the buffer, as allocated currently.

The two grayed boxes to the right provide a tool that lets you determine the
number of cells you can store in the buffer as allocated, based on a 32 MB
device.  This tool is advisory only, and has no effect on system processing.
Use the drop-down list to select the device’s capacity, then look in the box to
the right to see the number of ATM cells that can fit in the allocated space.
For example, we can store 131,072 cells using 25% of a 32 MB capture
RAM.

Regardless of whether you’re using automatic or user-defined sizing, the value
displayed in the lower righthand corner changes as you adjust the allocation, to
show the percent of total buffer space that’s been allocated already.  This value is
only significant if you specify one or more user-defined sizes;  622Vu Advisor
always distributes 100% of the available buffer space when all buffer sizes are
determined automatically.  If the total percent value changes to red, you’ve
exceeded 100% of the buffer space and should check the defined allocations.

Note: Captured cells are blocked when they’re stored in the filterset buffers, using a blocking
factor of 512 cells (for 32 MB RAM).  Because of this, 622Vu Advisor may make minor
adjustments to your specifications to distribute the buffer space as precisely as possible.

Moving a Buffer Up or Down in the FilterSet

During capture processing, cells are placed in the first buffer where they match
any of the filter entries for that buffer.  The order in which the buffers are
defined, then, can affect the cells captured.  622Vu Advisor lets you change the
sequence of the buffers using the two buttons shown to the left (or by choosing
Move Buffer Up or Move Buffer Down from the File menu).  First select the
buffer you want to move in the filterset list, then click the appropriate button.

  
   Buffer     Buffer
      Up        Down
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8.5  Defining Filter Entries
Within each buffer2, you’ll define filter entries that specify exactly what cells you
want to capture to that buffer.  This section describes how to add a new filter
entry (either from scratch or by cloning an entry that’s defined already), to
remove a filter entry, and to modify an entry’s definition.   

Adding a New Filter Entry

To add a new filter entry, click the
toolbar’s Add Filter Entry button
(or choose New Filter Entry from
the File menu).  The system prompts
for the name of the new filter, using
the window shown to the right.  Fill
in the name and click OK to add a
new (blank) definition.  Proceed to Modifying a Filter Entry (page 148) for
instructions to define the new entry.

Cloning a Filter Entry

Instead of adding a new filter entry from scratch, you can copy an existing entry
then modify it.  To do this, first select the entry you want to copy, then choose
Clone Filter Entry from the File menu.  The system prompts for a name to
assign to the new copy, using a window similar to the one shown above for Add
processing.  Fill in the name you want and click OK.  622Vu Advisor copies the
filter entry and stores it under the new name, placing it directly under the
definition you copied.  Change the definition as necessary, referring to Modifying
a Filter Entry (page 148) for instructions.

Removing a Filter Entry

To remove a filter entry from the cell library, first select the entry you want, then
click the Remove Filter Entry button (or choose the corresponding command
from the File menu).    

                                                     

2 Exceptions are the two types of reserved buffers, CaptureAll and BadHec, which don’t use
filter entries.

Add
Filter Entry

Remove
Filter Entry
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The system verifies that you really want to remove the entry, then deletes it from
the library.

Modifying a Filter Entry

The filter-entry definition window looks like this:

Filter entry name
and description.

Specific values
to look for.

Note: If the filterset uses Advanced Filtering Mode, you’ll see more fields in the Filter Match box.
See page 149 for instructions in this case.

Follow the directions below to define the filter entry’s name and description, and
the filter match specifications.  The Enabled check box in the upper right corner
is always marked.

Filter Entry Name and Description

The filter entry’s name displays as you specified it previously;  change the name
as necessary.  Specify the description as any text you want;  it’s only used in this
window to describe the entry.

Filter Match Specifications

Specify the Filter Match area as any set of GFC/VPI, VPI, and VCI header values
you want to capture.  Together these values comprise the address of a specific
connection (0000014 in our example).  Use hexadecimal or decimal values to
indicate the specific bit settings:  hexadecimal if the Options menu Show
Header Values in Decimal Format setting is OFF;  decimal if it is ON.
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8.6  Advanced Filtering Mode
622Vu Advisor’s advanced filtering features let you define a filterset-level mask
that's combined with all other selection criteria when choosing the cells to
include.  This lets you specify a particular characteristic that you want across all
captured cells, for example, or header fields you want to ignore completely

If you mark the Advanced Filtering Mode option for a filterset, the filterset
definition and filter-entry definition windows offer enhanced masking capa-
bilities.  The filterset definition window lets you specify a filterset mask, and the
filter-entry window uses that mask to offer extended filtering options.    

Specifying a FilterSet Mask

With Advanced Filtering Mode on, the filterset definition window changes to
include a filterset mask:

Use the FilterSet Mask
area to identify those
bit positions you want
to examine, within
each incoming cell.

This lets you define a mask that’s similar to the idle-cell mask described earlier,
but in this case the mask identifies those bit positions you want to examine in
each cell coming into the analysis device, for purposes of determining whether to
capture the cell.  Presumably at least one filter-entry definition references each
bit position you ask 622Vu Advisor to examine.

You can examine any of the header bits, as well as the first byte of the payload.
(This first payload byte lets you select AAL1 cells based on their SAR, for
example.)    
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For each bit position, specify one of the values below, combining the 1s and 0s
into hexadecimal characters for purposes of data entry (e.g., entering four 1s as a
single hex F).  Use hexadecimal if the Options menu Show Header Values in
Decimal Format setting is OFF;  decimal if it is ON:

Bit (s)
Setting Tells 622Vu Advisor…

0 (zero) Ignore this bit position;  it’s not relevant to the filter.

1 Examine this bit position.  Store the cell in this filterset if all positions corre-
sponding to 1s in the mask contain the values (0 or 1) specified in the same bit
positions in a filter entry.

X Ignore all the bits in this field.  If you use Xs in a field, the entire field must specify
Xs.

By default (i.e., if you’re not using advanced masking), 622Vu Advisor looks at
the first 28 bit positions of each header (the GFC, VPI, and VCI fields).  With
advanced masking, it examines the first 48 bits (also the PTI, CLP, HEC, and
first byte of the payload).

Change the mask as necessary, to
indicate those bit positions you want
to examine (mask value is 1), and
those you want to ignore (mask
value is 0).  In the example shown to the right (and the corresponding bit mask
shown below), we’re asking 622Vu Advisor to look at the 1-bit CLP:

FilterSet
Mask

Bit: 

Byte 5 Byte 1 Byte 2 Byte 3 Byte 4

 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1

Payload Byte 1 

 8      7     6      5     4     3      2     1

1 X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X 

HECVCI PTIGFC VPI CLP Payload

Filter Entries in Advanced Filtering Mode

With Advanced Filtering Mode on, the filter-entry window lets you specify
selection criteria based on all the header fields, as well as the first byte position
of the payload.  Any fields you’ve instructed 622Vu Advisor to ignore are grayed
out in the Filter Match area, and shouldn’t be entered.    

Use the other character positions to specify bit values you want to match to
incoming cells:
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Bit values you
want to match
(specified in hex).

Specific values to look
for, shown in binary
format (determined by
ADDing the filterset-
level mask and this
filter-entry mask).

As you enter values in the Filter Match area, the composite (Resulting Match…)
panel changes to show a binary representation of the actual values 622Vu
Advisor searches for when comparing incoming cells to this filter entry’s
selection criteria.  622Vu Advisor combines (ANDs) the mask and filter-entry
settings to compute a final match pattern.

In the example shown above (and corresponding bitmap below), we’re looking
for a CLP value of 1 (cells having a low priority). (  indicates positions that
aren’t examined:)

Bit: 

Byte 5 Byte 1 Byte 2 Byte 3 Byte 4

 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1 8      7     6      5     4     3      2     1

Payload Byte 1 

 8      7     6      5     4     3      2     1

Resulting
Match X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X 

FilterSet
Mask

Filter Entry X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X 

X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X 

X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X X  X  X  1 

X  X  X  1 

1 X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X  X X  X  X  X  X  X  X 

HECVCI PTIGFC VPI CLP Payload

8:  Filtering Captures
8.6  Advanced Filtering Mode

151



8:  Filtering Captures
8.6  Advanced Filtering Mode

152



Chapter 9

Editing Transmit
Sequences

622Vu Advisor lets you define and transmit sequences of cells used to analyze
ATM equipment.  You can create a transmit sequence in three ways:

•  By defining a sequence explicitly.

•  By using the AAL5 wizard to define a new sequence or append cells (AAL5
PDUs) at the end of an existing sequence.  

•  By capturing, then optionally editing, a series of cells.

You can combine these approaches, to capture a basic sequence then edit
individual cells and/or define additional cells for inclusion.

This chapter describes the first two approaches.  As necessary, refer to Creating
a Script From a Capture File on page 113 for instructions to create a new
sequence from captured cells.
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Initiating the Sequence Editor

To initiate the sequence editor, click the Edit Transmit Sequences button on the
toolbar (or choose the corresponding command from the Activities menu).  This
displays a summary of the sequences defined so far, with the currently selected
sequence identified at the top (Name field):       

Click to modify the
selected sequence.

Currently
selected
sequence.

Name and description of
each sequence defined
in the active cell library.

Click to define a
new sequence.

Click to delete the selected sequence.

Review the information shown, then proceed as follows:

Click To…

New Define a new sequence.

Edit Edit the selected sequence, or any cells defined in that sequence.

Remove Delete the selected sequence.  622Vu Advisor displays a verification window before
completing the request.

Close Close the window.

Alternatively, choose Cell Sequence AAL Wizards - AAL5 from the Tools
menu to initiate the AAL wizard, which lets you create a new sequence that
contains AAL5 PDUs, or add an AAL5 PDU to an existing sequence.  

If you request New or Edit, or use the AAL5 wizard command:

•  First read Section 9.1  Inheriting Cell Characteristics which describes the
concept of inheritance as it relates to cell characteristics (properties).  It’s
important that you understand this concept.  You can save time during
sequence definition, if you allow cells and sequences to inherit some or all
properties.

•  Proceed to Section 9.2  Creating or Editing a Sequence (page 157) to begin
definition of a new sequence.

Edit Transmit
Sequences
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•  Proceed to Section 9.3  Using the AAL5 Wizard (page 160) for instructions
to create AAL5 PDUs using 622Vu Advisor’s wizard capability.  The wizard
simplifies the task of creating PDUs for analysis, by formatting the SAR
(Segmentation and Reassembly) and CPCS (Common Part Convergence
Sublayer) settings for you automatically, and by computing the PDU’s CRC.  

•  Proceed to Section 9.4  Defining the Cells In a Sequence (page 163) to
define individual cells within a sequence.     

9.1  Inheriting Cell Characteristics
The basis of 622Vu Advisor’s ATM analysis involves transmitting and monitor-
ing traffic at the cell level.  622Vu Advisor uses two entities to group and process
cells:   

•  A sequence combines one or more individual cell definitions (and in-
formation telling it how to use those definitions).  You’ll access all cells
through a sequence definition;  each cell participates in one and only one
sequence.

•  A script combines one or more sequences to form a transmission used to
analyze ATM networks and devices.

Conceptually, then, scripts are at the highest level, the sequences are at the next
level, and cells are at the lowest level.  This is illustrated in Figure 4.

Several cell-specific properties are maintained at each of the cell, sequence, and
script levels.  At each level, every individual property is either defined (i.e., set
explicitly) or undefined (never set or set to the undefined state).
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Script CScript BScript A

Sequence 1

Cell List

Sequence 2

Cell List

Sequence 3

Cell List

Sequence 4

Cell List

Sequence 5

Cell List

Cell Library

Each sequence 
comprises 
one or more cells.

A script uses one or more 
sequences in its definition.  

CellSequence
Directory

CellScript
Directory

Figure 4.  Logical Hierarchy of Cells, Sequences, and Scripts

You’ll see how to define and undefine properties when you set up sequence and
script definitions.  Table 9 describes those properties that can be set from within
622Vu Advisor.

Table 9.  Cell Header Properties That Can Be Inherited

Inheritable Property Description

GFC Generic Flow Control.

VPI Virtual Path ID.

VCI Virtual Channel ID.   

PTI Payload Type Indicator.   

CLP Cell Loss Priority.

Force-HEC-state Indication of whether the state of the HEC is defined or not.   

If a property is undefined at a particular level, its value is inherited from the
containing object:

•  A property that’s undefined in a cell definition is inherited from the
containing sequence (if defined there) or script (if not defined at the sequence
level).
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•  A property that’s undefined in a sequence definition is inherited from the
containing script (then propagates down to any cells for which the property is
undefined).

Put another way, when a property is defined in a sequence, that definition
provides a master value that applies for any cells that are included in the
sequence and for which the property isn’t defined specifically for the cell.
Similarly, when a property is defined in a script, that definition provides a master
value that applies for any sequences included in the script, if the property is
undefined at the sequence level.

If a property isn’t defined at any of the three levels, it’s assumed to be zero (0).

9.2  Creating or Editing a Sequence
When you create or modify a sequence using the Edit Transmit Sequences
toolbar button, your working window looks like this:    

Sequence name and description.

Master property values (inherited
by any contained cells for which
the corresponding property is
undefined).

Calls included in the sequence, in
order as transmitted during script
execution, and with a repeat count
for each cell. Use this area to add,
reposition, or remove a cell from
the sequence; or to select a cell to
be modified.

Use this window to identify the sequence (top-most area), specify master
sequence values (middle area), and define/edit the cells in the sequence (bottom
area).

Edit Transmit
Sequences
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Identifying the Sequence

Use the area at the top to identify the sequence.  The sequence name (1–31
characters) is required when adding a new sequence, but is dimmed (not modifi-
able) when editing.  The description is optional and can be any length.

Specifying Master Sequence Values

Use the second area to specify
the sequence’s master values,
either typing a value in directly,
or using the drop-down list to
select the value you want.  .

Make sure you have read Section 9.1  Inheriting Cell Characteristics on page 155
before assigning these values, and make sure you’re familiar with the content and
use of each field as it relates to ATM cells.

The master values are described below.  One or more Xs in a field indicate that
there’s no defined value for that field;  if a cell contained in the sequence inherits
the corresponding property, that cell will have to look to the containing script for
a value:

Field Description

GFC/VPI Generic Flow Control for UNI-formatted cells;  generally always zero
(0).

Part of the VPI for NNI cells.

VPI Virtual Path ID, in the range hex 0–FF;  decimal 0–4095 (for a value
intended to be inherited by NNI cells) or 0–255 (if intended to be
inherited by UNI cells).

VCI Virtual Channel ID, in the range hex 0–FFFF;  0–65535 decimal.

PTI Payload Type Indicator.  Use the drop-down list to select the value you
want, in the range 0–7.

CLP Cell Loss Priority.  Use the drop-down list to select 0 or 1.

Use the check boxes to the far right to specify the format used for the header
fields (decimal or hexadecimal), and to indicate whether the force-HEC-state
property is defined..  Make sure to specify the header fields (above) using
(hexadecimal or decimal) values appropriate to the current Decimal Header
Format setting.
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Check Box Description

Decimal Header
Format

Indicates whether the header values display as decimal or hexadecimal.
Mark this box for decimal;  leave it blank for hexadecimal.

Mark HEC as Defined Indicates whether the force-HEC-state property is defined or not.  Mark
this box to specify the property as defined;  leave it blank if the property
is undefined.  The next option applies if you specify defined.

Force Bad HEC Does not apply for scripts run on the 622Vu Advisor device.

Defining the Sequence’s Cell Content

Use the area at the bottom to define or modify the cells included in the sequence:  

Cells are listed in order as
transmitted during testing.
Adjust the order using the
Position field, as necessary.

Click to edit a cell’s definition.
Click to add the cell

to the sequence.
Click to delete the selected cell.

Name of
each cell.

Click the arrows to shift the selected cell
up or down in the sequence. (Or enter an
absolute position in the text box.)

Click the + and - buttons to increase or decrease
the number of times the cell is transmitted. (Or
enter an absolute repeat count in the text box.)

This column shows the number of
times the cell is transmitted when
the sequence runs.  Adjust this
value using the Repeat Count field,
as necessary.

Cells are listed in order as transmitted during testing, and each cell has a repeat
count that specifies the number of times it’s sent (one after the other) when the
sequence runs.  You can adjust the order and count using the Position and Repeat
Count fields, respectively.

Using this part of the window, you can:

Click To...

New Add a cell to the sequence, positioning it just after the currently selected cell.

Edit Change the definition of a cell.  As an alternative to clicking the Edit button, double-
click the cell you want.  622Vu Advisor opens a window similar to that used for New
processing, but with the cell’s name and framing type grayed out;  you can only
specify the name and framing when you first define a cell.
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Remove Remove the selected cell.

For New and Edit processing, proceed to Section 9.4  Defining the Cells In a
Sequence.

Note: As an alternative to defining a sequence’s cell content, you can use the AAL5 wizard,
described next.

9.3  Using the AAL5 Wizard
The AAL5 wizard lets you define AAL5 PDUs
easily, without concern for accurate SAR and
CPCS settings, and without having to compute
the CRC.  From 622Vu Advisor’s main menu, choose Cell Sequence AAL
Wizards - AAL5 from the Tools menu to start the wizard:  

Master property values
(inherited by any cells for
which the corresponding
property is undefined).

Click to display a list of
sequences, to append the
new PDU at the end of an
existing sequence.

Sequence where you want
to store the new AAL5
PDU.  Enter a new or
existing sequence name.

Indicate whether you want to
define the PDU cell-by-cell,
using the Cell Editor; or from
a file stored on your PC.

Use with the Cell Editor to define (or modify)
the previous or next cell in the PDU.

Character with which to
fill unassigned positions
in the new PDU.

Use when importing the PDU from a text file to open a Windows
Open dialog box (from which you can then select the file you want).

Number of cells created
with the editor.

In the top-most panel, enter either the name of a new sequence (to start a new
definition) or the name of an existing sequence (to append the PDU at the end of
an existing sequence).  In the latter case, you can click the Select button to
display a list of sequences that exist already, to choose the one you want.

Use the middle panel to specify the master sequence values, as described starting
on page 158.  For ease of processing, the <Enter> key tabs between the header
fields indefinitely, as long as you stay in the Header area.  Specify fields using
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hexadecimal or decimal values, to correspond to the Decimal Header Format
setting.  One or more Xs in a field indicate that there’s no defined value for that
field.

Make sure you’re familiar with the concept of inheritance as it relates to cell
characteristics (properties) before assigning these header values, and make sure
you're familiar with the content and use of each field.  Use the check boxes to the
far right to specify the format used for the header fields (decimal or
hexadecimal), and to indicate whether the force-HEC-state property is defined.

If you’re generating a new sequence, 622Vu Advisor assigns the header values at
the sequence level, and sets up the individual cells to inherit header properties.  If
you’re appending PDUs to an existing sequence, the header values specified here
are inserted into each generated cell.  (An X value will cause the cell to inherit
the corresponding property in this case.)

Use the bottom-most area to:

•  Indicate whether you want to create the PDU cell-by-cell, using 622Vu
Advisor’s cell editor;  or by importing the payload data from an external file
stored on your Agilent Advisor.  (You can use any file, up to 6MB in size.)  

•  Specify the pad character you want to use for unassigned positions in the
payload.

Click the Next button when you’re through, to begin definition of the payload.
Here the processing varies depending on whether you’re using the cell editor or a
file to fill the payload (see Using the Cell Editor below, and Obtaining the
Payload From a File on page 162).

In either case, after you’re through defining the
payload, 622Vu Advisor adds the new PDU to the
sequence you’re working on, then tells you how
many cells are in the new PDU (right).  This
number includes the cells generated to store the
payload (as specified), and may include an additional cell used for padding, as
appropriate to the PDU.

Using the Cell Editor

If you request use of the cell editor, the system opens this window (shown filled
in for the first cell):
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Use this area to
define the 48-byte
cell payload.

Cell you’re working
on, within the PDU.

You can enter the payload here as
ASCII text, as long as all the
characters are printable. This area is
disabled if you enter unprintable
characters.

Click when you’re through
to generate the PDU.Click to define the next cell in the

PDU.  This button becomes active
only after you fill up the current cell.

Click to display the
previous cell.

Enter the payload data for the cell, using either method below:

•  Use the 48 text boxes to specify the data, entering each byte in hexadecimal
format.

•  Use the area below the text boxes to type in ASCII data.  This option isn’t
available if unprintable characters are already defined in the payload (in
reserved positions).  In this case, the ASCII box is grayed, and unprintable
characters display in that box as dots (.).

When you finish, either click Next to define the next cell in the PDU, or Done if
you’re through.  This completes generation of the PDU and adds it to the
sequence.  As necessary, use the Previous button from any cell, to
display/modify the previous cell definition.

Obtaining the Payload From a File

If you’re creating the new
PDU from a file, the system
opens a standard file-open
dialog box.  Select the file you
want to use to fill the payload
for the new PDU.  When you
return to the wizard, the Done
button is highlighted,
indicating that the content of
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the file was moved successfully to the PDU:  

Click to finish generating
the new PDU.

Not used when
creating cells
from a file.

Click Done to complete the PDU (and add it to the sequence you’re working on).
If you want to edit the new PDU, you can do so using the sequence editor (page
157).

9.4  Defining the Cells In a Sequence
When you use the sequence editor (page 159) to add a cell to a sequence, or to
edit a cell that’s already defined in a sequence, 622Vu Advisor uses the following
window to prompt for the cell’s content:          

Depending on the type of framing, this
area may offer a mini-wizard to assist in
specifying reserved areas of the
payload.

Cell name.

Type of cell framing used.

Cell’s header properties.  Values
assigned here are not inherited from
the containing sequence or script (X
specifies undefined, or inherited).

Use this area to define the 48-byte
cell payload.  Depending on the
type of framing used, some of the
payload may be reserved for
framing data.
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This window is the same for New and Edit processing, except that the name and
framing type are grayed (not-modifiable) for an edit.

Follow the directions below to identify the cell, select the type of framing used,
define the cell’s header properties, specify the payload, and define any payload
data that’s specific to the type of framing used.  When you're through with the
cell definition, click OK.

Identifying the Cell

Use the area at the top to specify a 1–31 character cell name.  This area is grayed
out if you've already defined the name.

Identifying the Type of Framing Used

When you define a new cell,
622Vu Advisor lets you pick
the type of framing you want
to use.  The lower right corner of the dialog box changes to provide a mini-
wizard(s) appropriate to your selection, for use in constructing the reserved
portions of the payload (nothing for Raw framing).  

Framing Description

Raw There are no predefined framing characteristics.  You can use the payload as you
wish, forcing any values in any position.

AAL1 ATM Adaptation Layer that supports connection-oriented services requiring a
constant bit rate, where those services have specific timing and delay
requirements.

AAL1 requires that you provide SAR (Segmentation and Reassembly) specifics,
as detailed under AAL1 Framing on page 166.    

AAL5 ATM Adaptation Layer that supports connection-oriented services using variable
bit-rate transmissions, where those services don’t require a bounded delay from
source to destination.  AAL5 is suitable for most data transmissions.

AAL5 requires that you provide CPCS (Common Part Convergence Sublayer),
SAR (Segmentation and Reassembly), and a Special setting, as detailed under
AAL5 Framing on page 167.    

OAM Not currently available.  

LMI Not currently available.
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Specifying Cell-Header Properties

Use the Cell Header area to specify the cell’s header properties:   

For ease of processing, the <Enter> key tabs between the header fields
indefinitely, as long as you stay in the Header area.  Use the check boxes to the
far right to specify the format used for the header fields (decimal or
hexadecimal), and to indicate whether the force-HEC-state property is defined.

Make sure you have read Section 9.1  Inheriting Cell Characteristics on page 155
before assigning these values, and make sure you’re familiar with the content and
use of each field as it relates to ATM cells.  Specify fields using hexadecimal or
decimal values, to correspond to the Decimal Header Format setting.  The values
you can enter are described under Specifying Master Sequence Values on page
158.  One or more Xs in a field indicate that there’s no defined value, and that the
cell inherits a value from the containing sequence (if defined there) or script.

Specifying the Payload

The bottom left area of the window provides 48 character positions, allowing you
to specify the cell’s 48-byte payload.  Unless you’ve selected Raw framing,
however, some of the payload may be reserved.  622Vu Advisor provides mini-
wizards to the right of the payload to assist in constructing the reserved portions
of the payload (illustrated below for an AAL5 cell):   

Mini-wizards display in this area, and
simplify the definition of the payload.
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622Vu Advisor color-codes any reserved positions in the payload area, matching
the color used with the corresponding framing specifications to the right (End of
Datagram in the example above).  See AAL1 Framing (page 166) and AAL5
Framing (page 167) for details about these framing specifications.   

You can fill in any data you want in the unreserved payload positions.  There are
two ways to do this:

•  Use the 48 text boxes to specify the data, entering each byte in hexadecimal
format.  When you close the cell definition, 622Vu Advisor fills all the
remaining positions with spaces.  If you don’t specify any cell positions
explicitly, 622Vu Advisor zero-fills the entire payload when you close the
cell.

•  Use the area below the text boxes to type in ASCII data.  This option isn’t
available if unprintable characters are already defined in the payload (in
reserved positions).  In this case, the ASCII box is grayed, and unprintable
characters display in that box as dots (.).

Raw Framing

If you select raw cell framing, 622Vu Advisor lets you specify any cell data you
want, in any position.  Raw cell framing is particularly useful for non-standard
transmissions, as for a device that uses a proprietary signalling code.     

AAL1 Framing

If you select AAL1 cell framing, 622Vu Advisor provides a mini-wizard to assist
you in generating a correctly formatted cell (i.e., a cell with SAR information in
the first payload position):  
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Use the drop-down lists in the mini-wizard to specify the Segmentation and
Reassembly (SAR) settings you want.  The first position in the payload is
reserved for these (combined) settings and changes as you set each field:

Field Description

CSI Convergence Sublayer Indicator, specified as 0 or 1.

SC Sequence count, in the range 0–7.  

SN Serial number, specified as hexadecimal 0–F.  This value is carried in the high-order
four bits of the first payload byte.  As an alternative to specifying this field, provide
the CSI and SC values individually.

CRC Checksum of the unframed payload data, in the range 0–7.  AAL1 uses this CRC to
verify correct transmission of the payload.

Parity Parity used for transmission, specified as 0 (even) or 1 (odd).

SNP Sequence Number Protection, specified as hexadecimal 0–F.  This value is carried in
the low-order four bits of the first payload byte.  As an alternative to specifying this
field, provide the CRC and Parity values individually.  

AAL5 Framing

If you select AAL5 cell framing, 622Vu Advisor provides mini-wizards to assist
you in formatting the cell’s Segmentation and Reassembly (SAR), CPCS
(Common Part Convergence Sublayer), and time-stamp (Special) information
correctly.
Each has its own tab.  Click each tab in turn, specifying information as described
below.  

SAR Settings

There’s one SAR field.  That field applies if this cell contains the end-of-
datagram signal (i.e., if it’s the last cell of the PDU):
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Specify zero (0) if the cell is not the last cell of the PDU;  1 to include the end-of-
datagram signal.  A zero value doesn’t affect the payload.  If you specify 1:

•  622Vu Advisor reserves the last eight bytes of payload.  Click the CPCS tab
to assign the value you want for each reserved field.

•  The PTI in the cell header changes to reflect end-of-datagram signalling.
You can override the PTI to change this setting, as necessary, but make sure
the last bit of the value you specify is a 1 so it correctly reflects end-of-
datagram signalling (1 and 3 are fine;  5 is out of range for AAL5).

Note: If you set End of Datagram ON (1) then turn it OFF (0), the positions that were formerly
reserved remain set in the payload, although they can now be modified.

CPCS Settings

The CPCS (Common Part Convergence Sublayer) mini-wizard is enabled when
you select end-of-datagram signalling using the SAR tab.  Click the CPCS tab to
assign values to the positions reserved for end-of-datagram information.  All
settings are in hexadecimal format.
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Use these fields
to set the CPCS
values at the end
of the payload.

Field Description

PAD Character with which to fill unassigned positions in the payload.

UU Indication User-to-user indicator (generally zero).

CPI Common Part Indicator, or message type (generally zero).

Length Length of the entire packet (data only, excluding any end-of-datagram
signal).

CRC Computed CRC checksum for the payload.

Special Settings

There’s one Special field, used to specify whether in-payload-timestamp-
generation is on or off for the cell.  With this property on (the check box
marked), 622Vu Advisor places a timestamp in the cell payload before it’s
transmitted, overriding bytes 8–10 and 12–14 for this purpose:   

Use these fields
to set the CPCS
values at the end
of the payload.

Note: If you insert a timestamp then remove it (by clearing the check box), the positions that were
formerly reserved remain set (to 00) in the payload, although they can now be modified.
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Saving Cell Changes

When you’re through with the cell definition, click OK.  Here’s the sequence
display with one cell added:    

Use to increase or decrease the number of times the
cell is transmitted.  (If you enter a number in the text
box, click out of that box for the change to take effect.)

Use to move the cell up or down in the
sequence. (If you enter a number in the
text box, click out of that box for the
change to take effect.)

The new cell appears just
after the cell that was
selected previously.

New cells are inserted just below the previously selected cell.  Use the Position
arrows as necessary to shift the cell’s location relative to other cells in the
sequence, and the Repeat Count arrows to specify the number of times the cell
should repeat in the sequence.  In either case, if you enter a number in the text
box, click outside of that box for the change to take effect.
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Chapter 10

Running & Editing Scripts

A script defines a specific ATM-cell traffic pattern, including timed pauses, that
can be sent from an analysis device across an ATM network to test its
transmission capabilities.  At any point in time, you can have one transmission
script running from each analysis device that’s accessible to your system.

The specific traffic pattern for each script is defined via one or more predefined
sequences (see Chapter 9, starting on page 153).  This chapter describes how to
display and execute scripts, then provides instructions to define new scripts.

To begin processing a script, either click the Transmit Scripts toolbar button
(shown to the left) or choose Transmit Scripts from the Activities menu.  Either
approach opens the window shown below, which lists each transmission script in
the active cell library, with the currently selected script identified at the top
(Name field):    

Select a script
then click to run it.Click to delete the

selected script.Click to modify the selected script.

Click to define a new script.

Name and description of
each script defined in
the active cell library.

Currently selected script.

Transmit Scripts
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Review the information shown, then proceed as follows:

Click To…

New Define a new transmission script.  (As an alternative to defining a transmission
script explicitly from scratch starting from this button, you can create a script from a
capture file.  This feature is described in Chapter 6, starting on page 113.)

Edit Edit the selected script.

Remove Delete the selected script.  622Vu Advisor displays a verification window before
completing the request.   

Run Execute the selected script (same as double-clicking that script).

Close Close the window.

If you request New or Edit processing, see Section 10.2  Creating or Editing a
Script on page 177.  If you request Run, proceed to the next section for
instructions.

10.1  Running a Script
To initiate a script, select the script you want and click Run (or double-click the
script).  622Vu Advisor asks you to define the script’s master header properties,
and to identify the device from which to transmit the test.

1. Use the top-most panel to specify the script’s master header properties.  Use
the check boxes to the far right to specify the format used for the header
fields (decimal or hexadecimal), and to indicate whether the force-HEC-state
property is defined.

Enter the properties as hexadecimal or decimal values to correspond to the
Decimal Header Format setting:     

Master property values (inherited by
cells for which the corresponding
property is undefined at both the cell
and sequence levels).

Mark to save the script header
in the active cell library;  leave
blank for one-time settings.

Make sure you’ve read Section 9.1  Inheriting Cell Characteristics on page
155 before assigning these values, and make sure you’re familiar with the
content and use of each field as it relates to ATM cells.  The specific values
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you can enter are described under Specifying Master Sequence Values on
page 158.

2. Mark the Save to Library check box if you want to save the header on the
active cell library;  otherwise (for a one-time setting) leave it blank.

3. Select the analysis device where you want to run the script, from the list at
the bottom of the processing window.  This list includes each device
available to you.  

Select an analysis device then click
to monitor the script’s processing.

Click to check (then redisplay)
the status of each device.

Field Description

Card System name to identify each device, followed by a number (always 1).

Interface Type of connection supported between the analysis device and ATM device.

Status Always “Available,” indicating that the device is currently available for use.

Note: In order to execute a script, the analysis device must be configured as an active end
station.  Refer to Chapter 4 for related configuration instructions, as necessary.

You can monitor the physical interface to the ATM device while the script
runs, as described in Chapter 5.  

You’ll only see those devices that are available for use currently.  If a
specific device is already performing RAM-intensive activity (such as a
capture), it won’t appear in the list.  If you expect to see a device that isn’t
here, click the Refresh button to reevaluate its status.

After you select an analysis device and click OK, 622Vu Advisor opens a
Monitor Script window, through which you’ll control and monitor the actual
script execution:
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Name of the script you’re running, and the
analysis device where you’re running it.

Toolbar.

Script-level
statistics.

There are two parts to this display:

•  The toolbar lets you control the actual script execution.

•  The area below the toolbar shows five tabs, but only the left-most (General)
tab is used, and shows script-level statistics.
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Using the Toolbar Buttons

Use the toolbar to direct script processing, referring to Table 10 for instructions.

Click to start
(transmit) the
script.

1

2

Depress before running the script, to set the script
to run repeatedly until you stop it (vs. only once).

Table 10.  Script Execution Menu Commands and Toolbar Buttons

Menu Command Button Used to…

Start Script Start the script (i.e., begin transmission of the sequences in
the script).  After you start the script, the elapsed-time
counter (right) becomes active, allowing you to track the time
since execution began:

Click to stop
script execution. Amount of time the

script has been running.

The Stop Script button is also enabled, allowing you to stop
transmission at any time.

Pause Script Pause the script.  Not currently implemented.

Stop Script Stop the script (only available during execution).  When you
click this button, the Start button is enabled, allowing you to
restart the same script.

Run Continuous Indicate whether to execute the script once or continuously
(depressed for continuous execution).  Even if you run the
script continuously, you can stop it at any time using the Stop
Script button.

Setup Script Display the first window opened when you ran the script,
allowing you to respecify master header values and the
analysis device you want to use.

Configure Script
Monitor
Parameters

Not used.

Print Log Not used.

Exit Exit from the script-execution window.
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If you interrupt the script, the elapsed-time field stops counting and changes from
green to red.  You can rerun the script any number of times by simply clicking
the Start button.  The elapsed-time field resets itself after a restart, as do the
statistics and graph (as applicable to the script you’re running).

General Tab Statistics

When you run a script, the Monitor Script window displays statistics related to
script execution.  The following statistics display on the General tab.  (The other
tabs are disabled for transmission scripts.)

Statistics Represents the...

Cells Transmitted Number of cells transmitted since the script started to run.  You
can graph this statistic.

Current State Current internal state of the script execution.

Current Steps Executing Number of the step that’s currently executing, as identified in the
script definition.

Executed Scripts Number of times the script has been run;  meaningful with Run
Continuous selected.

Execution Time (sec.) Amount of time it takes to execute the script, in seconds.  If Run
Continuous is selected, this is the amount of time it takes to run
the script one time.

Steps Executed Number of (valid) steps executed already, for the script that’s
running currently.

Total Execution time (sec.) Total time elapsed since the script first started to run, in seconds.
Includes all cycles if the script is set to Run Continuous.
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10.2  Creating or Editing a Script
When you create or modify a script, your working window looks like this (shown
below for creating Script 03):

Script name and
description.

Master property values (inherited
by any cells for which the
corresponding property is
undefined at both the cell and
sequence levels).

Definition of each
step in the script.

Use this window to identify the script (top-most area), specify master cell-header
properties (middle area), and define the specifics of the script itself.

Identifying the Script

Use the area at the top to identify the script.  The script name (1–31 characters) is
required when adding a new script, but is dimmed (not modifiable) when editing.
The description is optional and can be any length.

Master Cell-Header Values

Use the second area to specify default cell-header properties;  i.e., properties to
be assigned to any cells for which these properties aren’t defined explicitly at the
cell or sequence level.  Refer to page 158 for the specifics of these settings.  
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Defining the Specifics of the Script

The Script Steps panel lists all the steps in the script, in order as transmitted
during execution.  There’s a repeat count for each step.  You’ll use this area to
add or remove a step from the script, or to select a step to be modified.

Steps in the script, listed
in order as exectuted
when the script runs.
Click any step to edit its
content, or to shift it up
or down in the script.

Click the appropriate
button to shift the
selected step up or
down in the script.

Click to delete the
selected step.

Click to save the current step’s
definition (after changes).

Click to add a new
step to the script.

Use the buttons in this area to specify the type of processing you want:

Click To…

Add Add a new step to the script, positioning it just after the currently selected step.

Update Revise the definition of the currently selected step.   

Remove Remove the selected step.  622Vu Advisor verifies your request before deleting the
step.

Up Shift the currently selected step up one position in the script.

Down Shift the currently selected step down one position in the script.

Each script begins with a Start step and ends with an End step.  You can add any
combination of transmit and pause steps between these special markers.  The top
of the Script Steps panel defines the currently selected step, or a new step you’re
defining.    

Adding or Updating a Step in the Script

For a new or modified step, use the top of the Script Steps panel to define the
characteristics of the step.  As identified by the Type field, each step is either a
Transmit (which sends a sequence out from the analysis device) or a Pause
(which pauses a specified amount of time).

When you’re through defining the characteristics of the step, click Add to add
the specifications as a new step, placing it just below the step that’s selected;
click Update to modify the currently selected step.  
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Applicable for
Transmit steps;
sequence you want
to send out.

Delay between
each cell (for
Transmit steps),
or length of pause
(for Pause steps).

Type of step (Transmit or Pause).Number of times to repeat
this step (consecutively at
this point in the script).

For a Transmit step, specify the following fields:

Field Description

Step Type Type of step (always Transmit).

Repeat Number of times you want to repeat the sequence associated with the step.  When
the script runs, the analysis device transmits the sequence consecutively the
specified number of times.  

Delay Time Number of milliseconds, microseconds, etc., to pause between repetitions of the
sequence (you select the units).  The maximum delay time is 6.5535 milliseconds.

Sequence Name of the sequence you want to send when this step executes.  Either type the
name of a sequence here directly, or select one from the drop-down list.

Note: You can specify a sequence that you haven’t defined yet, as long as it’s
defined before the script runs.

For a Pause step, specify the following fields:

Field Description

Step Type Type of step (always Pause).

Delay Time Number of milliseconds, microseconds, etc., to pause at this point in the script
execution (e.g., 5 seconds, or 750 milliseconds — you select the units).  There’s no
reasonable limit to the time you can enter here.
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Chapter 11

Using the Ping Generation
Tool

The Ping Generation tool lets you transmit standard ping messages through an
ATM network, targeting a specific destination address.  You control the packet
size and the number of packets sent.

This feature is available for use with devices configured in end-station mode.

Starting Ping Generation

Click the Ping Generation button to initiate this feature of the system.  This
opens a dialog box through which you’ll specify the properties you want (packet
size, number of packets to send, etc.).

Specifying Properties to Use

First select the General tab then specify the
following information:

•  Use the Device drop-down list to select
the analysis device to use.  As noted
above, this must be configured as an
end-station device.

•  Enter the Source Address to identify the
analysis device you’re using.  This is
the address to which the remote device
sends it’s reply, after receiving each
ping message.  Make sure to specify an
IP address that’s different from the IP address of the device’s Ethernet port.

•  Specify the Destination Address of the end station you’re testing (i.e., the
target station to receive the ping messages).

•  Select the Protocol to use when transmitting the messages:

Protocol Description

RFC 1577 Classical IP and ARP over ATM.

Ping Generation
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Protocol Description

RFC 1483 Multiprotocol Support over ATM AAL5.

•  Specify the VPI/VCI over which to transmit the ping message(s).

 Then select the Options tab and specify the:

•  Packet Size of each message sent (4096
bytes maximum).  This size does not
include overhead for encapsulation.

•  Timeout period, in seconds.  This is the
maximum amount of time 622Vu
Advisor will wait for a response to each
message sent before timing out.
Applicable only if the Transmit Only
box is unmarked.

•  Type of Transmission requested:

Selection Description

Transmit Only Mark to transmit messages without regard to a response;  leave blank if
you want to wait for a response from each message sent.

Continuous Mark to send ping messages repeatedly, until you stop the transmission
explicitly.  With this box unmarked, you can specify the Number of
Packets to send.
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Running a Ping Test

After you specify the properties you want, click OK to run the test.  622Vu
Advisor opens this ping-test monitoring window:

Messages sent,
responses received,
and timeout counts.

Measured round-trip
latency (minimum,
maximum, and
average).

Amount of time the test has been running.

Ping packets sent per
second, and data
transmitted per second
(shown in Megabits).

The lefthand side of the display shows packet counts and latency information:

•  Packets displays the number of packets sent, the number of those packets for
which responses were received, and the number that timed out before a
response was received.

•  Latency displays the minimum, maximum, and average latency (measured
round-trip times) for all transmissions, measured in milliseconds.

The righthand area provides a graphic representation of the number of packets
transmitted per second (left), and the total amount of data in those packets
(measured in Mbps (Megabits per second, shown right).

The toolbar lets you stop/start the transmission of messages, or open the dialog
box used to specify the test properties (described above):

Click to begin transmission of
ping messages using the
current set of test properties.

Click to stop message transmission.

Click to change the test properties.

If you stop transmission of ping messages (or the transmission ends
automatically), the elapsed-time field stops counting.  You can retransmit the
messages any number of times by simply clicking the Start button.  The elapsed-
time field resets itself after a restart, as do the statistics and graphics (right).
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Menu Commands

As necessary, use the menu commands as follows:

Table 11.  Ping Generation Menu Commands and Toolbar Buttons

Menu Command Button Used to…

File
Exit — Exit from the Ping Generation test window.

View
Toolbar — Toggle display of the toolbar.

Status Bar — Toggle display of the status bar (bottom of window).

Ping
Start Start transmission of ping messages.  When you do this, the

elapsed-time counter (bottom right) becomes active, allowing
you to track the time since transmission began:   The Stop
button is also enabled, allowing you to stop transmission at
any time.

Stop Stop transmission of ping messages.  When you click this
button, the Start button is enabled, allowing you to restart the
same set of messages.

Properties Open the dialog box used to specify ping-test properties.

Help — Display online Help and/or general information about the
Ping Generation tool.
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Chapter 12

Using QoSMeter

QoSMeter is an analysis tool designed to test the quality of service on a particular
virtual circuit.  Using QoSMeter, you first define the set of tests you want to run.
Each set of tests comprises a session.  The tests in a session are identical, and are
defined in terms of the amount of data to send (test size), the percent of
bandwidth to use when transmitting the test, and the percent of bandwidth
committed to background traffic.

Next you run the session, transmitting test traffic from your analysis device,
across a virtual circuit, then back to the same (or another) analysis device.  You
(or another user) can monitor the test traffic as it’s received.

QoSMeter supports two types of sessions:   

•  Constant Bit Rate (CBR) sessions transmit and analyze data.  The data
travels out through the virtual circuit, then back to either the same or a
different analysis device.  QoSMeter measures various statistics, with an
emphasis on variation in cell delay.

•  Round-Trip Delay (RTD) sessions transmit data from the sending device
through the virtual circuit, then back to the same analysis device.  QoSMeter
measures statistics with an emphasis on the latency of data transmission.

QoSMeter requires one set of parameters for data transmission (known as
generation parameters), and one for analysis at the receiving end (known as
analysis parameters).  For RTD tests, you always combine the generation and
analysis parameters in a single session definition.  For CBR tests, you have the
choice of defining them separately or together.

•  The generation component of the session specifies the VCC over which to
transmit the session, the size of each test, and the percent of bandwidth to use
for test vs. background traffic.  It also specifies the frequency at which to run
the tests in the session (e.g., once every half hour, twice daily, etc.), and
specific tolerance levels for failure.

•  The analysis component of the session specifies the VCC over which to
receive the session traffic, and specific tolerance levels for failure.  It can
also include specific settings that match or restrict those of the actual session
being received.  In the absence of these specifications, the analysis end of the
session auto-detects session traffic as it enters the analysis device.
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When you run the session, QoSMeter lets you monitor the results as it proceeds.
There are three tabs in the monitor display, respectively used to:

1. Summarize the results of the session (current, average, best, and worst for
each of several statistics).

2. List specific counts and rates for each test.

3. Graph the number of cells per Cell-Delay Variation (for CBR sessions) or
per Round Trip Delay (for RTD sessions), for one or more tests.

If desired, you can save session results for later review.   

12.1  Getting Started
Click the QoSMeter button to initiate this feature of the system.  This opens
the QoSMeter monitoring window, with the Properties display in front of it:

Click on each tab, in turn, to define the properties appropriate for your session.
The remaining sections describe how to define (or edit) and run a session:

•  Section 12.2  Defining a Constant Bit Rate (CBR) Session, describes how to
define a new Constant Bit Rate session.

•  Section 12.3  Defining a Round-Trip Delay (RTD) Session, describes how
to define a new Round-Trip Delay session.

•  Section 12.4  Running a Session, tells how to run and monitor a session.

QoSMeter
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Menu and Toolbar Commands

At any point, you can return to the main QoSMeter display and use the menus/
toolbar as described below.  Shaded items apply only when running a session.

Table 12.  QoSMeter Menu Commands and Toolbar Buttons.

Menu
Command Button Used to…

File
New Define a new QoSMeter session.

Open Open the results of a session that was saved previously.

Save Save the most recent set of results.  Use the standard Save dialog
box to assign a name to the results, using the format name.qos.  If
you omit the suffix, QoSMeter assigns it correctly.  Session
results can be stored anywhere, but typically reside in the \qos
directory.

recent-file list — List of the most recently opened session results.

Exit — Exit from QoSMeter.

View
Auto Update
Graph

— Revise the graph continuously as the session runs, always using
two sets of values: those for the overall average of all tests, and
those for the current test.

Graph
Selected Tests

— Graph the results of selected tests, showing the results of each
test individually, and the overall average of all selected tests (or
the average of all tests run so far, if you only select one test to
graph).  Applicable after selecting one or more tests to graph.

Toolbar — Toggle display of the system toolbar.

Status Bar — Toggle display of the status bar (bottom of window).

QoS
Start Begin transmission of the session data.  After you start the

session, the elapsed-time counter becomes active, allowing you
to track the time since testing began.  The Stop button is enabled,
allowing you to stop transmission at any time.

Stop Stop the session (only available during execution).  When you
click this button, the Start button is enabled, allowing you to
restart the same session.

Properties Open the dialog box used to view/modify the session properties.

Help — Display standard Windows Help, technical information about the
product, or general product information.
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12.2  Defining a Constant Bit Rate
(CBR) Session

With a Constant Bit Rate (CBR) session, the data travels out through the virtual
circuit, then back to either the same analysis device or a different analysis device.
QoSMeter measures various statistics, including the number of cells sent and
received, the number whose data is good or bad, and variations in cell delay.

Type of session (select
CBR in this case).

Mode of operation for
the session: generation
and/or analysis.

To define a Constant Bit Rate session, first select that type of test at the top of the
General Tab, then select the operation mode you want:

•  Generation (send tests only).

•  Analysis (receive tests only).

•  Generation and Analysis (send and receive tests using the same analysis
device).

Then:

•  Use the rest of the General tab to define general settings, separately for
generation and analysis purposes (VPI/VCI, device to use, etc.).

•  Use the Traffic Pattern tab to specify the size of your test data stream
(remember that each session comprises one or more tests), the percent of
bandwidth to use to transmit the test, and any background traffic you want to
run simultaneously with the test data.

•  Use the Options tab to specify various options that apply for test execution
and/or analysis.  For example, on the execution side, you’ll use this tab to
specify the number of times to transmit the test, and the interval between the
start of one test and the start of the next test.  On the analysis side, you’ll use
it to specify such limits as the CDV tolerance.

The sections that follow detail these tabs further.  When you’re through with all
three tabs, click OK to start the session.
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General Tab Settings

The General tab looks like this:

Click the different tabs to
define specifications
relating to session
generation and/or analysis.

Device from which to
transmit the session.

VCC over which to
transmit the session.

Mark to analyze traffic
received over the same
VCC (only applicable if
Operation Mode specifies
Generation and Analysis). Click when you’re through with the definition (including

theTraffic Pattern and Options), to run the session.

Click to specify
device properties.

If you haven’t already done so, use the area at the top to specify the:

•  Type of session (CBR in this case).

•  Mode of operation:  Generation, Analysis, or Generation and Analysis, as
described on page 188.

Then fill in the generation and analysis specifications, as described below.

Generation Settings

For Generation and Generation and Analysis-type sessions, click the Generation
tab and specify the:

•  Device from which to transmit the session traffic.

If you want to configure the device, click the Properties button to the
right of this drop-down list.  If you’re transmitting test data, the device
must be configured for end-station mode.  You might also use this
feature to define the type of framing to use (SONET vs. SDH, etc.), or other
settings appropriate to the type of device you’re using.  Refer to Chapter 4
for instructions to configure the device, as necessary.

•  VPI/VCI over which to transmit the session.

•  Whether to use the same VPI/VCI for analysis (applicable only in
Generation and Analysis mode).  Mark the check box to analyze session
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traffic coming in over the same VCC as the one you’re using to transmit;
otherwise (to use a different VCC), unmark the check box.

If you mark this box, QoSMeter disables all fields on the Analysis tab
(described next).

Analysis Settings

Device over which to receive
and analyze the session
data.

VCC over which to
receive the session
data.

Click when you’re through with the definition (including
theTraffic Pattern and Options), to run the session.

For Analysis and Generation and Analysis type sessions, click the Analysis tab
and specify the following information.  If you marked the Use the Same VCC for
Analysis box in the Generation tab, these fields are pre-filled and cannot be
changed.

•  Device on which to receive and analyze session data.  For Generation and
Analysis mode, this field is disabled and always specifies the sending device.

•  VPI/VCI over which to receive the incoming session data.

•  If you’re running in Analysis mode only (vs. Generation and Analysis),
there’s one additional field:

Use this field to specify the channel over which to receive the incoming data:
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Selection Receives Data Over…

1 Channel 1.

2 Channel 2.

Auto Detect Channel determined automatically by the analysis device.

Traffic Pattern Settings

The Traffic Pattern tab looks like this:

Size of each test.

Click when you’re through with the definition (including
General and Options tabs), to run the session.

Click the different  tabs
to define specifications
relating to test or
background traffic.

Bandwidth to use for test traffic,
specified by shifting the slider or
entering one of the three numbers
shown.

Total percent of bandwidth
committed, for both test and
background traffic combined.

Use the area at the top to specify the maximum size of the test, in the range 1–49
megabits (where 49 Mb corresponds to 127,604 cells).  Then fill in the test and
background traffic specifications, respectively to define the bandwidth
committed to test and background traffic.  The analysis device calculates session
results based only on the test traffic, and the Test Size refers to the traffic
transmitted via the bandwidth assigned for test traffic.  Any background traffic
you define simply adds to the load, making the test more realistic.

The field at the bottom reflects the Total Committed Bandwidth, and combines
the test and background specifications.

This tab applies in Analysis mode as well as Generation mode.  In Analysis mode
(and Generation and Analysis mode), it tells the analysis device exactly what to
expect, thus enabling QoSMeter to compile the most accurate set of statistics
possible.

If you’re running in Analysis mode only, an additional field appears at the top of
this tab:
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Mark if you want
622Vu Advisor to
identify test traffic
automatically.

If you mark this field (it defaults to marked), all other fields on the tab are
disabled, for both test and background information.  QoSMeter auto-detects the
test traffic in this case.

Defining Test Traffic

Click the Test Traffic tab and specify the percent of total bandwidth used to
transmit the test.  This, in combination with the maximum test size, determines
how long each test takes to run.

Specify the bandwidth as a percent of total available bandwidth, using either the
slider (right) or one of the three fields shown (Percentage, Cells/Sec, or Bits/Sec).
All numeric values are in decimal format.

Defining Background Traffic

List of VCCs over which
to transmit background
traffic, and the percent of
total bandwidth to commit
to each.

Click when you’re through with the definition
(including General and Options tabs), to run the test.

Click to add background
traffic over a new VCC.

Click to remove the
selected VCC (and its
associated background
traffic).

Click the Background Traffic tab to specify any traffic you want to run
simultaneously with the test data.  Specify this background traffic as a percent of
bandwidth to use for traffic sent over one or more specific VCCs (up to 16 VCCs
total).  Use the buttons to the right to add and remove VCC specifications:
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•  Click the Add button to add a new VCC.
This opens the window shown to the right:

Fill in the VPI/VCI to specify the channel
over which to transmit background traffic,
and the bandwidth to commit to traffic
sent over that VCC.  Specify the
bandwidth as a percent of total available
bandwidth, using either the slider (right)
or one of the three fields shown
(Percentage, Cells/Sec, or Bits/Sec).  All numeric values are in decimal
format.

•  Select a VCC and click the Remove button to delete it.

Options

The Options panel has two tabs:

•  The Execution tab applies for all modes of operation.

•  The Analysis tab applies for Analysis mode and Generation and Analysis
mode.

The discussion below is broken down to cover each mode of operation
separately.

Generation (only) Mode Settings

When running in Generation mode,
there is only one tab in the Options
panel:

Use the Execution tab to specify:

•  Whether to transmit the test
continuously, or only a specified
number of times.

The number of times to transmit the test
during the session (applicable if the
Continuous box is not checked).   

•  The amount of time from the start of
one test to the start of the next test.  If any one test takes longer than the time
specified, the next test starts immediately upon its completion.
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•  The number of acceptable failures;  that is, the number of failures after which
QoSMeter should discontinue testing.  This field is used for long-term
testing, and refers only to internal failures on transmission.

Analysis (only) Mode Settings

When running in Analysis mode, both tabs in the Options panel (Execution and
Analysis) establish settings used to analyze the data received.  (Remember that
an entirely different device is transmitting the session data.)

Execution Tab

Use the Execution tab to specify
options related to the execution of the
session on the analysis device.

•  Whether to receive the test
continuously or only a specified
number of times.

•  The number of tests to analyze
(applicable if the Continuous box is
not checked).

•  The amount of time from the start of
(receipt of) one test to the start of the
next test.  If a test takes longer than the specified time, the receiving device
skips the next iteration of the test.

•  The number of acceptable failures;  that is, the number of tests for which it’s
acceptable to receive no data.

Note:  If you’re analyzing a session and see one failure after another, it’s likely that the
sending device hasn’t started the session yet.
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Analysis Tab

Use the Analysis tab to specify:

•  The maximum acceptable
percentage of errored cells.  This is
the highest percent of cells that can
show up as errored in any single
block, before the block is marked as
severely errored.  (The detailed
statistics for the test include Cells
Errored and Blocks Errored fields.)

•  The maximum acceptable variation
in cell-delay times (CDV).  This is the maximum acceptable amount of delay
between the arrival of any two sequential cells.  If the delay exceeds the
number of microseconds specified here at any point in time, the session
continues to run, but the analysis device increments two statistics:  Cells with
Bad CDV and Late Cells.

•  The maximum amount of time to wait for the arrival of the initial cells in any
given test, before the session times out.  Specify this time-out value either as
Infinite (no timeout) or a number of seconds.

Generation and Analysis Mode Settings

When running in Generation and Analysis mode, there are two tabs in the
Options panel.

•  The Execution tab defines options related to execution of the session, and is
specified exactly the same as the Execution tab for Generation (only) mode
sessions.  Refer to Generation (only) Mode Settings (page 193) for
instructions to fill in this tab.

•  The Analysis tab defines options related to the receipt and analysis of session
data, and is specified exactly the same as the Analysis tab for Analysis (only)
mode sessions.  Refer to Analysis Tab (page 195), for instructions to fill in
this tab.
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12.3  Defining a Round-Trip Delay
(RTD) Session

Type of session
(select Round Trip
Delay in this case).

With a Round-Trip Delay (RTD) session, data travels from the sending device,
out through the network over a preconfigured VPI/VCI, then back to the same
analysis device.  QoSMeter measures the latency of transmission, and provides
average, best, and worst latency statistics.

To define an RTD session, first select that type of test at the top of the General
Tab.  Then:

•  Use the rest of the General tab to define general settings, separately for
generation and analysis purposes (VPI/VCI, device to use, etc.).

•  Use the Traffic Pattern tab to specify the size of your test data stream
(remember that each session comprises one or more tests), the percent of
bandwidth to use to transmit the test, and any background traffic you want to
run simultaneously with the test data.

•  Use the Options tab to specify various options that apply for test execution
and/or analysis.  For example, on the execution side, you’ll use this tab to
specify the number of times to transmit the test, and the interval between the
start of one test and the start of the next test.  On the analysis side, you’ll use
it to specify such limits as the CDV tolerance.

The sections that follow detail these tabs further.  When you’re through with all
three tabs, click OK to start the session.
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General Tab Settings

The General tab looks like this:

Click the different tabs to
define specifications
relating to session
generation or analysis.

Mark to analyze
traffic received over
the same VCC.

Device from which to
transmit the session.

VCC over which to
transmit the session.

Click when you’re through with the definition (including
theTraffic Pattern and Options), to run the session.

If you haven’t already done so, use the area at the top to specify the type of
session (Round-Trip Delay in this case).  Then fill in the generation and analysis
specifications, as described below.

Generation Settings

Click the Generation tab and specify the:

•  Device from which to transmit the session traffic.

If you want to configure the device, click the Properties button to the
right of this drop-down list.  The device must be configured for end-
station mode (to allow it to transmit data).  You might also use this
feature to define the type of framing to use (SONET vs. SDH, etc.), or other
settings appropriate to the type of device you’re using.  Refer to the Chapter
4 for instructions to configure the device, as necessary.

•  VPI/VCI over which to transmit the session.

•  Whether to use the same VPI/VCI for analysis.  Mark the check box to
analyze session traffic coming in over the same VCC as the one you’re using
to transmit;  otherwise (to use a different VCC), unmark the check box.

If you mark this box, QoSMeter disables all fields on the Analysis tab
(described next).
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Analysis Settings

Device over which to receive
and analyze the session
data.

VCC over which to
receive the session
data.

Click when you’re through with the definition (including
the Traffic Pattern and Options), to run the session.

Click the Analysis tab and specify the VPI/VCI over which to receive the
incoming session data.  If you marked the Use the Same VCC for Analysis box in
the Generation tab, this field is pre-filled and cannot be changed.    

Traffic Pattern Settings

The Traffic Pattern tab looks like this:

Size of each test.

Click when you’re through with the definition (including
General and Options tabs), to run the session.

Click the different tabs to
define specifications
relating to test or
background traffic.

Bandwidth to use for test traffic,
specified by shifting the slider or
entering one of the three numbers
shown.

Total percent of bandwidth
committed, for both test and
background traffic combined.

Use the area at the top to specify the number of cells in the test, in the range 1–
127,604.  Then fill in the test and background traffic specifications, respectively
to define the bandwidth committed to test and background traffic.  The analysis
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device calculates session results based only on the test traffic, and the Test Size
refers to the traffic transmitted via the bandwidth assigned for test traffic.  Any
background traffic you define simply adds to the load, making the test more
realistic.

The field at the bottom reflects the Total Committed Bandwidth, and combines
the test and background specifications.

Defining Test Traffic

Click the Test Traffic tab and specify the percent of total bandwidth used to
transmit the test.  This, in combination with the maximum test size, determines
how long the test takes to run.

Specify the bandwidth as a percent of total available bandwidth, using either the
slider (right) or one of the three fields shown (Percentage, Cells/Sec, or Bits/Sec).
All numeric values are in decimal format.

Defining Background Traffic

List of VCCs over which to
transmit background traffic,
and the percent of total
bandwidth to commit to each.

Click when you’re through with the definition (including
General and Options tabs), to run the session.

Click to add background
traffic over a new VCC.

Click to remove the
selected VCC (and its
associated background
traffic).

Click the Background Traffic tab to specify any traffic you want to run
simultaneously with the test data.  Specify this background traffic as a percent of
bandwidth to use for traffic sent over one or more specific VCCs (up to 16 VCCs
total).  Use the buttons to the right to add and remove VCC specifications:
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•  Click the Add button to add a new VCC.
This opens the window shown to the right:

Fill in the VPI/VCI to specify the channel
over which to transmit background traffic,
and the bandwidth to commit to traffic
sent over that VCC.  Specify the band-
width as a percent of total available
bandwidth, using either the slider (right)
or one of the three fields shown
(Percentage, Cells/Sec, or Bits/Sec).  All numeric values are in decimal
format.

•  Select a VCC and click the Remove button to delete it.

Options

There are two tabs in the Options panel.  The Execution tab defines options
related to transmission of the session, while the Analysis tab defines options
related to the receipt and analysis of the session.

Use the Execution tab to specify:

•  Whether to transmit the test data
continuously, or only a specified
number of times.

•  The number of times to transmit the
test data (applicable if the
Continuous box is not checked).

•  The amount of time from the start of
one test to the start of the next test.

•  The number of acceptable failures;
that is, the number of failures after
which QoSMeter should discontinue testing.  This field is used for long-term
testing, and refers only to internal failures on transmission.

12:  Using QoSMeter
12.3  Defining a Round-Trip Delay (RTD) Session

200



Use the Analysis tab to specify:

•  The maximum acceptable
percentage of errored cells.  This is
the highest percent of cells that can
show up as errored in any single
block, before the block is marked as
severely errored.  (The detailed
statistics for the test include Cells
Errored and Blocks Errored fields.)

•  The maximum acceptable variation
in cell-delay times (CDV).  This is
the maximum acceptable amount of
delay between the arrival of any two sequential cells.  If the delay exceeds
the number of microseconds specified here at any point in time, the session
continues to run, but the analysis device increments two statistics:  Cells with
Bad CDV and Late Cells.

•  The maximum amount of time to wait for the arrival of the initial cells in any
given test, before the session times out.  Specify this time-out value either as
Infinite (no timeout) or a number of seconds.

12:  Using QoSMeter
12.3  Defining a Round-Trip Delay (RTD) Session

201



12.4  Running a Session
The session monitoring window looks like this (shown for a Round-Trip Delay
session):

The content of this area
varies depending on
which tab you’re on.  This
tab presents a summary
of statistics for the current
iteration of the test, with
average, best, and worst
values for each statistic
shown to the right.

Amount of time the test has been running.

Count of test iterations that
succeeded and failed thus far.

Device used to transmit
the test, and the type of
test you’re monitoring.

There are three tabs in this display.  Click the one you want to see:

•  Summary (illustrated above) lists the same statistics you’ll see in the Details
tab, but shows only the current test (left);  and the average, best, and worst
value for each statistic.

•  Details lists every available statistic for each test:  one row per test.

•  Graph presents a bar graph showing either Cell-Delay Variation (for a CBR
session) or Round-Trip Delay (for an RTD session), for one or more tests.
Before selecting the Graph tab, either:
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⇒  Select those tests you want to graph from the Details display, then
choose Graph Selected Tests from the View menu.  This results in a
graph of only the selected tests, plus one set of results showing the
average of all the selected tests (or, if you only select one test, the
average of all tests run so far in the session).  It’s a good idea to disable
the Auto Update Graph capability when you graph selected tests.

⇒  Choose Auto Update Graph from the View menu.  This results in a
graph that’s revised continuously, and that has two sets of numbers:
those showing the overall average of all tests, and those for the current
test.

Toolbar and Menu Commands

The toolbar lets you start/stop transmission of the session, or open the dialog box
used to specify the session properties.  (Use of this properties dialog box is
described in Section 12.2  Defining a Constant Bit Rate (CBR) Session (starting
on page 188) and Section 12.3  Defining a Round-Trip Delay (RTD) Session
(starting on page 196).

Click to begin transmission of the
session using the current properties.

Click to stop the session.
Click to view/modify the
session properties.

If you stop the session (or it ends automatically), the elapsed-time field stops
counting.  You can retransmit the session any number of times by simply clicking
the Start button.  The elapsed-time field resets itself after a restart, as do the
statistics and graphs.

Other menu commands let you open a previously saved session, save the current
session, graph displayed information, etc.  Refer to page 187 for a complete list
of menu and toolbar commands.

The rest of this section describes specific information available on the monitoring
display, first for Constant Bit Rate sessions, then for Round-Trip Delay sessions.
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Constant Bit Rate (CBR) Sessions

The following sections describe the Summary, Details, and Graph tabs for CBR
sessions.

Summary Tab

The CBR Summary display gives an overview of the tests run so far:

It shows the average, best, worst, and current test results for the following
statistics:

Statistic Description

Cells Transmitted Number of cells transmitted by the test.

Cells Received Number of cells received by the test, including errored and late cells.

Cells Lost Number of cells transmitted but not received.

Cell Loss Ratio Ratio of Cells Lost / Cells Transmitted.

Good Cells Number of cells arriving on time (i.e., within the specified CDV) and
with good data (i.e., having a good CRC (checksum) and arriving in
sequence).

Late Cells Number of cells received late (can include errored cells).  This is the
number of cells that exceeded the CDV Tolerance specified in the
session properties (Options tab).
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Statistic Description

Cells Succeeded Number of non-errored cells received by the test (can include late
cells).

Cells Errored Number of cells arriving with a bad CRC (checksum).

Cell Error Ratio Ratio of Cells Errored / Cells Received.

Cells Misinserted Number of times a cell arrived in an unexpected sequence.

Cell Misinsertion Ratio Ratio of Cells Misinserted / Cells Transmitted.

Cells Per Block Number of cells in each block.

Number of Blocks Number of blocks received.

Blocks Errored Number of blocks for which the percent of errored cells exceeded the
Maximum Errored Cells percentage specified on the Options tab.

Severely Errored Cell
Block Ratio

Ratio of Blocks Errored / Number of Blocks.

Cells with Bad CDV Number of cells for which the arrival time exceeded the CDV
Tolerance specified (Options tab, Analysis settings) by the test
properties in either direction (i.e., making the cell either too early or
too late).

Time Elapsed Elapsed time from the start of the test to completion of the test, in
milliseconds.

Details Tab

The CBR Details tab looks like this:

It includes one line for each test, for the most recent execution of the session.
The left-most two columns identify the test (Test column), and the date/time the
first data was received for that test (Date and Time column).  The remaining
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columns show the same statistics (in the same order) as described for the
Summary tab.  These statistics are described starting on page 204.

Graph Tab

The Graph looks like this for a CBR session:

Each different color corresponds to a single test, with the left-most bar (within
each set) showing the average for all tests shown.  In this example, of the 2,604
cells transmitted by each test, approximately 2600 had a CDV of zero
microseconds, and the rest had a CDV of 10 microseconds.

You can display the exact number of cells that fall into each category for a
specific test, by positioning the mouse on the corresponding column.  This is
illustrated above for the Average column to the left.
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Round-Trip Delay (RTD) Sessions

The following sections describe the Summary, Details, and Graph tabs for
Round-Trip Delay sessions.

Summary Tab

The Round-Trip Delay Summary display gives an overview of the tests run so
far:

It shows the average, best, worst, and current test results for the following
statistics:

Statistic Description

Cells Transmitted Number of cells transmitted by the test.

Cells Received Number of cells received by the test, including errored and late cells.

Cells Lost Number of cells transmitted but not received.

Cell Loss Ratio Ratio of Cells Lost / Cells Transmitted.

Good Cells Number of cells arriving on time (i.e., within the specified CDV) and
with good data (i.e., having a good CRC (checksum) and arriving in
sequence).

Good Round Trip Delay Number of cells arriving that pass these tests:
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Statistic Description
Cells •  CRC (cell contains good data).

•  unscrambling (unscrambled successfully).

•  integrity (cell retains its original signature after unscrambling).

Late Cells Number of cells received late (can include errored cells).  This is the
number of cells that exceeded the CDV Tolerance specified in the
session properties (Options tab).

Cells Succeeded Number of non-errored cells received by the test (can include late
cells).

Cells Errored Number of cells arriving with a bad CRC (checksum).

Cell Error Ratio Ratio of Cells Errored / Cells Received.

Cells Misinserted Number of times a cell arrived in an unexpected sequence.

Cell Misinsertion Ratio Ratio of Cells Misinserted / Cells Transmitted.

Cells Per Block Number of cells in each block.

Number of Blocks Number of blocks received.

Blocks Errored Number of blocks for which the percent of errored cells exceeded the
Maximum Errored Cells percentage specified on the Options tab.

Severely Errored Cell
Block Ratio

Ratio of Blocks Errored / Number of Blocks.

Cells with Bad CDV Number of cells for which the arrival time exceeded the CDV
Tolerance specified (Options tab, Analysis settings) by the test
properties in either direction (i.e., making the cell either too early or
too late).

Round-Trip Delay
(microseconds)

Round-trip delay, in microseconds.

Time Elapsed Elapsed time from the start of the test to completion of the test, in
milliseconds.
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Details Tab

The Round-Trip Delay Details tab looks like this:

It shows one line for each test, for the most recent execution of the session.  The
first five columns are described below.

Statistic Description

Test Number to identify this test within the session.

Date and Time Date and time the first data was received for this test.

Average RTD Average round-trip delay for all cells received (in microseconds).

Best RTD Lowest round-trip delay for all cells received (in microseconds).

Worst RTD Highest round-trip delay for all cells received (in microseconds).

The remaining columns show the same statistics (in the same order) as described
for the Summary tab, with one exception:  there’s no Round-Trip Delay field in
the Details tab.  (This field is replaced by the three Round-Trip Delay fields
described above.)

Refer to page 207 for a detailed description of these statistics.
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Graph Tab

The Graph looks like this for a Round-Trip Delay session:

Each different color corresponds to a test, with the left-most bar (within each set)
showing the average for all tests shown.  Here we’re looking at four different
tests.  All 2,000 cells transmitted by those tests had a Round Trip Delay in the
range 19 – 28, with most showing an RTD of 23 or 26.

You can display the exact number of cells that fall into each category for a
specific test, by positioning the mouse on the corresponding column (illustrated
above for Test 15 in the 20-microsecond RTD columns).
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Appendix A

Glossary

622Vu Advisor  The user interface to the CellCommand OLE Automation server.  This interface
program provides all the capabilities outlined in this Agilent 622Vu Advisor User’s Guide.

622Vu Undercradle  The Agilent Advisor undercradle analysis device.  Comprises the logic used
to send, receive, and analyze ATM traffic as directed by your scripts, ping messages, and
QoSMeter sessions.

AAL  See ATM Adaptation Layer.

Adaptation Layer  See ATM Adaptation Layer.

Arrival Time Applies to the capture window.  Format is hh:mm:ss.nnnnnnnnn, shown to a
resolution of 33 ns.  Initially displays relative to the start of the capture, but can be changed
via the View menu, to display a delta time between cells; or via the Edit menu, to establish a
particular cell as a baseline from which all other (relative) times are measured.

ATM  Asynchronous Transfer Mode — Group of communications protocols that support a wide
range of bit rates using a form of cell networking that transmits data in 53-byte cells.  ATM
allows integration of voice, data, and video transmissions, and is the most widely studied form
of cell networking.  It was initially developed by the CCITT and its successor, the ITU, as the
underlying form of transmission for B-ISDN.  Subsequently, a group called the ATM Forum
has taken over some of the ATM design in an effort to provide standards that were lacking in
the CCITT version.

In this context, the term asynchronous refers to the fact that cells from any one source don’t
have to be spaced (within the data stream) at a set position within a recurring frame (as is
common in circuit switching).  

ATM Adaptation Layer  Layer of ATM protocols responsible for packaging data into cells,
then reassembling it at the receiving end — that is, for adapting datagrams, voice samples, and
video frames into a format that can be handled by ATM.  The individual protocols used in this
layer are referred to as AALs.  As specified by the ITU, there are currently four AALs used to
package and reassemble normal traffic:  

•  AAL1 supports connection-oriented services that require a constant bit rate, and have
specific timing and delay requirements.

•  AAL2 supports connection-oriented services that don’t require a constant bit rate;  i.e.,
variable bit-rate services such as some video schemes.

•  AAL3/4 supports variable bit-rate transmissions that don’t require a bounded delay from
source to destination (connectionless and connection-oriented).

•  AAL5 is a simpler (and connection-oriented) version of AAL 3/4, suitable for most data
transmissions.  Its simplicity comes at the expense of automatic error recovery and built-
in retransmission.

The ATM Forum is working on AAL 6, which will support a specific type of video-stream
transmission known as MPEG2.

Each AAL is divided into two parts:  an SAR (Segmentation and Reassembly) sublayer and a
Convergence Sublayer (which itself comprises two separate sublayers).  Beyond this brief
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explanation, the specifics of these protocols are outside the scope of this manual;  suffice it to
say that Agilent Technologies complies with the latest AAL standards.

ATM Forum  Worldwide organization, founded in 1991 for the purpose of promoting ATM
within the industry and the end-user community.  The ATM Forum has taken over some of the
ATM design from the ITU (formerly the CCITT), in an effort to provide standards that were
lacking.  The ATM Forum has grown tremendously, and now includes a large assortment of
communications and computer industries, government agencies, resource centers, and private
users.

BadHec buffer  Applicable with filtersets defined as using filter entries.  Required buffer used to
store cells detected as having a bad HEC.  (There can be up to 1023 additional buffers.)  You
can’t specify filter entries for a BadHec buffer, although you can change its buffer-level
settings to restrict the size of the buffer, for example, or to control whether the buffer wraps
when it’s full.

bandwidth  Capacity of a circuit to carry data, generally measured in bits-per-second (bps) for
digital circuits.  The analysis device drives its connection to the ATM device at full bandwidth
(which varies depending on the type of physical connection used).

bps  Bits per second (speed of data transfer).

buffer  See filter buffer.

capture  Feature of 622Vu Advisor that lets you actually capture the traffic that comes in over one
or both channels of an analysis device, optionally saving the captured traffic on your PC.  You
might save a capture to review or process it later, or you may want to use the capture as a
script (or as the basis for a script).  Once you create a capture file, you can generate subsets of
that file, as necessary to accommodate your testing.

622Vu Advisor lets you limit the traffic you capture (generally to save storage).  You do this
by filtering the capture based on VCC, IP address, decode, or incoming channel.  You can also
use filters to control the way in which the traffic is captured (using a single buffer that wraps,
using several different buffers that don’t wrap, etc.).

There are three ways to define a filter:  through 622Vu Advisor’s standard filterset processor
(detailed in Chapter 8), while monitoring real-time statistics (detailed in Chapter 7), or using
the capture facility’s filterset wizard (described in Chapter 6).  In the latter two cases (real-
time stats and filterset wizard), you have the option of saving the filter definition, or
discarding it after a single use.  The approaches offer slightly different filtering capabilities, as
described in Table 3 (page 79).

CaptureAll buffer  The only buffer used when capturing traffic with a filterset that is defined as
capturing everything.  You can’t specify filter entries for a CaptureAll buffer, but you can
control its size and wrapping, and whether it captures idle cells or not.

CCITT  Comité Consultatif International Télégraphique et Téléphonique (or Consultative
Committee on International Telephone & Telegraph) — a committee initially designed to
develop international telephony (voice communications) standards, but whose responsibilities
evolved to include broader standards for communications equipment (equipment interfaces,
communications protocols, modem functions, etc.).  The CCITT has been replaced recently by
the International Telecommunications Union (ITU).  Many standards introduced by the
CCITT (and subsequently taken over by the ITU) are still considered CCITT standards.  The
ATM standards are among these.

cell  For purposes of 622Vu Advisor, a single 53-byte ATM cell comprising 5 header bytes and 48
bytes of data.

CellCommand  The OLE Automation Server that drives 622Vu Advisor’s host-side processing.
622Vu Advisor is one of several Windows applications you can use to pass requests to the
analysis device.  The mechanism used to communicate between these applications and the
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analysis device is known as OLE Automation.  This mechanism, developed by Microsoft, uses
state-of-the-art technology to ensure complete control over processing as well as efficient data
transfer.

You’ll use CellCommand to define transmit sequences (sets of cells), scripts, and QoSMeter
tests;  and to translate these definitions into direct function calls to the analysis device’s device
driver.  CellCommand is the only vehicle by which other Windows applications can pass
instructions or data to and from the analysis devices;  i.e., it’s the only code that can access the
analysis device’s device driver.    

CellCommand is implemented as:

•  an OLE 2 in-process server, meaning that it’s responsible for the complete imple-
mentation of its objects.  Automation clients can get everything they need from the DLL,
without going through another DLL.

•  an OLE 2 Automation object, allowing other applications (Visual Basic and C++ for
example) to dynamically discover and use its interfaces at run time.  This provides a form
of late binding to the interfaces, allowing each CellCommand object to describe its
capabilities to any tool dynamically, while letting that tool control the programming
environment — language, vendor, functions enabled, etc.

cell header  See header.

cell library  Repository for various 622Vu Advisor information:  sequence definitions, script
definitions, filterset definitions, QoSMeter test session definitions, etc.  622Vu Advisor can
manage any number of cell libraries, but only one library is open (active) at any given time.
Any changes made during processing are saved in the active cell library immediately.

All 622Vu Advisor processing requires that you have an active cell library.  Each library is a
complete entity, containing all the sequence and script definitions, filter buffers, filter entries,
etc., which are used together during processing.  (Only two types of information are stored
outside of the cell library, both for processing efficiency:  profile definitions and cell
captures.)

622Vu Advisor is distributed with several libraries, as detailed in Appendix C.  Within a given
cell library there are several distinct directories (one to store sequences, one to store scripts,
etc.).  Refer to Appendix D for a description of the library structure.

Cell Loss Priority  See CLP.

cell name  Name assigned to a particular cell, to identify it within its parent sequence.

cell networking  Technology involved in transmitting all data in small, fixed-length packets
(cells).  With cell networking, a sender breaks a data packet into cells before transmitting it
across the network to the receiver.  The receiver takes the cells and reassembles them to form
the packet.  Cell networking is also known as cell switching or cell relay.

The most common form of cell networking calls for 53-byte cells comprising a 5-byte header
and 48 bytes of data.  This is the size required by the ITU’s ATM standards.

cell property  Characteristics of a cell that are either defined or undefined at each of the cell
and/or sequence levels, but that are always considered defined at the script level.  These
characteristics include:
GFC — Generic Flow Control.

VPI — Virtual Path ID.

VCI — Virtual Channel ID.

PTI — Payload Type Indicator.

CLP — Cell Loss Priority.
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Force-HEC-state property — Indication of whether to force a HEC value before cell
transmission.

If a property is undefined at a particular level, its value is inherited from the containing object:

•  A property that’s undefined in a cell definition is inherited from the containing sequence
(if defined there) or script (if not defined at the sequence level).

•  A property that’s undefined in a sequence definition is inherited from the containing
script (then propagates down to any cells for which the property is undefined).

channel  Connection between two hosts.  A channel must be established before ATM cells can be
transmitted from one host to another.

channel identifier  28-bit identifier comprising a Virtual Path Identifier (VPI) and a Virtual
Channel Identifier (VCI).  Each ATM connection has one channel identifier, which is carried
in the cell header.  While the small size of this identifier makes hop-by-hop routing efficient, it
also means that you can’t use the identifier throughout the entire ATM network;  28 bits is
simply not large enough to guarantee a unique channel identifier across this ATM network.
(By comparison, ISO addresses range up to 160 bits in order to guarantee uniqueness.)      

ATM technology solves this problem by making the channel identifier dynamic from one hop
to the next, but static for any particular hop, and unique across all connections managed by the
two devices at either end of that hop.  When the signalling software first sets up a channel
(which happens before the first cell is sent through that channel), the two devices involved in
each hop determine a VPI/VCI setting that can be used for that hop.  Each device, then, needs
to know the incoming VPI/VCI (the channel identifier agreed upon with the previous device in
the network) and the outgoing VPI/VCI (the channel identifier agreed upon with the next
device in the network).  When it receives a cell, the device uses the incoming VPI/VCI values
as simple indexes into a routing table to determine the outgoing VPI/VCI values.  Then it
changes the identifiers before forwarding the cell.

Transmissions between the high-level provider networks (known as the ATM backbone
networks) typically only look at the VPI to route the cell correctly.  Very few (high-speed,
broadband) trunk links are needed to connect any one backbone device to its neighboring
devices, and the VPI contains sufficient information to forward the cell correctly between
these links.  Backbone networks that can route based only on the VPI only change the VPI
before forwarding the cell, effectively using an even smaller channel identifier than those that
need both the VPI and VCI.

Transmissions at the periphery of the ATM network — near the lowest-level connections (to
individual users or offices, for example) — generally require routing based on the VCI as well
as the VPI.

CLP  Cell Loss Priority — A one-bit cell-header field that, when set, indicates to the devices in the
ATM network that this cell can be dropped, if necessary, during periods of congestion.  Cells
for which the CLP is set will be dropped before cells having a zero value in the CLP.  There
are two ways the CLP can be set:  

•  By the sender, in cells used to fill up the bandwidth reserved for a connection.  Because
each ATM connection can have a guaranteed bandwidth, it’s important (for the sake of
efficiency) to use that bandwidth, even if the essential traffic doesn’t always fill it.  By
loading extra traffic into the network, the sender can make use of the full bandwidth;  but
by setting the CLP in the cells that carry that extra traffic, the sender can arrange for it to
be dropped before it interferes with essential traffic.

•  By the ATM network, if it detects the situation where the sender reserved less bandwidth
than is being used — for example, by asking for a 2 Mb/s connection then sending at 2.5
Mb/s.  In this case, the ATM standards allows for setting of the CLP bit in as many cells
as needed to reduce the priority (CLP = 1) traffic to the reserved amount.
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config.ini  .ini file used by 622Vu Advisor to configure the system at startup, and to determine
various processing preferences.

configuration #5  One of the possible configurations you can establish for a full-end station
analysis device, wherein incoming traffic on Channel 1 goes into the framer chip on the
analysis device and is monitored by 622Vu Advisor (and optionally captured).  The analysis
device transmits traffic over Channel 1.  This is the normal way to connect to a physical ATM
link in end-station mode, when capturing/transmitting on Channel 1.  Incoming traffic on
Channel 2 loops out over Channel 2 without being monitored.

configuration #6  One of the possible configurations you can establish for a full-end station
analysis device, wherein incoming traffic on Channel 1 loops out over Channel 1 without
being monitored.  Incoming traffic on Channel 2 goes into the framer chip on the analysis
device and is monitored by 622Vu Advisor (and optionally captured).  The analysis device
transmits traffic over Channel 2.  This is the normal way to connect to a physical ATM link in
end-station mode, when capturing/transmitting on Channel 2.

configuration #10  One of the possible configurations you can establish for an analysis device,
and always used for a monitor-only device.  With this configuration, 622Vu Advisor
automatically monitors the traffic coming in both channels, and retransmits all traffic over the
opposite channel from where it’s received.

connection-oriented  A term referring to the characteristic of ATM that requires an established
connection (channel) before a cell can be sent.  This minimizes the overhead involved in
routing traffic from one point to another, because each hop in the transmission only has to
remember how to get to the next point.

Convergence Sublayer (CS)  One of two sublayers in each AAL (ATM Adaptation Layer
protocol), as currently specified by the ITU.  The Convergence Sublayer is responsible for
managing the flow of data to and from the Segmentation and Reassembly sublayer.  (Looking
one step further, the CS actually comprises two component parts:  the Common Part
Convergence Sublayer and the Service Specific Convergence sublayer.  The specifics of these
sublayers are not detailed in this glossary.)  See ATM Adaptation Layer for more information.     

CRC  Cyclical Redundancy Check — Group of closely related mathematical algorithms used to
detect errors in a stream of bits.  The HEC (Header Error Control) computation is a form of
CRC, and verifies correct transmission of cell-data.  The PDU uses another form of CRC (this
in addition to the CRC (HEC) for each cell), but the specifics of this vary depending on the
type of PDU being sent.

To illustrate, the CRC formula used for an AAL3/4 stream is different from an AAL5:  in
AAL3/4, each cell payload has its own CRC, but in AAL5 only the last cell has a CRC, which
checks the entire PDU contents.

CS  See Convergence Sublayer.

datagram  One packet of information that’s routed through a network, including both the data
being passed from one host to another and the information necessary to deliver that data
safely.

Device Manager  Component of 622Vu Advisor that lets you configure analysis devices, and/or
monitor the physical interface between an analysis device and the ATM device under test.

DLL  Dynamic Link Library — A Microsoft Windows term referring to a support library for a
product or product set.

DS data rate  Digital Signal data rate:  a term referring to the rate of data transmission of a bit
stream across COAX cable (copper wire).  Agilent Technologies offers physical-interface
options that support DS3 (44.7362 Mb/s) and DS1 (T1).

end-station mode  One of two ways you can configure an analysis device (contrast monitor
mode).  In end-station mode, the 622Vu Advisor is a known, visible end station on the
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network, capable of transmitting ATM cells and ping messages, as well as monitoring and
capturing traffic as it’s received.

fiber optics  A type of signalling equipment capable of transmitting data through optical fiber
very fast (up to several Gb per second) over long distances, with low error rates.  Fiber-optic
cable provides a high bandwidth through which data is transmitted by modulating a light wave
through a specially engineered plastic or glass fiber.  Fiber optics have made gigabit networks
possible.

filter buffer  Subdivision of a filterset that's used to store one or more types of cells during
capture processing, where each type of cell is defined via a separate filter entry.  Each buffer
corresponds to a particular division of capture memory on the analysis device, and is assigned
a percentage of the total available capture memory.  You can divide capture memory evenly
across all buffers, or specify a certain percent of the available memory per buffer.  

All the cells stored in the various buffers are combined and sorted (by arrival time) before
being displayed;  the assignment of buffers through filtering has no effect on the capture
display.

filter entry  Lowest-level component within a filterset.  There can be one or more filter entries in
each filter buffer.  There’s a separate filter entry for each different type of cell you want to
capture in that buffer, and that entry provides specific instructions to 622Vu Advisor as to the
characteristics of the cell(s) you want to save (specific VCCs, specific GFC values, etc.).

filterset  Set of specifications that identify characteristics of the cells you want to keep during
capture processing.  Each capture can use, at most, one and only one filterset.  Each filterset is
defined as either capturing everything (i.e., all traffic), or as using filter entries.  Each filterset
divides the analysis device’s memory into receive areas (called filter buffers), and specifies
what type(s) of cells should go into each area (via filter entries).  A capture-everything filterset
has one buffer (CaptureAll).

Filtersets defined as using filter entries always have a buffer (BadHec) used to store cells
having a bad HEC, and can have any number of additional buffers, each with its own defini-
tion of content.  You can define how much memory to use for each buffer, and whether to
wrap buffer space.  You also indicate whether or not to capture idle cells at the filterset level.

firmware  Software running on the analysis device, used to drive its processing.

force-HEC-state property  Property of a cell that indicates whether to force a certain HEC
value before cell transmission.

Gb  Gigabit — Unit of measure generally used to specify the capacity (transmission rate) of a
connection to carry data;  specifically, 19 (one billion) bits.

GB  Gigabyte — Unit of measure generally used to specify memory or disk-storage capacity;
specifically, 19 (one billion) bytes.

General Switching Management Protocol  See GSMP.

Generic Flow Control  See GFC.

GFC  Generic Flow Control.  Four-bit field that’s carried in the cell header for purposes of flow
control;  that is, to determine how to multiplex the current cell with cells of other ATM
connections transmitted across a shared-access network.  The specifics of this field are still
undefined;  in fact, the logic of using these four bits for juggling priorities among ATM
connections is still being questioned.  Currently the GFC is always zeros.  Regardless of its
final specifications, the GFC’s value will only have local significance, and will be overwritten
in ATM devices, as necessary.   

gigabit networks  Networks capable of transmitting at speeds of one Gb per second or faster.
Refers to the term gigabit environment, introduced by Craig Partridge in his book “Gigabit
Networking” [1994 Addison-Wesley Publishing Company] to refer to “a computing milieu in
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which most of all of the components of a computer system are processing, storing, displaying,
or moving data at speeds exceeding 1 gigabit per second.”

GRC  Generic Reference Configuration.

GSMP  General Switching Management Protocol — A general-purpose protocol developed by
Ipsilon that’s used to control an ATM switch.  GSMP allows a controller to establish and
release connections across the switch;  to add and delete leaves on a point-to-point multi-point
connection;  to manage switch ports;  to request configuration information;  and to request
statistics.  During operation, GSMP sets up the connection between switches, establishes the
protocol used and the path (VCC) through which the switches will communicate, and then
passes control to IFMP to perform IP header compression (for TCP/IP cut-through switching).

header  5-byte cell header used by UNIs, NNIs, and ATM devices to route cell traffic.  The cell
header is formatted differently depending on whether the cell is being passed by a user to a
UNI, or from one provider network to another (via an NNI).  Each component of the header is
described separately in this glossary.

UNI cell header                                                NNI cell header

HEC  Header Error Check — An 8-bit cell-header field that’s computed over the five bytes in the
cell header, using a CRC algorithm.  The CRC polynomial (    x

8 + x 2 + x + 1) that computes the
HEC can correct a single bit error within individual ATM cells, and can also detect various
multiple-bit errors.       

host  Any computer that provides, or can provide, services over a network to another computer,
other than simple data storage and forwarding (as with a file server).

IFMP  Ipsilon Flow Management Protocol.  An IP switching protocol developed by Ipsilon that
handles compression of the IP header.  Specifically, IFMP allows a node to instruct an
adjacent node to attach a Layer-2 label to a specified IP flow.  The label allows more efficient
access to cached routing information for that flow.  The label can also enable a node to switch
further packets belonging to the specified flow at Layer 2 rather than forwarding them at
Layer 3.  622Vu Advisor lets you identify specific VCCs that should always be interpreted
(i.e., decoded) as IFMP traffic, as detailed under Specifying Decode Preferences on page 100.    

IISP  Interim Inter-Switch Protocol.  An early, simplified version of the PNNI (Private Network-
to-Network Interface) switch-to-switch signalling protocol, still widely used.  622Vu Advisor
lets you identify specific VCCs that should always be interpreted (i.e., decoded) as IISP
traffic, as detailed under Specifying Decode Preferences on page 100.

Interim Inter-Switch Protocol  See IISP.

Internet  A global internet connecting millions of computers (hosts) via the TCP/IP protocol suite.
There’s only one Internet (with an uppercase I) world-wide.

internet  Shortened form of internetwork — Any set of two or more networks that are connected
by a router, where communication between computers on different networks is facilitated by
consistent rules governing:  1) communications over the network — formatting, timing,
sequencing, etc. (known as a protocol), and  2) how to connect one type of network to another
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(e.g., Token Ring to Ethernet).  Unlike the global Internet, there are several protocols to
control traffic across internets:  OSI (Open Systems Interconnection), SNA (Systems Network
Architecture), Netware, DECnet, and TCP/IP are some of the more commonly used internet
protocols.

IP  Internet Protocol — The internetworking component of the TCP/IP protocol suite.  There are
clearly defined rules for sending IP over different types of networks.  Standards exist for
running IP over ATM networks.  To communicate over the Internet, a host sends an IP
datagram using the rules that apply for its local network (IP over Token Ring, for example, or
IP over Ethernet).  As necessary — that is, if the destination host is on another type of network
— the datagram is sent via a router that removes the source-network’s rules and applies the
rules for the target network.

IP is generally preferred to other internetworking protocols such as X.25, because it’s easier to
implement on local area networks (LANs).

Ipsilon Flow Management Protocol  See IFMP.

ISDN  Integrated Services Digital Network — A far-reaching CCITT (now ITU) standard that
deals primarily with issues relating to the total integration of voice and data signals.  (ISDN
involves other communications issues as well, but the current thrust involves this integration.)
One part of the ISDN standard, knows as B-ISDN (the B stands for Broadband), includes
standards related to switching technology for use with mixed voice (telephone), data, and
video networks.  ATM was initially developed by CCITT and its successor, the ITU, as part of
the B-ISDN standard.

ISO  International Organization for Standardization — A Paris-based organization that’s responsi-
ble for developing and publishing standards for many industries world-wide.  Within the
computer industry, there are ISO standards for many things, including data communications.

ITU  International Telecommunications Union.

Kb  Kilobit — A unit of measure generally used to specify the capacity (transmission rate) of a
connection to carry data;  specifically, 13 (one thousand) bits.

KB  Kilobyte — A unit of measure generally used to specify memory or disk-storage capacity;
specifically, 13 (one thousand) bytes.

Kbps  kilobits per second (speed of data transfer).

library  See cell library.

Management Information Base  See MIB.

Mb  Megabit — A unit of measure generally used to specify the capacity (transmission rate) of a
connection to carry data;  specifically, 16 (one million) bits.

MB  Megabyte — A unit of measure generally used to specify memory or disk-storage capacity;
specifically, 16 (one billion) bytes.

MIB  Management Information Base — File used when decoding SNMP or ILMI PDUs.  622Vu
Advisor uses the values in MIB files to convert MIB Object Identifiers (OIDs) to their textual
representation;  otherwise (without a MIB) 622Vu Advisor only shows OIDs in their
numerical form.

monitor mode  One of two ways you can configure an analysis device (contrast end-station
mode).  In monitor mode, the 622Vu Advisor passively observes the traffic flow coming
through it, optionally capturing some or all traffic for further analysis.

network  One or more ATM switching platforms under the same administration.  The network
can be public or private.

Network-to-Network Interface (NNI)  Type of connection between two provider ATM
networks, or two devices that reside wholly within a private network.  NNI functions solely to
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provide a smooth connection between the two devices.  It doesn’t protect one device against
problems in the other, but rather assumes that the two devices function correctly according to
the rules of the public or private network.  (In the case of NNI used on a provider network, it’s
assumed that the devices abide by current ATM standards.)

OAM  Operations, Administration, and Maintenance.

OC data rate  Optical Carrier data rate:  a term referring to the rate of data transmission of a bit
stream after being converted to optical signals, specified in conformance with SONET
standards.  Current OC transmission rates vary from 51.84 Mb/s, known as Optical Carrier
level 1 (OC-1), to 2,488.32 Mb/s, or OC-48.  In between are OC-3, OC-12/STM-4, and OC-
24.  The n designation specifies the number of level-1 (OC-1) circuits that could be at the data
rate:  OC-12/STM-4 carries 622.08 Mb/s (51.84 x 12), for example.  Visual Networks offers a
physical-interface option that supports OC-3 (155.52 Mb/s) and OC-12/STM-4, with future
plans to support OC-48 (although no ATM standards exist currently for OC-48 speeds).  See
also STS data rate, STM data rate.

OLE  Object Linking and Embedding — A Microsoft term used to refer to the capability of one
piece of software (e.g., CellCommand) to create objects that you include (embed) in other
systems (e.g., Visual Basic, C++, Excel, or 622Vu Advisor).

OLE Automation  Capability that applications (such as 622Vu Advisor) use to expose their OLE
objects to development tools that support OLE Automation — container applications such as
Visual Basic or C++, for example, or macro languages.  OLE Automation allows one program
to essentially operate another program;  specifically, allowing it to dynamically discover and
use the interfaces to the other program at run time.

OLE object  Piece of code that makes its functions available (i.e., exposes its functions) through
distinct function groups known as interfaces.

OSI  Open Systems Interconnection — One of several protocols commonly used to communicate
over an internet.  The OSI standard (an ISO standard itself) supports a seven-layer
communications protocol, where each layer is responsible for a specific type of activity (raw
signalling over the transmission media, data framing, placing on an internet, etc.).  This is well
documented in most data communications material.

Payload Type  Three-bit cell-header field that serves primarily to distinguish between user and
operations traffic (where operations traffic includes administration and management —
OAM).  The first bit is 0 for user data, 1 for OAM data.  

•  For user data (bit 1 is zero), the second bit is used to indicate whether the cell encoun-
tered any network congestion during the last hop:  0 indicates no congestion, 1 indicates
congestion.  The third bit is available to the user for any signalling purposes.

•  For OAM data (bit 1 is set), the specifics of use for the second and third bits are still not
finalized.  (Exceptions are Payload Type 111, which is reserved for future use, and 110,
which is reserved for future traffic-control and resource management.)

Payload Type Indicator  See PTI.

PC  For purposes of Agilent Technologies' product line, any "C or newer" model of the Agilent
Advisor.

PDU  Protocol Data Unit — The information unit of a particular communications protocol;  in the
case of ATM traffic, the collection of cells that make up a packet.  PDUs can be packaged
using any of several standard formats, as described under ATM Adaptation Layer.  The format
used varies depending on the type of data being sent and the medium over which it’s being
transmitted.

Physical Media Dependent sublayer (PMD)  Sublayer, within the physical layer, that
defines the transmitter, receiver, timing recovery, and channel specifications that facilitate a
connection to appropriate transmission media.
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PMD  See Physical Media Dependent sublayer.

PNNI  Private Network-to-Network Interface.  A switch-to-switch signalling protocol.  622Vu
Advisor lets you identify specific VCCs that should always be interpreted (i.e., decoded) as
using PNNI signalling or routing, as detailed under Specifying Decode Preferences on page
100.

point-to-multipoint connection  Collection of associated ATM virtual channel (VC) or virtual
path (VP) links that associate endpoint nodes through a simple tree topology, and that have the
following characteristics:

•  A single root link serves as the root.  When this root node sends information, all other
nodes on the connection (known as leaf nodes) receive copies of the information.

•  The current implementation of the signalling specification only supports zero return
bandwidth (i.e., from the leaf nodes to the root node).

•  The leaf nodes can’t communicate with each other directly, but can be connected via a
distributed implementation.

The current release does not support point-to-multipoint connection.

point-to-point connection  Collection of associated ATM virtual channel (VC) or virtual path
(VP) links that connect two endpoints.  The current version of the ATM Forum signalling
specification supports point-to-point virtual channel (VC) connections.

private UNI  User-Network Interface between terminal or endpoint equipment and a private
network.

profile  See user profile.

property  See cell property.

provider network  Any of several public networks that link ATM users together.  Local users
typically connect to their regional ATM provider network (possibly passing through one or
more private ATM networks first).  The regional provider networks connect to a higher level
(e.g., national) provider network, and so forth.  Communications between two provider
networks are facilitated through a network-to-network interface (NNI).  Communications
between a provider network and a user’s equipment (gateway, router, host, etc.) are facilitated
through a user-network interface (UNI).

PTI  Payload Type Indicator.  Same as Payload Type.

public UNI  User-Network Interface between terminal or endpoint equipment and a public
network.

Q.2931 [29]  The broadband signalling protocol standards that are currently under development to
support ATM connections at the user-network interface.  These standards have been
supplemented where necessary to support capabilities identified by the ATM Forum as
important for early deployment and interoperability of ATM equipment (primarily to support
point-to-multipoint connections, additional traffic descriptors, and private network
addressing).

QoSMeter test session  Analysis tool designed to test the quality of service on a particular
virtual circuit.  Using QoSMeter, you first define the set of tests you want to run.  Each set of
tests comprises a session.  The tests in a session are identical, and are defined in terms of the
amount of data to send (test size), the percent of bandwidth to use when transmitting the test,
and the percent of bandwidth committed to background traffic.

Next you run the session, transmitting test traffic from your analysis device, across a virtual
circuit, then back to the same (or another) analysis device.  You (or another user) can monitor
the test traffic as it’s received.
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Real-time statistics  Feature of 622Vu Advisor that’s available any time you’re not capturing
traffic actively.  Allows you to monitor real-time statistics for the link attached to an analysis
device, and to display the active network connections on the link.  Each time 622Vu Advisor
detects a new connection, it displays the corresponding VP/VC identifiers and begins tracking
statistics for that connection.  If you notice a problem while monitoring the statistics, you can
begin capturing any particular VCC(s) through a special filtering capability available via real-
time statistics.

SAAL  Signaling ATM Adaptation Layer (uses AAL5).

SAR  See Segmentation and Reassembly (SAR) sublayer.

SC  Sequence count, in the range hex 0–7 (specified during sequence definition when using AAL1
cell framing).

SCCP  Signaling Connection and Control Part.

script  Instructions that describe the transmission pattern you want to send out across an ATM
network.  A script sends cells in specific order, and each cell has a specific content, both in its
header and payload.    

Segmentation and Reassembly (SAR) sublayer  One of two sublayers in each AAL (ATM
Adaptation Layer protocol), as currently specified by the ITU.  On the sending end of ATM
transmissions, the SAR sublayer receives datagrams, video frames, etc., from the CS
(Convergence Sublayer), and is responsible for breaking that data into cell-sized pieces, then
mapping that data into the cell payloads of an ATM cell stream.  On the receiving end, the
SAR sublayer is responsible for retrieving data from the cell payloads and reassembling it into
its original form (datagrams, video frames, etc.), then forwarding that data to the CS.  See
ATM Adaptation Layer for more information.     

sender  Within the context of ATM, the host (computer) that initially sends a cell over the
network.  Also used to refer to the host user or application responsible for sending the cell.

sequence  Within 622Vu Advisor, a named set of cells that can be referenced as a single entity by
using the sequence name.  Each entry in the sequence comprises a:

•  cell name — a descriptive name.

•  repetition count specifying how many consecutive copies of the cell occur in that table
entry;  i.e., at this point in the containing sequence.

Before a sequence is transmitted, it’s expanded into one contiguous stream of cells (by using
the repeat counts), then it’s transmitted to the DUT as a single burst.

signaling software  Software responsible for enforcing the signalling (or setup) portion of the
ATM protocol suite.  Before ATM cells can be transmitted, the signalling software establishes
a connection between the sender and receiver, and assigns a channel identifier (VPI/VCI) to
the connection at each hop.  Signaling software resides in each ATM device, and somewhere
in the sender and receiver’s equipment.  Each device is responsible for contacting (and setting
up communication with) the next device in the path between the two hosts.     

SN  Serial number, in the range hex 0–F (specified during sequence definition when using AAL1
cell framing).

SNA  Systems Network Architecture — One of several protocol suites commonly used to
communicate over an internet, this one defined by IBM.

SNAP  Sub Network Access Protocol.

SNMP  Simple Network Management Protocol.  A tool that runs on top of IP to facilitate
standardized management of all types of network devices.  SNMP allows the Network
Manager to obtain a simple set of information about each device in the network.
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SONET  Synchronous Optical Network:  a form of fiber-optic data signalling that was first
defined in the U.S. and was later incorporated as part of a broader international set of ITU
standards known as SDH, or Synchronous Data Hierarchy.  (The SDH standards support
multiplexing over high-speed links.)

Three different terms are used to describe the SONET data-transmission standards: OC, STS,
and STM.  All three terms refer to the rate of data transmission and are described separately in
this glossary.

standard.lib  Default cell library.  Used to store all 622Vu Advisor definitions unless you define
another library(ies) for this purpose.

standard.prf  Default user profile.  Active when you first start 622Vu Advisor, and used until
you add your own profile.  On subsequent startups, 622Vu Advisor is initialized with the last
profile used.

SSCOP  Service Specific Connection Oriented Protocol.

STM  Synchronous Transport Mode.

STM data rate  Synchronous Transport Mode data rate:  a term referring to the rate of data
transmission for a bit stream, specified in conformance with SONET standards.  STM levels
correspond to OC and STS levels, but don’t support the lowest OC/STS rate of 51.84 Mb/s.
STM-1 (STM level 1), therefore, corresponds to OC-3/STS-3 and carries 155.52 Mb/s.  The n
designation specifies the number of level-1 (STM-1) circuits that could be encapsulated at the
data rate (always 3 times the number of OC/STS level-1 circuits):  STM-4, STM-8, and STM-
16 have the same data rates, respectively, as OC-12/STS-12, OC-24/STS-24, and
OC-48/STS-48 (currently the fastest data rate).  See also OC data rate, STS data rate.

STP  Signaling Transfer Point, or Shielded Twisted Pair cable.

STS data rate  Synchronous Transport Signal data rate:  a term referring to the rate of data
transmission for a bit stream, specified in conformance with SONET standards.  STS levels
correspond exactly to OC levels, where STS-1 represents a transmission rate of 51.84 Mb/s,
STS-3 represents a transmission rate of 155.52 (3 x 51.84) Mb/s, and so forth.  As with OC,
the n designation specifies the number of level-1 (STS-1) circuits that could be encapsulated at
the data rate.  See also OC data rate, STM data rate.

subset.  Specific set of the total traffic included in a capture, where that set is defined by some
combination of content, capture channel, IP addresses, and type of decode.

STS-3c  Synchronous Transport System-level 3 concatenated.

TCP/IP  Transport (or Transmission) Control Protocol/Internet Protocol — One of several
protocols commonly used to communicate over an internet;  this one developed by the U.S
Department of Defense (DOD) in the 1970s and 1980s specifically to permit different types of
computers to exchange information.  The TCP/IP standards support a five-layer
communications protocol (as contrasted with the OSI standard of seven layers).

Transmission Convergence sublayer  Sublayer, within the physical layer, that defines the line
coding, scrambling, and synchronization of data.  

UNI (pronounced “U-knee”)  See User-Network Interface.

User-Network Interface (UNI)  Type of connection between:

•  A user’s ATM equipment (host, router, etc.) and private ATM network equipment
(known as CPE, or Customer Premises Equipment).  The interface in this case, known as
a private UNI, is used exclusively to connect hosts to devices where both are managed by
the same administrative domain.  It does not protect either side from equipment that
misbehaves, but rather assumes that the two sides function correctly according to the
current standards of the network.
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•  A user’s ATM equipment and public ATM network equipment.  The interface in this
case, known as a public UNI, is used to connect private ATM equipment with provider
networks, and protects the provider network from user or CPE equipment that may
misbehave (or otherwise not adhere to the ATM standards).

•  Private ATM switches (or other CPE equipment) and public ATM network equipment.
The interface in this case is the public UNI described above.

user profile  Tool used to establish a particular processing environment quickly, by loading
the user profile associated with that environment.  Each profile comprises a combination
of:

•  Settings that become effective when the profile is loaded:  a cell library, use of toolbars
and toolbar Help, colors used when viewing captures, and so forth.

•  Up to 16 scripts that are run regularly by the profile user(s), and that you can initiate by
clicking their icon (run button) on the profile toolbar.

•  Preferences and other information that’s stored session to session, so you can restart with
the same settings (e.g., last user profile used, and options used to view captured traffic).

You define user profiles in two places:  during capture processing (for preferences related to
viewing the capture), and using the Load User Profile button from the main menu (for all
other settings).

VC  Virtual Channel (Virtual Circuit).

VCC See Virtual Channel Connection.

VCI  See Virtual Channel Identifier.

Virtual Channel Connection (VCC)  A Virtual Channel Connection is defined as a
concatenated list of Virtual Channel (VC) links.  A VC link is a unidirectional flow of ATM
cells with the same VCI between a VC connecting point and another VC connecting point or a
VC endpoint.

Virtual Channel Identifier (VCI)  16-bit identifier that’s carried in the cell header.  Together
with the 12-bit VPI (Virtual Path Identifier), the VCI forms a 28-bit channel identifier that
identifies the ATM connection.  While the channel identifier changes from one hop to the next
as a cell moves through the ATM internet, it stays the same between any two network
elements for the life of the connection.  See channel identifier for more information.   

Virtual Path Identifier (VPI)  12- or 8-bit identifier that’s carried in the cell header (12 bits for
NNI transmissions and 8 for UNI, which sacrifices 4 bits for the GFC).  Together with the 16-
bit VCI (Virtual Channel Identifier), the VPI forms a 28- or 24-bit channel identifier that
identifies the ATM connection.  While the path identifier changes from one hop to the next as
a cell moves through the ATM internet, it stays the same between any two network elements
for the life of the connection.  See channel identifier for more information.     

VP  Virtual Path.

VPC  Virtual Path Connection.

VPCI/VCI  Virtual Path Connection Identifier/Virtual Channel Identifier.

VPI  See Virtual Path Identifier.

VP/VC  Virtual Path/Virtual Circuit.

Wrap Buffers  When defining filtersets, you can choose to wrap buffers or not.  The option you
choose applies for all buffers defined for the filterset, and indicates whether to:

•  Reuse each buffer continually until the capture is stopped, essentially creating a circular
buffer (box is marked).  With this selection, 622Vu Advisor writes over cells that have
already been stored on the analysis device after the buffer is full.

•  Fill up each buffer once, then stop collecting the corresponding cells (box not marked).
Cells that would otherwise be stored in the buffer are discarded;  they don’t fall through
to any other buffers that match their content.

A: Glossary
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Appendix B

config.ini File

This appendix contains the text of 622Vu Advisor’s basic initialization (.ini) file.
While the .ini file rarely requires modification, you might be asked to change it
for your installation.  If this is the case at your site, open the config.ini file, then
edit the file using the standard Windows Notepad application.  A few guidelines
follow:   

•  The file is divided into sections, with each section enclosed in brackets:
[CAPMON], etc.  Generally Agilent Technologies' support staff will direct
you to a particular section of this file.

•  Each line takes the format keyword = value.  If you make changes, modify
only the righthand side of the equation.

•  You can comment-out any line by placing a semicolon in front of it.

Modifying an .ini file can lead to unexpected and catastrophic consequences.
Make a backup of the .ini file before changing it in any way.

B:  config.ini File

225



Identification and
security information.

Environment variables
(user profile).

Current settings for
various processing
options.

Capture preferences.

Devices accessible
via 622Vu.

B: config.ini File
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Appendix C

Summary of Libraries

622Vu Advisor is shipped with several cell libraries that are designed to help
with specific types of ATM analysis, as detailed in this appendix.  You can use
these libraries for your own purposes, or modify them as needed.

Table 13.  Libraries Distributed with the System

Library Name Description

cb_std.lib Contains one sample script and samples of filtersets used to capture UNI,
ILMI, CLP, OAM, etc., traffic.  Good as a base to edit and customize.  

sample1.lib Contains two sample scripts:

One for full bandwidth split between VCIs 1 – A, transmitted in raw cell
mode (not as part of PDUs), with ten cells repeated 13,000 times.  This
results in 130,000 cells, which fills the 8 MB of capture RAM on
certain devices.

The other is designed to test Bad HEC counts, and sends three good HEC
cells then three bad.  It repeats this process 1,000 times for a total of
6,000 cells.

Includes samples of filtersets that you can modify, showing all the
combinations of options (wrap, no-wrap, include idle cells, don’t include
idle cells, etc.).

sample2.lib Contains sample scripts you can customize, including:

•  One for full bandwidth to send on VCIs 6–E, to test a switch’s ability
to forward a full-bandwidth pipe to ten VCIs that will each be 10%
loaded.

•  Some UNI 3.1 traffic that you can retransmit on any VPI/VCI of your
choosing.

Includes some basic (non-wrapping) filtersets for simplified capture of idle
cells or specific VCCs.

sample3.lib Provides bandwidth scripts you can use to load ATM networks at various
rates (1, 5, 10 – 100%), independent of the interface type.  These scripts are
all sent out on VCC 99/99, but you can edit the sequence to change this, as
necessary, by going in at the transmit sequence level (see Chapter 9).

Includes a buffered filterset that captures VCC 99/99 and displays the
percent-of-bandwidth captured.  This is useful for blasting through switches
and verifying sustained throughput at different levels.

C:  Summary of Libraries
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Appendix D

Cell Library Structure

622Vu Advisor’s cell libraries serve as repositories for various information:
sequence definitions (groups of cells), script definitions (groups of sequences),
filterset definitions, etc.  622Vu Advisor can manage any number of cell
libraries, but only one library is open (active) at any given time.

When you open a cell library, it displays as library-name.lib in the Open Library
dialog box and the righthand side of the main menu.  This same library is stored
as library-name.dir on the hard disk.  When you examine the library-name.dir
file further, it contains several distinct directories.  These directories are the same
in each cell library, and are described below:

Directory Name      Used to store…

CellScripts Transmit scripts.  Each script is stored as a separate file, with the filename
comprising the script/name plus the extension .scr.  For example, a script
called Sample Script would be stored in the CellScripts directory as Sample
Script.scr.  The Explorer incorrectly identifies these files as type "Screen
Saver," which it derives from the extension (same extension as that for the
Windows Screen Saver).  You can ignore these file-type descriptions;  the
files are, in fact, CellScripts directory script files.

CellSequences Transmit sequences.  Each sequence is stored as a separate file, where the
filename comprises the sequence name plus .seq extension.  For example, a
sequence called My Seq would be stored in this directory as My Seq.seq.

FilterSets Capture filtersets.  Each filterset is stored as a separate file, with the filename
comprising the filterset name plus the extension .fil;  for example,
SampleFilterset.fil.

SearchRules Upload capture rules:  filterset rules you define on the fly for immediate use
with the current active capture.  You can define them in two places:
•  Through the capture facility’s filterset wizard, in which case they’re

based on some combination of VCC, IP address, decode, and/or channel.

•  While monitoring real-time statistics, in which case they’re based on
some combination of VCCs.

Each set of rules is stored as a separate file, with the filename comprising the
name assigned to the rules, plus the extension .srl.

QoS QoSMeter test results.  Each set of results is stored as a separate file, with the
filename comprising the name you assign, plus the extension .qos.
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Appendix E

Regulatory Information

Laser Safety Statements
The OC-12c/SMT-4c single mode fiber-optic interface contains Class 1 laser
devices.  Class 1 laser devices are considered to be safe based upon current
medical knowledge.  

A laser safety warning label is attached to the individual modules where
necessary.  An example of the text on a Class 1 warning label is as follows:

"CLASS 1 LASER PRODUCT
INVISIBLE LASER RADIATION
MFD IN SINGAPORE

OF FOREIGN AND DOMESTIC COMPONENTS
COMPLIES WITH 21CFR 1040.10"
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The specifications for the OC-12c/STM-4c single-mode interface module is:

Specification Agilent J3764A

Laser Type Fabry-Perot Laser

Laser Class

21CFR 1040.10 (Canada, Japan, USA)

IEC 825 (Europe)

Class 1

Class 1

Transmitter Min Typical Max

Avg Optical Power (dBm) -15 -13 -8

Optical Wavelength (nm) 1293 1310 1334

Receiver Min Typical Max

Avg Optical Sensitivity (dBm) -28 -30 •

Avg Max Input Power (dBm) • • -3

Optical Wavelength (nm) 1200 • 1550

________________________________________________________________

You must return modules with malfunctioning lasers to an Agilent Technologies
Service Center for repair and calibration.

Under no circumstances look into the module connector or the end of an optical
cable attached to the optical output when the device is operational.

________________________________________________________________

WARNING

232



Declaration of Conformity
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173
configuration syntax, described, 70–71
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OC-12 interface, 65
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scripts.
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scripts.
signal strength when monitoring, 61
specifying for a capture, 78. See also

capture processing.
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also sequences; scripts.
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captures, 94, 95
asynchronous, definition of, 211
ATM network

connecting to the 622Vu undercradle, 47
ATM network, monitoring. See analysis

devices.
ATM statistics, 74. See also analysis

devices.
described, 69
displaying for both channels, 69

ATM terminology, definition of, 42, 211–23
ATM25 device

monitoring. See also analysis devices.

B
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capturing, 139–40. See also capture
processing; filtersets, defining.

highlighted in capture displays, 92. See
also user profiles, capture settings.

library for testing, 227. See also cell
library.
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for QoSMeter background traffic, 192,

199
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198–200, 199
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controlling idle cell capture. See
filtersets, defining; idle cells.

controlling size and wrapping of. See
filtersets, defining.

defining, 135, 143–46. See also filtersets,
defining.

deleting, 138, 144. See also filter
processing.

description of, 131–33, 216
displaying definitions, 134
filter entries in. See filter entries.
limiting size of, 79. See also capture

processing; filter processing; memory
allocation for captures.

memory allocation, specifying, 145–46.
See also memory allocation for
captures.

VCC statistics, displaying for a capture,
82, 83

Wrap message, 83. See also filtersets,
defining.

C
capture-facility toolbar

summary of functions, 93–97
capturing traffic, 38, 42, 45. See also

processing overview.
building scripts with, 89, 90, 113–15. See

also processing overview; scripts.
building sequences with, 153. See also

sequences; scripts.
cell count for, 81, 89
changing the arrival time, 91, 94
changing the filterset, 84. See also

filtersets.
channel used for, 79. See also analysis

devices; channel.
color preferences with, 50, 92. See also

user profiles.
creating subsets, 89, 90, 107–8. See also

processing overview; subsets of
cells/PDUs, creating.

decoding all PDUs at once, 93, 100
decoding PDU information, 90, 97–100
defining decoding preferences, 98, 113
defining filtersets during. See also

filtersets.
displaying captured traffic, 80
displaying cell- vs. PDU-level traffic, 91,

113
displaying detailed PDU/cell information,

95, 112
displaying VCC statistics, 83, 95
establishing a time baseline, 91, 94
exporting captured data, 38, 93, 101

filtering, 79. See also filter processing.
highlighting cells in current packet, 97
limiting captures to specific cells, 79
memory allocation for, 131, 143, 145–46,

216. See also filtersets, defining;
processing overview.

MIB use in decoding PDUs, 101, 218
opening a capture file, 77, 89, 93
PDU count for, 89
preferences for PDU decodes, 98
printing PDU information, 93
restarting a capture, 82, 97
saving the capture, 77, 89, 93, 97
searching capture files, 89, 90, 94
searching for specific cells, 105, 109
searching for specific PDUs, 105, 109,

113
searching the files, 103–7. See also

processing overview; searching
capture files.

starting a new capture, 78–80, 93, 96
stopping a capture, 82
storage format, 48
summary of functions, 93–97
using Goto to locate a cell/PDU, 94, 103

CardBus card
troubleshoot installation, 28

cb_std.lib file, 227
CDV times, specifying maximum, 195, 201
Cell Editor, use of, 160, 161–62. See also

AAL5 wizard; sequences, creating.
cell header

as part of ATM cell composition, 212,
213

CLP field, definition of, 214
definition of, 217
end-of-datagram signaling, with, 168
GFC field, definition of, 216
HEC field, definition of, 217
inheritable properties, 156
Payload Type field, definition of, 219
searching for strings in, 104, 109
specifying for a capture filter, 140, 141–

43, 148. See also Advanced Filtering
Mode; capture processing.

specifying for a post-capture script, 114–
15. See also capture processing;
scripts.

specifying for a subset, 107–8. See also
capture processing; subsets of
cells/PDUs, creating.

specifying for cells in a sequence, 163,
165. See also sequences.

specifying master script values, 172, 175,
177. See also scripts.
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specifying master sequence values, 157,
158–59. See also AAL5 wizard,
using; sequences.

VCI field, definition of, 214, 223
VPI field, definition of, 214, 223

cell library
buffers, managing. See buffers, defining.
creating a new, 45, 49
default, in user profile, 48, 49, 52
description of, 41, 48
directory stored in, 49
filter entries, managing. See filter entries,

defining.
filtersets, managing. See filtersets,

defining.
hierarchy of, 41
name of current, displayed on toolbar, 43
opening, 45, 48
saving changes, 44, 49
scripts, managing. See scripts.
sequences, managing. See sequences.
standard, supplied with 622Vu Advisor,

48
summary of 622Vu Advisor-supplied, 42,

227
Cell Loss Priority field

definition of, 214. See also header data.
specifying values for. See cell property

inheritance; header data.
cell property inheritance, 114–15, 154, 155–

57, 163, 165, 214. See also header
data, specifying master script values;
header data, specifying master
sequence values.

cell property, defined, 213–14
CellComand, 221

OLE capability, 219
CellCommand, 41, 55

description of, 213
interface to capabilities of, 211

cells. See also capture processing; filter
processing.

defining in sequences, 157, 160, 163–70.
See also sequences.

definition of, 212
displaying definitions, 170. See also

sequences.
editing, 114, 160, 161–62. See also

AAL5 wizard; sequences, creating;
sequences, defining cells in.

fields comprising address, 140. See also
header data.

idle. See idle cells.
including in sequences, 159. See also

sequences.

networking, 213
number of in a buffer, determining, 146.

See also buffers, defining.
transmission options for, 65. See alarm

indicators; analysis devices, interface
options.

channel
capturing and processing traffic on. See

capture processing; analysis devices;
processing overview.

definition of, 214, 215
displaying VCC statistics for, 83. See

also buffers, defining.
identifier, assignment of, 221. See also

Virtual Channel Identifier field;
Virtual Path Identifier field.

identifier, definition of, 214
indication of active, 69–70
monitoring a single channel, 61–63, 69.

See also analysis devices.
monitoring both channels, 63, 68, 69
use in transmissions, 62. See also capture

processing; analysis devices.
VCI field, 156. See also header data.

clock
source, specifying for transmissions, 61,

62. See also analysis devices,
monitoring a single channel.

CLP field. See Cell Loss Priority field.
colors

and buffer memory allocation, 146. See
also buffers; filter processing.

capture displays, use with, 82
preferences for capture displays, 50, 92.

See also user profiles.
reserved payload positions, use with, 166.

See also sequences, defining payload
data.

Command File Generation, 32
Common Part Convergence Sublayer. See

Convergence Sublayer; CPCS
sublayer.

config.ini file, 42, 48
editing guidelines, 225
listing, 226

Configuration and Installation, 9
configuration syntax, described, 70–71
configure

622Vu Advisor, 20
Generated File, 36
IP addresses, 20

configuring devices. See also analysis
devices.

configuring the device, 189, 197
connections

237



to ATM network, 47
undercradle, 10
undercradle installation, 18

Console
troubleshooting tool, 30
useful tool, 33

Constant Bit Rate QoSMeter sessions, 186
defining general session settings, 189–91
defining session-analysis device, 190
defining session-transmission device, 189
defining traffic pattern settings, 191–93
defining transmission options, 193–95
description of, 188
graph described, 206. See also graphing

QoSMeter test results.
menu and toolbar commands, 187
overview of tab use, 188
selecting the operation mode, 188, 189
starting and stopping, 203
statistics described, 204–6. See also

monitoring QoSMeter session results.
Constant Bit Rate sessions

overview of processing, 7
Convergence Sublayer

definition of, 215. See also AAL
protocols, definition of.

relationship to SAR sublayer, 221
corrupted cells, allowance of, 37
counters, resetting, 69
CPCS sublayer

definition of. See Convergence Sublayer,
definition of.

formatting settings automatically, 155.
See also AAL5 wizard; sequences.

settings for cell framing, 164, 167, 168.
See also sequences.

CRC field
as AAL1 SAR setting, 167. See also

AAL protocols, defining framing for
sequences.

definition of, 215
polynomial, used to compute the HEC,

217
CSI field

as AAL1 SAR setting, 167. See also
AAL protocols, defining framing for
sequences.

definition of. See Convergence Sublayer,
definition of.

D
decode settings, 100
default settings in user profiles, 48, 49, 50,

52. See also user profiles.
defining a new session, 187

defining QoSMeter session properties, 186,
187

using the toolbar for, 203
Device Manager. See also analysis

devices:configuring, monitoring
traffic.

launching, 45
displaying QoSMeter session statistics. See

monitoring QoSMeter session results.
DS3 device

monitoring. See also analysis devices.
transmission rate, 215

E
E3 device

monitoring. See also analysis devices.
echo-back, use of, 70
Elapsed time field, description of, 81
end-of-datagram

signal, use of, 166, 167–68. See also
sequences.

end-of-datagram computation, 46
errored cells, maximum allowed, 195, 201
errors

bit, forcing, 156, 214. See also HEC.
counters for OC-12 interface, 74. See

also OC-12 device.
counters forOC-12 interface, 76
HEC, described, 72. See also ATM

statistics; analysis devices, interface
options.

recovery, and AAL5 protocol, 211
tracking, 38

Ethernet card
installation, 17
troubleshoot installation, 28

exiting 622Vu Advisor, 45, 113
exiting QoSMeter processing, 187
export

file to Expert Analysis, 102
exporting captured data, 93, 101

F
file

save to Expert Analyzer, 102
filter buffers

adding, 144
filter entries

adding, 147
defining, 135, 147–48. See also buffers,

defining; filtersets, defining.
deleting, 138, 144, 147. See also filter

processing.
description of, 131–33, 216
displaying definitions, 134
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effect on filterset configurations, 137. See
also filtersets.

filter processing, 42. See also processing
overview.

Advanced Filtering Mode, 135, 140, 148,
149–51

defining buffers, 135, 143–46
defining filter entries, 135, 147–48, 149,

150
defining filtersets, 135, 137–43, 149–50
description of, 79, 131–33
displaying definitions, 134
exiting from, 135
illustrated, 132
option availability, 136
specifying use of, 79

filtering captures, 38, 45
filterset

stored, 41. See also cell library.
stored, 48

filtersets
adding, 137
controlling new captures with, 79. See

also capture processing.
defining, 135, 137–43. See also filter

processing.
defining from the capture window, 84, 96
defining with Advanced Filtering Mode,

149–50. See also Advanced Filtering
Mode.

deleting, 138
description of, 131–33, 216
displaying definitions, 134
library inclusion of, 227. See also cell

library.
VCC statistics for, described, 83

framing, identifying for new cells, 163, 164,
166–69. See also sequences.

G
Generated File

configuring 622Vu Advisor, 36
Generic Flow Control field

definition of, 216. See also header data.
specifying values for. See cell property

inheritance; header data.
GFC field. See Generic Flow Control field.
graphing options, 38
graphing QoSMeter test results, 186, 202

Constant Bit Rate sessions, 206
menu commands, 187
Round-Trip Delay sessions, 210

H
HEC

cells, capturing bad, 132, 139–40. See
also capture processing; filtersets,
defining.

cells, displaying bad, 92. See also user
profiles, capture settings.

cells, library for testing bad, 227. See
also cell library.

errors counters, 72. See also ATM
statistics; analysis devices, interface
options.

field, definition of, 217. See also header
data.

relation to CRC, 215
state, forcing, 156, 159, 214. See also

inheriting cell characteristics;
sequences.

Help
displaying online, 8
displaying toolbar, 45, 49, 51–53

Help menu (filterset)
summary of commands, 136

hierarchy
cells, sequences, and scripts, 156. See

also cells; scripts; sequences.
hierarchy of 622Vu Advisor components, 41

I
idle cells

capturing, 79, 137, 139–40. See also
capture processing; buffers, defining;
filtersets, defining.

counts of, 72. See also ATM statistics.
defining, 79, 141–43. See also filter

processing.
library inclusion of, 227
standard buffer for, 140. See also buffers.

ILMI PDUs, decoding, 101, 218. See also
PDUs; user profiles.

inheriting cell characteristics, 114–15, 154,
155–57, 163, 165, 214. See also
header data, specifying master script
values; header data, specifying master
sequence values.

initialization file, 48. See config.ini file.
installation

622Vu Advisor installation, 13
622Vu undercradle, 14
Agilent Advisor Installation Guide, 13
CardBus controller, 15
Console tool, 33
Ethernet card, 17
modem, 24
registry generation, 32
TCP/IP stack, 16
test the installation, 22
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troubleshoot the NIC card, 28
troubleshoot undercradle installation, 25
troubleshoot with the Console tool, 30
troubleshooting, 23
troubleshooting with Ping, 31
troubleshooting with the Console tool, 33
Windows, 13

Installation and Configuration, 9
IP address

622Vu Advisor, 20

L
LAN

save file to Expert Analyzer, 102
laser

safety statements, 231
specifications, 232

LEDs
undercradle, 10

licensing information, displaying, 46

M
main menu illustrated, 43
memory allocation for captures, 131, 143,

145–46, 216. See also capture
processing; filtersets, defining;
processing overview.

MIB file
description of, 218
identifying, 101. See also user profiles.

modem
installation, 24

monitoring ATM network activity. See
analysis devices; processing
overview.

monitoring QoSMeter session results, 186,
202

Constant Bit Rate statistics, 204–6
graphing statistics, 206, 210
Round-Trip Delay statistics, 207–9

monitoring real-time statistics, 38, 45
monitoring scripts. See scripts, monitoring.
monitoring traffic, 37, 38, 45

N
Network General Sniffer format, 38, 40, 93,

101, 212
network, monitoring the ATM. See analysis

devices.

O
OAM framing for sequences, 164. See also

sequences.
OC-12 device

configuring, 65
monitoring, 74. See also analysis devices.

OC-3 device
monitoring. See also analysis devices.

transmission rate, 222
OLE Automation, 41

definition of, 219
server, 213

Onboard Clock, description of use, 62. See
also analysis devices, monitoring a
single channel.

opening a QoSMeter session, 187
overview of QoSMeter processing, 7

P
Parity field, as AAL1 SAR setting, 167. See

also AAL protocols, defining framing
for sequences.

Pause Step. See scripts, defining steps in.
payload data

as inheritable property. See inheriting cell
characteristics.

as part of ATM cell composition, 212,
213

defining in a sequence, 163, 165–69. See
also AAL5 wizard; sequences,
defining cell framing.

displaying for a capture, 90. See also
capture processing, displaying active
captures; PDU information, decoding.

importing from a file, 160, 161, 163. See
also AAL5 wizard.

scrambling at transmission, 65
searching for strings in, 104, 109
specifying for a capture filter, 140. See

also Advanced Filtering Mode;
capture processing.

specifying for cells in a sequence, 163,
164. See also sequences.

Payload Type field
definition of, 219. See also header data.

Payload Type Indicator field
definition of. See Payload Type field,

definition of.
specifying values for. See cell property

inheritance; header data.
PDU information, 101. See also capture

processing.
adding to sequences, 153, 160–63
description of, 219
relation to CRC, 215
specifying payload data for, 160, 161,

163, 165. See also AAL5 wizard;
payload data.

PDUs
creating subsets of, 38

Ping
troubleshooting tool, 31

PingGeneration tool, 38, 40, 42
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instructions to use, 181–84
toolbar buttons described, 184

processing overview, 7
profile toolbar

defining script buttons, 49, 51–53. See
also scripts; user profiles.

description of, 44
displaying, 45
illustrated, 43
summary of commands, 45

PTI field. See Payload Type Indicator field.

Q
QoSMeter Help, displaying, 187
QoSMeter menu commands described, 187
QoSMeter operation modes, selecting, 188,

189
QoSMeter processing

overview, 7
QoSMeter sessions

defining new, 187
defining properties for, 187
opening existing, 187
saving, 187
starting, 187
stopping, 187

QoSMeter statistics display. See monitoring
QoSMeter session results.

QoSMeter test sessions, 40, 42
description, 39
stored, 41, 48. See also cell library.

QoSMeter toolbar
buttons described, 187
toggling display of, 187

R
raw framing for sequences, 163, 164, 165,

166. See also sequences.
real-time statistics, monitoring, 38, 40, 42,

45
Recovered RD Channel, description of use,

62. See also analysis devices,
monitoring a single channel.

reference material, 7
registry

troubleshooting, 32
resetting counters, 69
restarting a capture, 82, 97
Round-Trip Delay QoSMeter sessions, 186

defining general session settings, 197–98
defining session-transmission device, 197
defining traffic pattern settings, 198–200
defining transmission options, 200–201
description of, 196
graph described, 210. See also graphing

QoSMeter test results.

menu and toolbar commands, 187
overview of tab use, 196
starting and stopping, 203
statistics described, 207–9. See also

monitoring session results.
Round-Trip Delay sessions

overview of processing, 7

S
safety statements, laser, 231
sample library files, 227
SAR sublayer

definition of, 221. See also AAL
protocols, definition of.

formatting settings automatically, 155.
See also AAL5 wizard; sequences.

relationship to Convergence Sublayer,
215

settings for cell framing, 164, 166, 167–
68. See also sequences.

using settings as filtering criteria, 149.
See also Advanced Filtering Mode.

save
file to Expert Analysis, 102

saving a QoSMeter session, 186, 187
SC field, as AAL1 SAR setting, 167. See

also AAL protocols, defining framing
for sequences.

scrambling feature, specifying use of, 65
scripts, 39, 42. See also processing

overview.
analysis device requirements for, 173.

See also analysis devices, monitoring
a single channel.

creating, 177–79
creating from stored captures, 42, 77, 89,

90, 96, 113–15
defining master header values, 177
defining steps in, 177, 178–79
definition of, 221
deleting, 172. See also scripts.
deleting steps in, 178
description of, 155, 171
displaying defined, 171
editing, 114
executing from the toolbar, 44, 49, 51–

53. See also user profiles.
hierarchy of, 156
initiating processing, 171–72
maximum number in a user profile, 49,

52. See also user profiles.
monitoring ATM interface during a run,

67, 173. See also analysis devices.
monitoring General statistics, 176
naming a new script, 177
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property inheritance, 155–57. See also
cell property inheritance.

running, 172–76
sample, in libraries, 227. See also cell

library.
saving step definitions, 178
stopping, 175
stored, 41, 48. See also cell library.
toolbar buttons described, 173–75

Segmentation and Reassembly sublayer. See
SAR sublayer.

sequences, 39, 42. See also processing
overview; scripts.

adding PDUs to, 46, 153, 160–63
creating, 153, 154, 157–60
creating from stored captures. See scripts,

creating from stored captures.
defining, 45
defining cell framing, 163, 164, 166–69
defining cell header values, 163, 165
defining cells in, 154, 155, 157, 159,

163–70. See also AAL5 wizard,
using.

defining master header values, 157, 158–
59

defining payload data, 163, 165. See also
sequences, defining cell framing.

defining with the AAL5 wizard. See
AAL5 wizard.

definition of, 221
deleting, 154. See also sequences.
description of, 155
displaying cell definitions, 170
displaying defined sequences, 154
hierarchy of, 156
initiating processing, 154
naming a new cell, 164
naming a new sequence, 158
property inheritance, 154, 155–57. See

also cell property inheritance.
repeating transmission of, 179. See also

scripts, defining steps in.
saving cell changes, 170
stored, 41, 48. See also cell library.

sessions. See also Constant Bit Rate
sessions, Round-Trip Delay sessions.

SN field, as AAL1 SAR setting, 167. See
also AAL protocols, defining framing
for sequences.

SNMP
description of, 222
PDUs, decoding, 101, 218. See also

PDUs; user profiles.

SNP field, as AAL1 SAR setting, 167. See
also AAL protocols, defining framing
for sequences.

software
622Vu Advisor installation, 13
Windows installation, 13

Special field settings for cell framing, 167,
169. See also sequences.

standard.lib file, 48. See also cell library.
standard.prf file, 44, 49. See also user

profiles.
starting 622Vu Advisor, 41, 42, 43

library opened when first, 48. See also
cell library.

profile active when first, 49. See also
user profiles.

statistics
ATM.. See ATM statistics.
requests for via GSMP, 217
resetting, 69

status bar, displaying, 187
subset facility, 38
subsets of cells/PDUs, creating, 89, 90, 94,

107–8
synchronizing

cell transmissions, 222
system toolbar

description of, 43
displaying, 45
illustrated, 43
summary of commands, 45–46

system toolbar, displaying, 187

T
taskbar icons, 44
TCP/IP

stack installation, 16
technical support, 46
terminology, ATM-related, 211–23
timeout, specifying for QoSMeter sessions,

195
time-stamp information for cell framing,

167, 169. See also sequences.
toolbar

with QoSMeter testing, 203
toolbars. See profile toolbar; system toolbar.

capture facility. See capture-facility
toolbar.

filterset. See filterset toolbar.
PingGeneration tool, 184
script execution, 173–75

tools
Console tool, 33

traffic
filtering. See filter processing.
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transmission options, specifying, 65. See
alarm indicators; analysis devices,
interface options.

Transmit Step. See scripts, defining steps in.
troubleshoot

622Vu Advisor installation, 23
Console tool, 30, 33
NIC card installation, 28
Ping, 31
undercradle installation, 25

U
undercradle

installation, 14
installation connections, 18
LEDs and connectors, 10

user profiles
associating scripts with, 51–53. See also

scripts.
capture settings, 92. See also capturing

traffic.
changing the active, 50
defining, 45, 50–53
description of, 49, 223
directory stored in, 50, 51
general settings, 48
loading the active, 45, 50
name of current, displayed on toolbar, 43,

44
saving revised definitions, 50
standard, 49
storage format, 48
toolbar settings, 51–53

V
VCCs

as IFMP traffic, 217
as IISP traffic, 217
as PNNI traffic, 220

as search criteria, 94, 103
creating subset based on. See subsets of

cells/PDUs, creating.
defining decode methods, 98, 113
defining filtersets based on, 96
established via GSMPdl-anyotherhere?,

217
library inclusion of, 227
limiting captures to particular, 79. See

also capture processing; filter
processing.

VCI field. See Virtual Channel Identifier
field.

version information, displaying, 46
Virtual Channel Identifier (VCI) field

assignment of, 221
definition of, 214, 223. See also header

data.
specifying values for. See cell property

inheritance; header data.
Virtual Path Identifier (VPI) field

assignment of, 221
definition of, 214, 223. See also header

data.
specifying values for. See cell property

inheritance; header data.
VPI field. See Virtual Path Identifier field.
VPI/VCI assignment for QoSMeter session

analysis, 190, 198
VPI/VCI assignment for QoSMeter session

transmission, 189, 197

W
Windows

installation, 13
wizard capability. See AAL5 wizard.
Wrap message, 83. See also buffers; filter

processing; filtersets.
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